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About this document
This document is a global document. Contact your system supplier or your 
Nortel Networks representative to verify that the hardware and software 
described are supported in your area.

Subject
This document contains information about the DECT system. 

Note on legacy products and releases

This NTP contains information about systems, components, and features that 
are compatible with Succession 3.0 Software. For more information on 
legacy products and releases, click the Technical Documentation link under 
Support on the Nortel Networks home page:

http://www.nortelnetworks.com/

Applicable systems
This document applies to the following systems:

• Meridian 1 Option 11C Chassis

• Meridian 1 Option 11C Cabinet

• Meridian 1 Option 51C

• Meridian 1 Option 61

• Meridian 1 Option 61C

• Meridian 1 Option 61C CP PII

• Meridian 1 Option 81

http://www.nortelnetworks.com/


Page 12 of 612  About this document

553-3001-370 Standard 1.00 October 2003

• Meridian 1 Option 81C

• Meridian 1 Option 81C CP PII

• Succession 1000

• Succession 1000M Chassis

• Succession 1000M Cabinet

• Succession 1000M Half Group

• Succession 1000M Single Group

• Succession 1000M Multi Group

Note that memory upgrades may be required to run Succession 3.0 Software 
on CP3 or CP4 systems (Options 51C, 61, 61C, 81, 81C).

System migration

When particular Meridian 1 systems are upgraded to run Succession 3.0 
Software and configured to include a Succession Signaling Server, they 
become Succession 1000M systems. Table 1 lists each Meridian 1 system 
that supports an upgrade path to a Succession 1000M system.

Table 1
Meridian 1 systems to Succession 1000M systems (Part 1 of 2)

This Meridian 1 system...
Maps to this 
Succession 1000M system

Meridian 1 Option 11C Chassis Succession 1000M Chassis

Meridian 1 Option 11C Cabinet Succession 1000M Cabinet

Meridian 1 Option 51C Succession 1000M Half Group

Meridian 1 Option 61 Succession 1000M Single Group

Meridian 1 Option 61C Succession 1000M Single Group

Meridian 1 Option 61C CP PII Succession 1000M Single Group

Meridian 1 Option 81 Succession 1000M Multi Group



 About this document  Page 13 of 612

DECT Description, Planning, Installation, and Operation

Note the following:

• When an Option 11C Mini system is upgraded to run Succession 3.0 
Software, that system becomes a Meridian 1 Option 11C Chassis.

• When an Option 11C system is upgraded to run Succession 3.0 Software, 
that system becomes a Meridian 1 Option 11C Cabinet.

For more information, see one or more of the following NTPs:

• Small System: Upgrade Procedures (553-3011-258)

• Large System: Upgrade Procedures (553-3021-258)

• Succession 1000 System: Upgrade Procedures (553-3031-258)

Intended audience
This document is intended for sales representatives, planners, installers, site 
maintenance personnel and administrators. 

Conventions

Terminology

In this document, the following systems are referred to generically as 
“system”:

• Meridian 1

• Succession 1000

• Succession 1000M

Meridian 1 Option 81C Succession 1000M Multi Group

Meridian 1 Option 81C CP PII Succession 1000M Multi Group

Table 1
Meridian 1 systems to Succession 1000M systems (Part 2 of 2)

This Meridian 1 system...
Maps to this 
Succession 1000M system
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The following systems are referred to generically as “Small System”:

• Succession 1000M Chassis

• Succession 1000M Cabinet

• Meridian 1 Option 11C Chassis 

• Meridian 1 Option 11C Cabinet

The following systems are referred to generically as “Large System”:

• Meridian 1 Option 51C

• Meridian 1 Option 61

• Meridian 1 Option 61C

• Meridian 1 Option 61C CP PII

• Meridian 1 Option 81

• Meridian 1 Option 81C

• Meridian 1 Option 81C CP PII

• Succession 1000M Half Group

• Succession 1000M Single Group

• Succession 1000M Multi Group

The call processor in Succession 1000 and Succession 1000M systems is 
referred to as the “Succession Call Server”.

Caution, Danger, Warning tables

These tables are strategically placed in this document to advise the reader of 
potential hazards. A brief description in provided within each of the following 
tables. 

DANGER — Electric Shock

Advises of the risk of a serious injury or death caused by 
an electric shock.
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DANGER — Electrostatic Sensitive Device

Advises of a procedure that can result in equipment 
damage due to ElectroStatic Discharge (ESD).

DANGER — Serious Injury

Advises of the risk of a serious injury or death caused by 
an immediate hazard.

CAUTION — Data Loss

Advises of a procedure that can result in a loss of data.

CAUTION — Equipment Damage

Advises of a procedure that can result in equipment 
damage.

CAUTION — Service Interruption

Advises of a procedure that can result in an interruption of 
service.

WARNING — Personal Injury

Advises of the risk of a minor or moderate injury caused 
by an immediate hazard.
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Step Action table

Procedures in this document are contained in Step Action tables. The 
following example explains the how a procedure is arranged in this table 
format. 

Related information
This section lists information sources that relate to this document.

NTPs

The following NTPs are referenced in this document:

• Optivity Telephony Manager: System Administration (553-3001-330)

• Small System: Installation and Configuration (553-3011-210)

• Large System: Installation and Configuration (553-3021-210)

• Succession 1000 System: Installation and Configuration (553-3031-210)

• DECT: Description, Planning, Installation, and Operation 
(553-3001-370)

• DECT Programming and Provisioning Record (553-3601-250)

• DECT Messaging (P0989045)

Table 2
A Sample Step Action table

Step Action

1 This portion of the step action table details the required step.

This portion of the step action table details the action to carry out the above step.

2 This portion of the step action table details the required step.

This portion of the step action table details the action to carry out the above step.

END
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Online

To access Nortel Networks documentation online, click the 
Technical Documentation link under Support on the Nortel Networks 
home page:

http://www.nortelnetworks.com/

CD-ROM

To obtain Nortel Networks documentation on CD-ROM, contact your 
Nortel Networks customer representative.

http://www.nortelnetworks.com/
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Product description

Contents
This section contains information on the following topics:

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Mobility card (DMC8)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Base stations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Handsets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Optivity Telephony Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Systems window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Subscriptions window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

DMC boards window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Radio Fixed Part (base station) window . . . . . . . . . . . . . . . . . . . . . . . . 104

Active Alarm Snapshot window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

Performance Collection window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

Multi-site Mobility Networking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

Messaging and alarms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Overview
DECT allows users to move freely about their work sites while conducting 
telephone conversations using wireless handsets. DECT is an acronym for 
Digital Enhanced Cordless Telecommunications.
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Figure 1
Main parts of the DECT system

The DECT system is in a Large System IPE shelf or a Small System cabinet 
or chassis. DECT has four main components:

a DECT mobility cards

b Base station

c Handsets

d Optivity Telephony Manager (OTM) with DECT application

Clock requirements

The following clock controller cards are mandatory:

• NTRB53 Clock Controller card for a Large System

• NTAK20BD Clock Controller daughterboard or NTAK79AA card with 
a built-in clock controller for a Small System

If there is no digital connection to the network, the appropriate clock 
controller must be installed and operated in free run mode.
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Note: On EMC-hardened Cabinet systems, the clock controller must be 
in one of the first three slots of the CPU cabinet.

Synchronization port

Figure 2
DECT synchronization

Where multiple DECT systems share the same radio coverage area, the 
DECT synchronization port must be used. The DECT synchronization port is 
accessed through an MDF connection. Failure to connect the DECT 
synchronization ports of each system can lead to service interruptions.

Mobility card (DMC8)
The NTCW00AB DMC8 DECT Mobility Card provides an interface 
between the base stations and the Meridian 1, Succession 1000M, or 
Succession 1000.

DECT
DMC

553-AAA0453

a
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Figure 3
DECT Mobility Card 

The DECT system supports a mix of DMCs and DMC8s. A DMC8 supports 
up to eight base stations.

All DMC8s support a Point-to-Point Protocol (PPP) connection to the DECT 
Manager with an NTCW12DA cable. The DMC8 card requires a 
NTCW25AA DECT Manager Ethernet (DME) daughterboard installed to 
support an Ethernet connection.

Each DMC8 is programmed in the database using LD 10.

The DMC8s are interconnected by faceplate cables, allowing them to pass 
information to each other.

DMC8s must be in an IPE shelf or in a cabinet or chassis.

There is no call switching in the DMC8 card. All call switching occurs within 
the Meridian 1, Succession 1000M, or Succession 1000.

DMC

553-AAA0454
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DMC8 options

Figure 4
DMC8 options

The component side of the DMC8 contains jumpers J1, J2, and J3. The 
jumpers indicate card status. 

DMC8 – Expander (DMC8-E)

The NTCW01AB DMC8-E DECT Mobility Card – Expander provides the 
same functions as a DMC card.
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The DMC8-E has additional circuitry required to regenerate faceplate cable 
signals when a system contains more than eight DMC8s. The DMC8-E 
connects two shelves or cabinets in a DECT system.

Figure 5
DECT Mobility Card – Expander

If the DMC8-E is used in an IPE module, it must be located in card slot 8. Do 
not install a DMC8 in slot 8 of an IPE module. 

If the DMC8-E is used in an Small System cabinet or chassis, it must be 
located in card slot 9, 19 or 29. Do not install a DMC8 in slot 9, 19 or 29 of a 
Small System cabinet or chassis.

An NTCW25AA DME daughterboard is required to provide Ethernet OTM 
access. The daughterboard is also required to enable DECT Messaging. The 
DME daughterboard is not required for serial OTM access. Only one DME 
daughterboard is required per system.

DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8

J1

Cont DMC8-E DMC8 DMC8 DMC8 DMC8 DMC8 DMC8DMC8
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Faceplate features

Figure 6 on page 26 shows the following DMC8 and DMC8-E faceplate 
features:

a Red LED (indicates the same status as all IPE cards)

b Yellow LED (indicates DECT sub-system status)

c Green LED (indicates DECT sub-system status)

d DMC8 to DMC8 faceplate cable port 

e DMC8 bypass faceplate cable port 

f DMC8-E to DMC8-E faceplate cable port 

g For future use
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Figure 6
DMC8 and DMC8-E faceplate features
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Faceplate cables

The faceplate cables form the 20 Mb/s bus that connects all DMCs. The 
faceplate cables meet the standard for Unshielded Twisted-Pair category of 
performance 5 (UTP Cat 5).

Signalling and PCM are sent to all DMCs over the faceplate cables, allowing 
a DMC8 to pass a call to another DMC8.

The cables shown in Figure 7 on page 28 are as follows:

a DMC8 to DMC8 faceplate cable

b DMC8 to DMC8-E faceplate cable

c DMC8 faceplate termination 

d DMC8 bypass faceplate cable

The DMC8 to DMC8 cable extends the 20Mb/s bus to all DMCs.

The DMC8 to DMC8-E cable extends the 20Mb/s bus past the XPEC card in 
the IPE shelf.

The DMC8 faceplate termination balances the impedance at either end of the 
20Mb/s bus.

The DMC8 bypass faceplate cable bypasses DMC8s to be inserted in or 
removed from an operational system. The DMC8 bypass faceplate cable is 
shown in Figure 7 on cards 10 and 12.

The DMC8-E to DMC8-E faceplate cable connects two shelves or two 
cabinets. The DMC8-E to DMC8-E faceplate cable is shown in Figure 9 on 
page 30.
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The faceplate cabling layout plan must specify that the DMC8 to DMC8-E 
cable connects into the ports as shown in Figure 7 on page 28.

Figure 7
Faceplate cables

CAUTION — Service Interruption

Customers must use UTP Cat 5 faceplate cables supplied 
by Nortel Networks. Faceplate termination must be used 
on the DMCs at both ends of the faceplate cabling.
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Inter-shelf or cabinet faceplate connections

Figure 8
Cable ferrites 

CAUTION — Service Interruption

The DMC8-E to DMC8-E faceplate cable has four sets of 
movable ferrites. The position of the ferrites on the cable 
is important. See Figure 8. Each end of the cable must 
have a group of 20 ferrites. One quarter the distance from 
each end of the cable must have a group of 10 ferrites. 
The maximum length of the cable is 1.5 meters, limiting 
the position of DECT shelves 0 and 1 to adjacent IPE 
modules or Small System cabinets/chassis.

Group of 20 
ferrites

Group of 10 
ferrites
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Figure 9 shows the following:

a DECT shelf 0

b DECT shelf 1

c DMC8-E to DMC8-E faceplate cable connection between 
DMC8-Es on DECT IPE shelves

Figure 9
IPE inter-shelf faceplate connections
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Figure 10 shows the following:

a Main cabinet

b Expansion cabinet

c Second expansion cabinet

d DMC8-E to DMC8-E faceplate cable connection between the 
DMC8-Es on the first and second cabinets
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Figure 10
Inter-cabinet faceplate connections
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Base stations
There are three base station models available: 

• C4600 – supports six active call radio links

• C4610 – supports 12 active call radio links

• C4610E (with external antenna) – supports 12 active call radio links

Base stations are IP40-compliant wall-mounted transceivers that provide 
digital radio links to handsets.

The base station has the following features:

• RJ45 socket connection to a one meter UTP Cat 5 cable

• RJ45 socket connection to an external or local power supply

• Green LED (C4600) or a yellow LED (C4610), which when lit, indicates 
synchronization to its DMC8

• One meter UTP Cat 5 cable connected through an RJ45 Connect Box and 
MDF to an IPE I/O panel or Small System cabinet I/O panel 

Two sources can power the base station:

• The DMC8 and DMC8-E feeding phantom power over the UTP Cat 5 
cable signaling pairs, connected to (a) in Figure 11 on page 34

• A local power supply, connected to (b) in Figure 11 on page 34

CAUTION — Service Interruption

For maximum line length before signal degradation 
occurs, use UTP Cat 5 cabling between the base station 
and the shelf or cabinet. If the line length exceeds 100 
ohms for the 4610 base station, an external power supply 
must be used. The maximum distance when using 
external power with UTP Cat 5 cabling is approximately 
1.7 km.
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Figure 11
Base Station

Base stations connected to a DMC8 or DMC8-E card can use phantom power 
in some conditions, and must use local power in other conditions. An 
application on the Optivity Telephony Manager (OTM) can enable or disable 
phantom power.

Note: The maximum line length for a twelve-channel base station using 
phantom power is 1.0 km. The maximum line length for a six-channel 
base station, regardless of power, or a twelve-channel base station using 
external power, is 1.7 km.

Base station housing

The base station environmental housing is IP66 compliant. The housing must 
be used indoors if a base station is subject to conductive pollution, or outdoors 
if base stations are mounted externally.

553-AAA0461

a

b

c



 Product description  Page 35 of 612

DECT Description, Planning, Installation, and Operation

Figure 12
Base station environmental housing

The environmental housing kit includes all of the relevant cables and 
installation material. 

The environmental housing mounts to existing walls.

Signaling lines provide power to the external base stations.

Base station cell

A base station cell is the radio signal area covered by a single base station. 
The base stations are positioned so the cells overlap. A DECT handset can 
make and receive calls when it is within a base station cell. When the handset 
moves from one cell to another, the cell overlap allows the handset to move 
without interruptions.

553-AAA0486
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Figure 13
Base station cell

The cell radius varies from 20m to 100m.

The number of base stations required to cover a certain area depends on many 
factors, such as the following:

• Size of the area of coverage

• Radio propagation characteristics of the buildings

• Materials used for walls, floors, lift shafts, reinforced glass, doors 

• Strong magnetic fields from radar, welding equipment, manufacturing 
equipment, and high energy electronic devices

• Density of telephone users in an area and amount of telephone traffic
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Handsets
Four handset models are available: 

• C4010

• C4010 Ex

• C4020

• C4050

The handsets are battery-powered, pocket-sized, portable telephones.

C4010, C4010 Ex, and C4020 handsets

The C4010 is the base model. The C4010 Ex and C4020 handsets have 
additional features or features that are different from the C4010 model. The 
C4010 Ex design lets it operate safely in an explosive atmosphere. The C4020 
accepts a headset and has a vibrate alert feature.
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Figure 14
DECT C4010 handset and C4010 Ex handset

Handset attributes

• Up to 8 hours talk time

• Up to 60 hours standby mode

• Up to 8 days power-save standby mode (cannot receive calls in this 
mode)

• Subscribe to a maximum of 8 DECT systems

• Directory dialling from a 20-name phone book
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• Off-hook number preparation with correction option

• Last number re-dial

• Recall

• Automatic encryption

• Adjustable alerter volume

• Adjustable ear-piece volume in 5 steps

• Six ringing melodies

• Manual ringer mute on incoming calls

• Handsfree operation

Power supply

• 3.6V/600mAh NiMh rechargeable battery pack

Dimensions

• Handset 135 x 58 x 19 mm

• Charger 85 x 75 x 50 mm

Color and finish

• The C4010 and C4020 handset color is charcoal grey, with a non-gloss 
finish

• The C4010Ex handset is yellow

Weight

• Handset 135 g

Accessories

• Belt clip

• Headset for the C4020 only

C4010 battery charger

• Desktop or wall mounted battery charger
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• Mains supply required is 230V/50 Hz

• Power consumption 

Figure 15
C4010 battery charger
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C4050 handset

Figure 16
C4050 handset

Handset attributes

• Up to nine hours speech time

• Standby time of up to 130 hours

• Subscribe to a maximum of 10 DECT systems

• Local directory with alpha search function for 100 entries

• Incoming call indication LED light-ring (red)

• Charging indication LED light-ring (green)

553-AAA0488
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• Visual and audible incoming call signal

• Volume control during a call

• Name display (16 characters) and number display (32 digits)

• Last number redial for up to 20 entries

• Caller list of 20 calls

• Caller filter for 10 entries with on/off settings

• Re-dial function for up to 20 entries

• On-hook number preparation

• Microphone mute

• Prompts in ten languages

• Calling Line Identification (CLID) 

• Key click on or off

• Automatic off-hook on an incoming call, selectable

• Keypad lock

• Headset option

• Ringer, 30 melody selectable

• Ringer volume control, off, plus seven steps

• Tone ringing through the headset in normal speech volume

• Ringer mute while charging, selectable

Power supply

• Two standard AAA 650 mAh NiMh rechargeable batteries

Dimensions

• Handset 140 x 51 x 25.5 mm

• Charger 130 x 82 x 65 mm

Color and finish

• Dark grey and silver with a non-gloss finish
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Accessories

• Belt clip

• Carry case

• Headset

• Desktop charger

• Data charger and data cable

C4050 battery charger

• Charging time maximum eight hours

• Spare batteries have a 24-hour charging time

Figure 17
C4050 charging rack

Subscription and de-subscription

Subscription is the process of adding a handset to a DECT system. The 
handset can then make and receive calls.

A user can subscribe a handset to more than one DECT system. This feature 
is useful for a company that has multiple DECT sites. See Implementing and 
operating MSMN, page 404.
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De-subscription is the process of removing a handset from a DECT system. 
The handset user is then prevented from making and receiving calls.

Note: Refer to the C4010/C4020 Cordless Handset User Guide, and the 
C4050 Handset User Guide for a detailed description of how to use 
handset features and system features.

Optivity Telephony Manager
The Optivity Telephony Manager (OTM) provides a single point of access 
and control to manage multiple applications on a Meridian 1, 
Succession 1000M, or Succession 1000 system.

OTM provides a DECT Application and OTM Common Services to manage 
a DECT system. OTM runs on Windows NT 4.0, Windows 98, and 
Windows 2000 as a server, plus Windows 95 as client.

Note: For an overview of OTM, see Optivity Telephony Manager: 
System Administration (553-3001-330).

DECT Application

Features

The DECT Application allows a user to:

• Launch the Application from OTM using Windows and Web navigators

• View DECT provisioning using the DECT Systems window

• View the DMC8 configuration using the Boards window

• View base station configuration using the Radio Fixed Part window

• View subscription information using the Subscriptions window

• Upgrade firmware using the DECT Systems window

• Subscribe handsets using the Subscription window

• Support DMC8 and DMC (serial only) cards

• Synchronize (update) the DECT Application database to the DECT 
system configuration when the OTM connects to the DECT system
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• Collect performance data using the Performance Collection window

• View On-line Help

Common Services

The following DECT management features are provided by OTM Common 
Services:

• OTM Alarm Management provides alarm collection and alarm 
processing, as well as the following:

— a web-based alarm browser to view alarms, past alarms and 
occurring alarms

— a Windows-based alarm browser to view alarms that occur while the 
browser is open

— an Alarm Notification application to notify personnel of an alarm 
occurrence by pager or E-mail. This application can forward the 
alarm to an upstream processor

— a PC Event log and Viewer to view events and alarms generated 
from the DECT Application in a report layout

• Backup and restore to create and restore an OTM backup file of the 
DECT application data

• User profiles to enable configuration of different types of DECT users 

• On-line help to provide help for common services features

For more information about the Common Services features, see Optivity 
Telephony Manager: System Administration (553-3001-330).

OTM navigators

The DECT Application uses two navigators to manage a DECT system:

• a Windows-based navigator

• a web-based navigator

A Windows-based navigator, with the Microsoft Windows interface, can 
access all DECT Application features. A web-based navigator, that uses the 
web (http) interface, can access most but not all DECT Application features.
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Use the Windows-based navigator to manage a DECT system at the keyboard 
and mouse of an OTM server. See Access with the Windows-based navigator, 
page 52.

Use a web-based navigator to manage a DECT system from a client PC. See 
Access with the web-based navigator, page 54.

Provisioning features

The following provisioning features are available to both Windows-based 
and web-based navigators:

• Define DECT system

• DECT system names

• DECT Concentration mode

• DECT system Access Right

• Transmission parameters

• DMC8 provisioning

• Firmware provisioning

• Base Station provisioning

Operation features

The following operation features are available to both Windows-based and 
web-based navigators:

• DECT system connectivity

• DECT system connection control

• Read data from a DECT system on demand

• Define handsets with the overlays in the OTM database

• Define handsets in the DECT database

• Subscribe handsets
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Maintenance features

The following maintenance features are available to both Windows-based 
and web-based navigators:

• Operational status monitoring

• Alarm management

• Date and time

• Upstream Manager IP address

• Basic browser

• DECT system data synchronization with the DECT Manager database

• Performance

• PC Event Log

Windows-based navigator features

The following features are only available at an OTM server using the 
Windows-based navigator. The OTM server enables the following:

• Define DECT system sites

• Define PBX system

• Configure handsets with the Station Administration feature of OTM

• OTM Alarm Notification

• PC Event log and Viewer

• Backup and restore the DECT Manager database to and from a file

• Define a user profile for Windows-based applications

• Define user management for Windows-based applications

Security features

For information about the Security features, see Optivity Telephony 
Manager: System Administration (553-3001-330). 
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OTM server connections to DECT 

Figure 18 on page 49 shows an overview of an OTM server connected to a 
DECT system over a V.24 interface. 

Web clients access the OTM server over a LAN, WAN and the Public 
Switched Telephone Network using modems. For the OTM to communicate 
over PPP with DECT, configure Remote Access Service (RAS) for modem 
dial out. See “Access with the web-based navigator” on page 54. For more 
information about OTM access, see Optivity Telephony Manager: System 
Administration (553-3001-330).

A client, in this context, is a DECT application that runs on a personal 
computer or workstation, and depends on an OTM server to perform some 
operations. For example, a DECT Application client is an application that 
enables personnel to manage a DECT system.

Figure 19 on page 50 shows an overview of an OTM server connected to a 
DECT system, over a dedicated LAN interface.

Remote Access Service (RAS)

A computer in a network provides access to remote users through analog 
modem or ISDN connections. It includes the dial-up protocols and access 
control (authentication), and can be a regular file server with remote access 
software or a proprietary system. The modems can be internal or external to 
the device.

ISDN is an international telecommunications standard for providing a digital 
service from the customer's premises to the dial-up telephone network.
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Figure 18
Local OTM server access to a DECT system by V.24
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Figure 19
Local OTM server access to a DECT system by dedicated LAN

Synchronize DECT and Station Administration Configuration

The Synchronize DECT and Station Administration Configuration dialog 
is selected from the Operations menu (Retrieve OTM Configuration) if 
there is a mismatch. If there is no mismatch, synchronization occurs and 
Figure 20 on page 51 does not appear.

Large System
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Figure 20
Synchronize DECT and Station Administration Configuration Mismatch

DECT systems support configured and subscribed handsets as TNs. 
The Meridian 1, Succession 1000M, or Succession 1000 has matching TN 
handsets configured in LD 10.

PBX to DECT system synchronization

If the PBX configuration data is available through the OTM Station 
Administration database, then a synchronization facility is available to import 
the data into the DECT Manager. Synchronization is subject to the following 
rules:

• A handset not listed in the DECT Manager, but present in the OTM 
database, is added in the DECT Manager list.

• If the DECT Manager lists a handset, but the OTM database does not, the 
DECT Manager prompts to either keep or remove the handset.

To add handsets to the DECT manager, select Configure from the 
Operations menu. See “Synchronize DECT and Station Administration 
Configuration” on page 50.

The Synchronize DECT and Station Administration Mismatch dialog box 
highlights DMC TNs in the DECT Manager that are not configured in the 
OTM Station Administration. Those subscriptions must be kept in the DECT 
manager so they can be checked. See Figure 20 on page 51.
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If there is no mismatch that OTM cannot resolve automatically, the 
Synchronize DECT and Station Administration dialog does not appear. 

Two examples of mismatches that OTM cannot resolve automatically are as 
follows:

• There are no entries in the Station Administration database, or 

• The DECT Manager does not have a DMC configured in a PBX TN 
location, but an entry exists in the Station Administration database.

Access with the Windows-based navigator

For access from a web-based navigator, see “Access with the web-based 
navigator” on page 54.

Login to the OTM

Access the OTM Login dialog box using the Start menu, under Programs, 
OTM. The login dialog appears as shown in Figure 21. After entering a 
User ID and Password, the OTM Windows Navigator window appears, as 
shown in Figure 22.

Figure 21
OTM login dialog box

Note: See Optivity Telephony Manager: System Administration 
(553-3001-330) for details about the OTM login dialog box.
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Select the PBX that supports DECT

In the OTM Navigator window, select the system that supports DECT to be 
administered. Double-click on the system (shown as Sample Site in 
Figure 22), and the M1 System Window appears. See Figure 23 on page 54.

Figure 22
OTM Navigator window

Note: See Optivity Telephony Manager: System Administration 
(553-3001-330) for details about the OTM Navigator window.
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Open DECT Application

Open the DECT application by double clicking on DECT (shown in 
Figure 23), or open through the File menu. This action displays the DECT 
System window, shown in Figure 29 on page 62.

Figure 23
M 1 System Window

Access with the web-based navigator

For more detailed information on web-based navigators, see Optivity 
Telephony Manager: System Administration (553-3001-330).

Administrator Login

To open the OTM web Administrator login screen, seen in Figure 24, enter 
the URL http:otm_server_name or use the ip_ address, in either the Microsoft 
Internet Explorer web browser or the Netscape Navigator web browser.



 Product description  Page 55 of 612

DECT Description, Planning, Installation, and Operation

To launch the Administrator Login, click on the applet launch logo. See 
Figure 24.

Figure 24
OTM web Administrator login
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Current Status

The Current Status screen appears after logging in through the Administrator 
Login screen. See Figure 25.

Figure 25
OTM web navigator current Status

The screen in Figure 25 displays the current status of:

• OTM software release version

• Time and date of the last login

• OTM server applications
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The Current Status screen allows web navigator access to the items listed on 
the left side of the screen.

System navigator

To select the System navigator, click on System Navigator in the list on the 
left of the Current Status screen. See Figure 25 on page 56.

Figure 26
OTM web system navigator

The System navigator window opens, as seen in Figure 26.
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Select a DECT system(s). From the grey box on the left of the System 
navigator window, select an application to be opened for that system. For 
example, select OTM DECT to open the Systems window (see page 61). 
Select Alarms to open the Alarm browser window. See page 58.

Alarm browser

The Alarm browser, seen in Figure 27, can be opened from the System 
navigator window in one of two ways:

• by clicking on System Alarms in the list on the left of the screen

• by selecting Alarms in the gray box on the right of the screen
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Figure 27
OTM web system Alarm browser

The Alarm Browser enables the system alarms to be examined.

Web Access security

To open the Web Access security screen, click on Web Navigator Access 
from the list on the left in the System Navigator window, as seen in Figure 26 
on page 57. 

The Web Access security window opens. See Figure 28.



Page 60 of 612  Product description

553-3001-370 Standard 1.00 October 2003

Figure 28
Web Access security

Group and individual access permissions can be changed by the Windows NT 
User Administrator.
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Systems window
Use the DECT Systems window to enable the following features:

• Select a DECT system to view database details, or select all DECT 
systems to view database details.

• Add a DECT system.

• Delete a DECT system.

• Connect to, disconnect from, lock or unlock a connection between the 
OTM server and a DECT system. See “Connecting to a DECT system” 
on page 421.

• Open the following windows for the selected DECT systems:

— Subscriptions

— DMC Boards

— Base station Radio Fixed Parts

— Active Alarm Snapshot

— Performance Collection

— Current RSSI data
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Figure 29
DECT Systems window

List filter

List

Connection status

Operation progress
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Menu

The DECT Systems window displays the following:

• File – contains a pull-down menu that allows one of the following to be 
selected:

— Add – creates a new DECT system with default values and opens the 
DECT System Properties window

— Delete – removes a DECT system from the OTM server/OTM client

— Connect / Lock / Disconnect – the same functions as the Connect/
Disconnect tool. See “Connecting to a DECT system” on page 421.

— Properties – opens the DECT System Properties window (Figure 30 
to Figure 41)

— Close – closes the client application and all DECT windows opened 
by that client

• View – contains a pull-down menu that allows the following bars to be 
shown or hidden:

— Tool bar

— Status bar

• Applications – contains a pull-down menu that allows the following 
windows to be opened:

— Subscriptions (Figure 47 on page 81)

— Boards (DMC) (Figure 60 on page 100)

— Radios (base stations) (Figure 62 on page 104)

— Current Alarms 

— Performance Collection (Figure 66 on page 112)

— Current RSSI data (Figure 68 on page 115)

• Firmware – contains a pull-down menu that allows the following 
windows to be opened:

— Upload – loads firmware to DMC (Figure 42 on page 77)

— Activation – makes firmware active 
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• Help – contains a pull-down menu used to select the following:

— Content and Index

— About OTM DECT Management application

• Tool bar icon – used to click a tool button to do the following:

Note: While the Connection status is Connecting or Disconnecting, the 
Connect/Disconnect tool is disabled. The status bar shows the 
connection progress.

• List filter – select one of the following:

— This Meridian only – lists the DECT System data selected from the 
M1 System Window. See Figure 23 on page 54.

— All DECT systems – lists every DECT systems data managed by the 
OTM server

• List field – shows the following for the DECT system or systems 
selected from the M 1 System Window (Figure 23 on page 54):

— Site name/location (Figure 30 on page 62)

— PBX name (Figure 30)

— DECT system name (Figure 30)

— Presence of an alarm (Figure 40 on page 75)

Opens a connection to a DECT system selected in the List, 
when the Connection status shows Disconnected. When 
opened, the icon turns red. See “Connecting to a DECT 
system” on page 421.

Locks the connection to a DECT system when the 
Connection status is Connected. This prevents another user 
from closing the connection.

Disconnects from a DECT system when the Connection 
status is Connected.

Unlocks the connection from a DECT system when the 
Connection status is Connected/Locked.
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— IP address, for the DECT system (Figure 36 on page 71)

— Primary Access Rights Identifier (Figure 38 on page 73)

— Concentration mode (Figure 30)

— Number of subscribed handsets (Figure 30)

— Connection status

• Connection status field – shows the current state of the connection, 
where:

— Disconnected – indicates no communication between the OTM 
server and a DECT system.

— Connected – indicates communication between the OTM server and 
a DECT system for an operation initiated by a user. The connection 
disconnects when the operation is finished.

• Operation progress field – shows the last received event associated 
with the connection, such as the following:

— Disconnecting

— Connecting

— Modem Busy

— Dialing

System Properties dialog

The DECT System Properties dialog is selected from the File menu. The 
DECT System Properties window has five tabs:

• General

• Communication

• Access Right Identification

• Alarm

• Parameters

See Figure 30 on page 66.
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DECT System Properties dialog – General tab

Figure 30
DECT System Properties – General tab

The General tab enables the following options:

• View Site Name.

• View Meridian Name.

• View or change the DECT System Name (Figure 31 on page 67 and 
Figure 32 on page 67).

• Change the password (Figure 33 on page 68).

• View if Concentration Mode is active or not active.

• View Number of Subscribed Users.
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The DECT System Name Missing window appears when a DECT system 
name is not entered. See Figure 31.

Figure 31
DECT System Name Missing dialog

The application will not save a system unless a unique name has been 
provided.

The DECT System Name Already in Use window appears when a DECT 
system name is the same as the name of another system. See Figure 32.

Figure 32
DECT System Name Already in Use dialog

The Change DECT System Password window is selected from the DECT 
System Properties – General tab. See Figure 33.
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Figure 33
Change DECT System Password dialog

If the new password does not match the confirmed password, a dialog box 
opens and warns that the passwords do not match and allows the passwords 
to be changed.

DECT System Properties dialog – Communication tab

The DECT System Properties dialog is selected from the File menu. See 
Figure 34 on page 69.
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Figure 34
DECT System Properties – Communication tab

The Communication tab enables the following features:

• View or change the unique IP address; used if the connection is Serial or 
Ethernet.

• View the Subnetwork Mask.

• View the Gateway IP address.

• Check a Permanent Connection to keep the connection open and open the 
connection when the OTM starts.

• Select Close Connection (see Figure 35 on page 70).

• Select Ethernet or Serial connection.

• Select Details for the Serial connection (see Figure 36 on page 71).
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• Select a new DECT system definition by pressing the OK button. This 
causes the manager to try to connect to a new DECT system and write the 
system name in MIB2, after the following is done:

— Enter the new system IP address.

— Specify the new system name.

The Close Connection dialog opens when the Close Connection button on 
the DECT System Properties – Communication tab is clicked. See Figure 35.

Figure 35
Close Connection dialog
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DECT System Detailed Connection settings properties is selected from the 
Details button of the DECT System Properties – Communication tab. See 
Figure 36.

Figure 36
DECT System Detailed Connection settings properties
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DECT System Detailed Connection settings properties enables the 
following options:

• View or change the OTM Server IP interface assigned to the PC RAS 
port interface on the same network as DECT.

• View or select the COM Port attached to either DECT or the modem.

• Select a modem mode.

• View or change the Phone Number that dials the modem.

Figure 37
Local and remote IP address for serial connections

Serial links

DECT System 1

DECT System n

IP at DECT System 1 remote

IP at DECT System n remote

IP at DECT System 1 local

IP at DECT System n local

OTM Server

553-AAA0506
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Supply an IP address for local and remote ends of the serial link, so the OTM 
can route IP traffic to the correct DECT system. See Figure 37.

DECT System Properties dialog – Access Right Identification tab

The DECT System Properties dialog is selected from the File menu. See 
Figure 38.

Figure 38
DECT System Properties – Access Right Identification tab

There are two Access Right Identifications, a Primary Access Right 
Identification (PARI) and a Secondary Access Right Identification (SARI), 
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which identify each DECT system. The Access Right Identification enables 
the following:

• View or change the PARI. See Figure 39 on page 74.

• View or change the SARI. (A SARI dialog box is similar to that shown 
in Figure 39.)

The Change DECT System PARI window appears when the Change 
PARI... button on the Access Right Identification tab is pressed. See 
Figure 39.

Figure 39
Change PARI dialog

Do not change the PARI or SARI until connected to the DECT system 
requiring the new PARI or SARI.

During synchronization, a dialog warns if a DECT system has a different 
PARI or SARI than the OTM DECT manager. 

See “Multi-site Mobility Networking subscriptions” on page 98 for additional 
information about changing the PARI and SARI.



 Product description  Page 75 of 612

DECT Description, Planning, Installation, and Operation

DECT System Properties dialog – Alarm tab

The DECT System Properties dialog is selected from the File menu. See 
Figure 40.

Figure 40
DECT System Properties – Alarm tab

The Alarm enables the following options:

• View a Yes or No in the active alarm when the manager is connected to 
a DECT system with an active alarm.

• View or change the Upstream Manager IP address. The DECT system 
can send alarms to an upstream manager.

• View or change the Date and Time, used to timestamp alarms. When not 
connected, the Date and Time fields are blank. When the DECT system 
is reset, the time and date are not updated.
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DECT System Properties dialog – Parameters tab

The DECT System Properties dialog is selected from the File menu. See 
Figure 41.

Figure 41
DECT System Properties – Parameters tab

The Parameters tab enables the following options:

• View or change Tone Duration in milliseconds.

• View or change Inter Digit Pulse width in milliseconds.

• View or change Level 1 – low frequency in decibels.

• View or change Level 2 – low frequency in decibels.
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• View or change Analog/Digital loss pad – handset to system in decibels.

• View or change Analog/Digital loss pad – system to handset in decibels.

• Set all parameters to Factory Default values.

The DECT System Properties Parameters are read from DECT on 
synchronization. 

Firmware upload and activation

The Firmware upload dialog is selected from the Firmware menu.

Figure 42
Firmware upload with DMC-4 dialog

The designator DMC is used to differentiate between the NTCW00AA DMC 
card and the NTCW00AB DMC8 card. 

This dialog alerts that a DMC card cannot support a firmware upload. If OK 
is selected, a file chooser allows a firmware file to be selected from the Client 

WARNING — System Failure

Do not use the Advanced.... button. It can cause the 
system to fail.
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or from the OTM server. See Figure 44 on page 79. When OK is selected, the 
existing standby firmware can be replaced with new firmware.

Do one of the following:

• Accept the firmware for DECT.

• Cancel the firmware upload for DECT.

See Figure 42 on page 77.

Figure 43
Firmware upload dialog
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Figure 44
Firmware activation dialog

Figure 45
Upload file chooser
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The Upload radio buttons enable the following options:

• Browse files on the Client PC.

• Browse files on the OTM Server.

Select a file from either the client or the server to upload to DECT.

Figure 46
Progress indicator
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Subscriptions window
The Subscriptions window is selected from the DECT Systems window 
Applications menu. See Figure 47.

Figure 47
Subscriptions window

553-AAA0516
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Features

The Subscriptions window enables the following:

• Connect to, disconnect from, lock or unlock a connection between the 
OTM server and a DECT system.

• Choose to show, in any combination, (see Figure 49 on page 87 and 
Figure 50 on page 88) handsets that are:

— Available

— Subscribed

— Enabled

— Blacklisted

— Configured on one DMC8 or all DMC8s

• Subscribe (configure) handsets.

• De-subscribe handsets.

• Copy subscription data.

• Move subscription data.

• Delete subscription data.

• Find subscription data.

• Export subscription data.

• Import subscription data.

Note: To use a handset, the handset must first be programmed on the 
system using LD 10.

Menu

The Subscriptions window displays the following:

• File – contains a pull-down menu allowing one of the following to be 
selected:

— Import – a subscription from a file (see Figure 53 on page 92)

— Export – a subscription to a file (see Figure 54 on page 93)
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— Connect – Lock, Unlock, Disconnect

— Properties – includes data in the subscription list and International 
Portable User Identifier (IPUI) (see Figure 58 on page 97)

— Close – close the Subscriptions window

• View – contains a pull-down menu that shows or hides the following:

— Tool bar

— Status bar

• Edit – contains a pull-down menu to open the following dialog boxes:

— Copy (see Figure 51 on page 89)

— Delete (see Figure 50 on page 88)

— Find (see Figure 55 on page 94)

• Operations – contains a pull-down menu to open the following 
windows:

— Configure – to program a handset on the system. See Figure 48 on 
page 86.

— Set Default PARK – enter the default Portable Access Rights Key. 
See Figure 59 on.)

— Enable – to subscribe a handset

— Disable – to de-subscribe a handset from one DECT system (see 
Figure 56 on page 95) or de-subscribe a handset from all DECT 
systems, for example, Multi Site Mobility Networking. See the 
section “Multi-site Mobility Networking subscriptions” on page 98.

— Force Disable – to return the subscription to the available state, and 
requests the system to disable the subscription. However, there is no 
interaction between the system and handset. See Figure 57 on 
page 96.

— Retrieve OTM Configuration – to retrieve the handset configuration 
from the OTM Station Administration database. If there is a 
mismatch between the Station Administration configuration and the 
DECT application configuration, see Figure 20 on page 51.

• Help – contains a pull-down menu to select the following:
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— Content and Index

— About DECT application

• Tool bar – click the appropriate tool button to do the following:

• List filter – to show or hide details of handsets that are:

— Available (see Figure 49 on page 87 and Figure 50 on page 88)

— Subscribed (Figure 49 and Figure 50)

— Enabled (Figure 49 and Figure 50)

— Black-listed (Figure 49 and Figure 50)

Note: DMC restricts the list to subscription data for one DMC or lists 
subscription data for all DMC 

Connect Performs same functions as 
“Systems window” on page 61.

Lock Performs same functions as 
“Systems window” on page 61.

Unlock Performs same functions as 
“Systems window” on page 61.

Disconnect Performs same functions as 
“Systems window” on page 61.

Enable Subscribes a handset.

Disable De-subscribes a handset.

Configure Programs a handset.
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• List – to show the following subscription details for handsets assigned to 
a <sitename>, a <PBX name>, a <DECT system name>. See the 
Figure 47 title bar on page 81.

— DMC TN

— Index – 32 units or 510 virtual units for concentration on a DMC

— Concentrated handset Home DN

— Concentrated handset Local DN – different than Home DN for 
visitor concentrated handset

— Virtual TN for concentration handsets

— Subscription PARK

— Subscription status – updated by SNMP traps from DECT

— PIN code appears during subscription activation

— An 80-character comment

• Pop up menu – available when at least one subscription is selected. The 
pop-up menu contains the following items:

— Configure

— Enable

— Disable

— Copy

— Move

— Delete

— Export

— Properties

— Help

• Status bar – shows the following:

— Connection status

— Operation status

— Current subscription PARK
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Configure and enable subscriptions

Figure 48
Configure DECT Subscription dialog

Configure DECT Subscription enables the following:

• Select a DMC TN.

• Enter the first subscription index (unit, as in l s c u).

• Select a number of consecutive subscriptions.

When configured, the subscription becomes available and the subscription 
can be enabled. During the enable process, the DECT manager generates a 
PIN code for the subscription. See Figure 49 on page 87.
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Figure 49
Enable a subscription

Disable subscriptions

A subscription can be de-subscribed in the following ways:

• As a single handset 

• In a list of selected handsets

• For all handsets on a DMC

Available

Enabled

Subscribed

PIN
code

entered within
15 minutes

?

No

Yes

DECT channel is configured
and available for subscription.

The subscription process starts with the user selecting
the handset(s) and pulling down the Operations menu
then clicking on Enable

The handset is now ready to make and receive calls

The OTM DECT manager provides a PIN

553-AAA0518
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Figure 50
Disable a subscription

Launching an on-air de-subscription requires an open connection to DECT.

When the DECT Manager starts the de-subscription, DECT holds the 
de-subscription until one of the following occurs:

• The handset makes or receives a call.

• The DECT Manager removes the subscription.

The DECT system notifies the DECT Manager that the handset is 
de-subscribed.

The DECT Manager can stop a handset from operating on all the DECT 
systems where the handset is subscribed with a given International Portable 
User Identifier (IPUI).

Available

Black listed

Subscribed

The de-subscription process starts with the user 
selecting the handset(s) and pulling down the 
Operations menu, then clicking on Disable

The handset can make and receive calls

The following conditions must exist:
- connection with the system
- handset in range
- handset on
- handset go off-hook or called 

Handset ready for subscription

553-AAA0519
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To stop a handset from operating, the handset must be within radio range and 
ready for on-air de-subscription. The process removes handset subscription 
data from:

a the DECT system DMCs,

b the handset, and

c the DECT managers handset and DECT system files.

When the handset’s subscription data is removed, the handset no longer 
works on any DECT system.

Copy subscriptions

The DECT Copy Subscription dialog is selected from the Edit menu.

Figure 51
DECT Copy Subscription dialog

The DECT Copy Subscription dialog allows subscriptions to be copied 
from a DMC on DECT system A and then pasted into a DMC on DECT 
system B. The subscriptions must have a Subscribed status.

Ensure the connection to the destination system is open. Select the 
Destination DECT system and the Destination DMC from the DECT Copy 
Subscription dialog.
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Subscriptions can be copied from:

a a single handset subscription,

b a list of selected subscriptions, or 

c a DMC.

Note: Subscriptions cannot be copied within the same DECT system. 
When a subscription is copied, only DECT data is copied, not the PBX 
data.

In Figure 51 on page 89, the source subscription data appears in the three left 
columns: DMC TN, Index, and Local DN. View the source subscription from 
the Subscription window. The destination subscription data is in columns 
To: DMC TN, and To: Index. Index is the Unit on the DMC. When the 
dialog opens, the source DMCs and destination DMCs are the same.

When copying subscription data, ensure a connection exists between the 
source DECT system and the destination DECT system.

The Copy Subscription feature provides a way to support Multi-site Mobility 
Networking, by allowing handsets to be subscribed without being on the 
Distributor Premises.

Replace subscriptions

The Replace DECT Subscription dialog allows an action to be confirmed if 
more than one subscription will be overwritten at the destination. See 
Figure 52.
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Figure 52
Replace DECT Subscription dialog

Move subscriptions

The Move Subscriptions dialog is selected from the Edit menu.

Move Subscriptions is similar to Copy, except for the following. The Move 
Subscriptions dialog allows subscriptions to be cut/removed from a DMC on 
DECT system A, and the subscriptions pasted into a DMC on the same DECT 
system, or on DECT system B. 

When using Move, the source DECT system and the destination DECT 
system must be connected.

Import subscriptions

The DECT Import Subscriptions dialog is selected from the File menu. See 
Figure 53.
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Figure 53
DECT Import Subscription dialog

Import Subscriptions is similar to Copy, except for the following. The import 
dialog allows subscriptions to be copied from an import file and the 
subscriptions pasted into a DMC on a DECT system. 

To paste a subscription, ensure a connection to the destination DECT system.

Delete subscriptions

The Delete operation allows handset information to be removed from the 
manager and the DECT system, but not the handset. The Delete operation 
does not require the handset to be available for on-air de-subscription. The 
Delete operation:

a removes DECT handset subscription data, 

b retains the handsets subscription data, if the handset had 
subscription data. (As the handset does not remove its subscription 
data, it continues operating on all the DECT systems where this 
subscription is relevant.), and

c removes the DECT manager handsets subscription data including 
comments and PBX Station Administration data.



 Product description  Page 93 of 612

DECT Description, Planning, Installation, and Operation

The DECT Manager can be used to remove subscription records from:

a a single handset subscription,

b a list of selected subscriptions, or

c a DMC or from all DMCs at once.

The subscription removal requires an open connection to the DECT system.

Remove subscription records for the following reasons:

• To clean a Multi Site Mobility Networking DECT system subscriptions 
on the distributors premises.

• To move a DMC from one DECT system to another.

Export subscriptions

The Export DECT Subscriptions dialog is selected from the File menu.

Figure 54
Export Subscription dialog

Export Subscriptions is similar to Copy, except for the following. The export 
dialog copies subscriptions from a DECT system and pastes them into a file. 
See Figure 54.
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Note: Import and Export support Multi-site Mobility Networking and 
Subscription on the Distributor Premises to a DECT system normally 
managed by OTM “B”, not OTM “A”.

Find subscriptions

The Find DECT Subscriptions dialog is selected from the Edit menu.

The Find operation allows subscription information to be located by 
searching for an IPUI or a Home DN, using the Find DECT Subscription 
dialog. See Figure 55 on page 94.

The Find action displays the subscription information in the Find DECT 
Subscription Result dialog box.

Figure 55
Find Subscription dialog



 Product description  Page 95 of 612

DECT Description, Planning, Installation, and Operation

Disable subscriptions

The Disable DECT Subscriptions dialog is selected from the Operations 
menu.

Figure 56
Disable DECT Subscription dialog

Use the Disable DECT Subscriptions window to disable a handset from all 
DECT systems used in Multi-site Mobility Networking systems. See 
Figure 56.

Use from this system only or if the handset is on-air on this DECT system. 
This DECT system contacts the handset. When contact is established, the 
subscription is removed from the handset. The subscription is removed from 
both the system database and the OTM server database. The other DECT 
systems remove subscription data in the background, and the OTM server 
updates its database for these systems.

If from all systems where the portable set is subscribed is used, all DECT 
systems are asked to contact the handset. The first DECT system to contact 
the handset removes the handset’s subscription. The subscription is removed 
from the first DECT system database, and the OTM server database. The 
other DECT systems remove subscription data in the background and the 
OTM server updates its database for these systems.

Force disable subscriptions

The Force disable DECT Subscriptions dialog is selected from the 
Operations menu.
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Figure 57
Force disable DECT Subscription dialog

Force disable returns the subscription to the available state and requests the 
system to disable the subscription. However, there is no interaction between 
the system and handset.

Force disable can be used when the handset is not in range or on-air.

Select on this DECT System only or to remove the handset subscription 
from only this DECT system and remove the handset subscription from all 
other DECT systems in the background. See Figure 57.

Select on all DECT Systems where it is present? to remove the handset 
subscription from all systems at the same time. See Figure 57.



 Product description  Page 97 of 612

DECT Description, Planning, Installation, and Operation

Subscription Properties

The DECT Subscription Properties sheet is selected from the File menu. 
The DECT Subscription Properties sheet is shown in Figure 58.

Figure 58
DECT Subscription Properties

Features

The DECT Subscription properties sheet enables the following:

• View the DMC Terminal Number.

• View the Index. Index is the TN unit, as programmed in LD 10 in a 
non-concentrated system, and a virtual TN unit in a concentrated system.

• Change and apply Comments, up to 80 characters.

• View Home Directory Number (where the handset is configured on the 
PBX as the home location).
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• View Local Directory Number.

• View Home handset only.

• View handset Virtual Terminal Number.

• View the International Portable User Identifier (IPUI).

• View the subscription PARK.

• View the subscription status.

• View the subscription PIN.

DECT Subscription Properties sheet definition

The DECT Subscription Properties sheet displays the same subscription data 
as the Subscriptions window list items. 

Multi-site Mobility Networking subscriptions

In Multi-site Mobility Networking (MSMN), users can take their DECT 
handsets to other sites in the network, and make and receive calls as if they 
were at their home location. A handset is subscribed in a given DECT system 
and can be used in one or many DECT systems. 

For information on MSMN feature description, feature interaction, feature 
packaging, and operating parameters, see “Multi-site Mobility Networking” 
on page 116. For information on MSMN feature implementation and 
operation, refer to Implementing and operating MSMN, page 404.

Every handset has a Portable Access Rights Key (PARK). Every DECT 
system has a Primary Access Rights Identifier (PARI), and can have a 
Secondary Access Rights Identifier (SARI).

The handset PARK and DECT system PARI and SARI are used by the 
handset and DECT system to identify each other. The PARK and PARI/SARI 
match allow the handset to work with a DECT system.

In an MSMN network, for example, DECT system “A” has a PARI matching 
a handset PARK while DECT systems “B,” “C,” and “D” have a SARI 
matching the handset PARK.
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The DECT Manager user programs the SARI in the DECT system. The 
DECT Manager provides the PARK during the on-air subscription, and the 
PARK is programed into the handset at subscription time. See Figure 38 on 
page 73 and Figure 39 on page 74.

For example, a handset can be subscribed to a DECT system on a distributor’s 
premises, where the handset is not to be in operation. Then the subscription 
data is downloaded to a DECT system where the handset is to be in operation. 
The PARI, where the handset is subscribed, and the SARI, where the handset 
is used, are not always the same. The PARK matching the destination DECT 
system to the handset is provided during the on-air subscription.

Figure 59
DECT Default Subscription PARK dialog

The DECT Manager provides the ability to specify the PARK given to the 
handset, to support Multi-site Mobility Networking and Subscription on the 
distributor premises. See Figure 39 on page 74. The PARK normally defaults 
to the PARI of the system where the on-air subscription occurs. For MSMN, 
the default PARK must be equal to the network SARI value for any 
subscription activity to take place.

The PARK used by the OTM DECT subscription application is subject to the 
following conditions:

• PARK is limited to the lifetime of the subscription application.

• Two users can use a different PARK on the same DECT system at the 
same time.

• PARK is not recorded in persistent storage.
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DMC boards window
The DMC Boards window, seen in Figure 60, is selected from the DECT 
Systems window Applications menu, seen in Figure 29 on page 62.

Figure 60
DMC Boards window

Features

The Boards (DMC) window enables the following options:

• Examine DMC details.

• Connect to, disconnect from, lock or unlock a connection between the 
OTM manager and a DECT system.

• Show Operational DMC, Non-operational DMC, or both.

• Open a properties sheet.
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Menu

The Boards window displays the following DMC data: 

• File – contains a pull-down menu to select one of the following:

— Clear – erases all subscriptions, sets all base stations to installed 
status and line powered, allows the DMC to be programmed in a new 
DECT system.

— Connect – Lock, Unlock, Disconnect, works the same as the 
Connect/Disconnect tool.

— Properties – see Figure 61 on page 103.

— Close – closes the DMC window.

• View – contains a pull-down menu to show or hide the following:

— Tool bar.

— Status bar.

• Synchronization – contains a pull-down menu to enable the following:

— Synchronize From – subscription and base station alarm muting/
power source configuration data from a DMC to the OTM server.

— Synchronize To – subscription and base station alarm muting/power 
source configuration data from the OTM server to a DMC.

• Help – contains a pull-down menu to select the following:

— Content and Index.

— About DECT application.

• Tool bar � used to click a tool button to do the following:

Connect Performs same functions as “Menu” on 
page 101.

Lock Performs same functions as “Menu” on 
page 101.
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• List filter – to show list details of only the operational DMC or non- 
operational DMC or both.

• List – shows the following DMC details:

— DMC TN.

— DMC type.

— Relay DMC.

— Operational state – when DMC operational status changes, the OTM 
server updates the status.

— Number of handsets on a DMC.

— An 80-character comment.

• Pop up menu – supports the following actions:

— Synchronize from DMC.

— Synchronize to DMC.

— Properties.

— Help.

• Properties – displays additional information about DMC. Only the 
comment can be modified. See Figure 61 on page 103.

Unlock Performs same functions as “Menu” on 
page 101.

Disconnect Performs same functions as “Menu” on 
page 101.
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DECT Board properties sheet

The DECT Board properties sheet (see Figure 61) is selected from the File 
menu.

Figure 61
Board (DMC) properties sheet

Options

The DECT Board properties sheet enables the following options:

• View DMC details.

• View operational status. When the DMC operational status changes on 
DECT, the OTM updates the status.

• Change and apply comments, up to 80 characters.

• View DMC Type Number.
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• View DMC Manufacture Code.

• View DMC Standby Software Package.

• View DMC Boot Package.

• View DMC Protocol Version.

• Open the help file.

• Close the properties sheet.

Radio Fixed Part (base station) window 
The Radio Fixed Part (RFP) window (see Figure 62) is selected from the 
DECT Systems window Applications menu. See Figure 29.

Figure 62
RFP (base station) window

The RFP window enables the following:

• Examine base station details.
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• Connect to, disconnect from, lock or unlock a connection between the 
OTM server and a DECT system.

• Choose to show Muted base stations, or Not Muted base stations, or both.

• Open a properties sheet.

Menu

The RFP window displays the following base station data: 

• File – contains a pull-down menu to select one of the following:

— Connect / Lock / Unlock / Disconnect, works the same as the 
Connect/Disconnect tool.

— Properties, opens the Radio Fixed Part properties sheet.

— Close, closes the Radio Fixed Part window.

• View – contains a pull-down menu to show or hide the following:

— Tool bar.

— Status bar.

• Edit – contains a pull-down menu to do the following:

— Mute Alarms – keeps a selected base station from generating alarms.

— Cancel Mute Alarms – allows a selected base station to generate 
alarms.

Note: View alarms on the OTM Alarm browsers (common services) or 
on the Active Alarm Snapshot window. See Figure 64 on page 109.

Mute Keeps a base station from generating alarm 
messages.

Cancel 
Mute

Allows a base station to generate alarm 
messages.
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• Help – contains a pull-down menu to select the following:

— Content and Index.

— About DECT application.

• Tool bar icon – click the tool button to do the following:

• List filter – to select a list showing base stations allowed to generate 
alarms, or base stations not allowed to generate alarms, or both.

• List – displays the following:

— DMC TN – connected to a base station.

— Radio Identifier – identifies the base station (1 to 4) connected to the 
DMC and the base station (1 to 8) connected to the DMC8.

— Operational State – indicates if a base station is operational or is not 
operational.

— Alarm Muted – indicates if a base station is allowed to generate 
alarms or not.

Connect Performs same functions as noted in File 
above.

Lock Performs same functions as noted in File 
above.

Unlock Performs same functions as noted in File 
above.

Disconnect Performs same functions as noted in File 
above.

Mute Keeps a selected base station from generating 
alarms.

Cancel Allows a selected base station to generate 
alarms.
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— Number of Channels – identifies the base station as either a 
6-channel or a 12-channel base station.

— Comment – an 80-character comment field in the DECT application.

• Pop-up menu – appears when at least one base station, also known as a 
Radio Fixed Part (RFP), is selected and right-clicked. Selecting one or 
more base stations by clicking/double-clicking on a Radio Identifier, or 
highlighting a row in the list, displays a Properties sheet. See Figure 63 
on page 107.

• Help – select Content and Index or About DECT application.

DECT Radio Fixed Parts (base station) properties sheet 

The DECT Radio Fixed Parts properties sheet is selected from the pop-up 
menu.

Figure 63
Radio Fixed Part (base station) properties sheet
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The DECT Radio Fixed Parts properties sheet options

The RFP properties sheet enables the following:

• View base station details.

• View Operational Status. When the base station operational status 
changes, the OTM server updates the status.

• Change and apply Alarm Muting.

• Change and apply comments – up to 80 characters.

• Select Line Power (powered by the DMC card) or Local Powered.

• Open the help file.

• Close the properties sheet.

RFP properties sheet definition

The Radio Fixed Part properties sheet displays the same base station data as 
the Radio Fixed Part window list items. The properties sheet also shows the 
power source for the selected base station. 

Active Alarm Snapshot window
The Active Alarm Snapshot window is selected from the DECT Systems 
window Applications menu.
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Figure 64
Active Alarm Snapshot window

Features

The Active Alarm Snapshot window enables the following:

• Connect to the Active Alarm Snapshot window.

• Refresh the window.

• Open a properties sheet.

Menu

The Active Alarm Snapshot window displays the alarm data stored in the 
DMC. The alarm data displayed does not change or update until manually 
refreshed.

• File – contains a pull-down menu to select one of the following:

— Connect / Lock / Unlock / Disconnect – the same functions as the 
Connect/Disconnect tool.

— Properties – opens the Active Alarm Snapshot, Figure 65.

— Close – closes the Active Alarm Snapshot window.

• View – contains a pull-down menu to select the following:

— Tool bar – to show or hide.
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— Status bar – to show or hide.

— Refresh – updates the Active Alarm Snapshot window with the latest 
alarm data from the DECT system selected in the title bar. A 
separate DMC TN cannot be selected to refresh.

• Help – contains a pull-down menu to select the following:

— Content and Index.

— About DECT application.

• Tool bar � used to click a tool button to do the following:

• List – shows read-only data about the following:

— Severity – always labeled as Critical.

— Error Code – a three digit code. Refer to the DECT Operation 
Administration and Maintenance NTP for the meaning of the Error 
Codes.

— DMC TN – indicates the location of the card that originated the 
alarm.

— Radio Identifier (base station identifier) – indicates the base station 
that is the source of an alarm.

Connect Performs same functions as noted in File 
above.

Lock Performs same functions as noted in File 
above.

Unlock Performs same functions as noted in File 
above.

Disconnect Performs same functions as noted in File 
above.

Refresh Updates the Active Alarm Snapshot window 
with the latest alarm data from the DECT 
system selected in the title bar. A separate 
DMC TN cannot be selected to refresh.



 Product description  Page 111 of 612

DECT Description, Planning, Installation, and Operation

— Date and Time – when the alarm occurred.

— Operator Data – describes the alarm and the faulty component, if 
applicable.

• Pop-up menu – appears when at least one RFP (base station) is selected, 
and right clicked. The DECT Active Alarm Snapshot window opens. 
See Figure 65.

• Help – displays Content and Index, and About DECT application.

DECT Active Alarm Snapshot properties sheet

The DECT Active Alarm Snapshot properties sheet, shown in Figure 65, is 
selected from the pop-up menu. The Active Alarm Snapshot properties sheet 
displays the same alarm data as the Active Alarm Snapshot window list items. 

Figure 65
Active alarm properties sheet

The Active Alarm Snapshot properties sheet properties sheet enables the 
following:

• View alarm (DECT system message) details.
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• Close the properties sheet.

• Open the help file. 

Performance Collection window
The Performance Collection window, as seen in Figure 66, is selected from 
the DECT Systems window Applications menu.

Figure 66
Performance Collection window
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The Performance Collection window displays the following:

• Name – to select the directory to store the Performance Collection file. 

• User Performance Collection – collects counter data on handset user 
related activities. 

• Equipment Performance Collection – collects counter data on DMC 
related activities. 

Figure 67
Select location

The Performance Collection window enables the following:

• Start and stop User Performance Collection counters.

• Start and stop Equipment Performance Collection counters.
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Performance Collection additional information

The OTM DECT Manager user starts and stops performance counter 
collection. Performance collection cannot be scheduled. The collection 
begins when it is manually started, and ceases when manually stopped.

The collection period can be set for 15 minutes, 30 minutes, one hour, or one 
day. The performance counters are on the DMCs. DMC TNs can be selected.

User (handset) data and Equipment (DECT system) data can be collected 
separately. User (handset) data and Equipment (DECT system) data 
collection periods can be set separately.

The OTM DECT Manager stores the performance files. Rebooting the OTM 
DECT Manager does not destroy the files. 

The back up and restore application on the OTM DECT Manager does not 
back up and restore the performance files.

Retrieve RSSI Snapshot window

The Retrieve Radio Signal Strength Indication (RSSI) Snapshot window, 
shown in Figure 68 on page 115, is selected from the DECT Systems window 
Applications menu.

The Retrieve RSSI window enables the following:

• View Radio Signal Strength Indication details.

• Scroll and select a DMC card for RSSI information retrieval.

The Retrieve RSSI Snapshot window collects, on request, the RSSI for a 
selected DMC card.
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Figure 68
Retrieve RSSI Snapshot window

Retrieve RSSI Snapshot attributes

The OTM server collects the RSSI as an ASCII file. The OTM server user 
must indicate where to store the RSSI file.
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Multi-site Mobility Networking
Multi-site Mobility Networking (MSMN) allows a DECT handset user to 
make and receive calls at any MCDN node. When the handset user visits a 
MCDN node, the MSMN feature automatically performs the following 
actions:

• Detects the visiting handset when it is on.

• Forwards calls to the visiting handset from the users home node.

The Call Forward dial tone indicates when MSMN activation was not 
successful. Turn the handset off and on again to re-activate the MSMN 
feature.

The MSMN feature requires concentrated DMCs. A concentrated system has 
each handset configured to a Virtual TN (VTN) on phantom loops. 
Concentration allows up to 510 handsets to share the DMCs 32 time slots and 
is a blocking system. See “System concentration traffic” on page 121.

A non-concentrated system has each handset configured to a DMC8 TN. A 
non-concentrated DMC8 has 32 handset TNs assigned to 32 time slots and is 
non-blocking. 

Separate DECT systems on a PBX can be concentrated or non-concentrated.

Operating parameters

The MSMN feature can not support a mix of concentrated DMCs and 
non-concentrated DMCs within the same DECT system.

All DMCs, either new, empty for redundancy, or used for base station 
coverage, must have at least one handset configured to ensure system 
operation.

The C4010/C4020 handset can subscribe to a maximum of eight DECT 
systems.

The C4050 handset can subscribe to a maximum of eight DECT systems.
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Feature interactions

Call forward from a MADN handset

A MADN handset at a remote node can activate Call Forward (CFW) at the 
home node. When the handset shares a DN with another set(s), the CFW lamp 
lights on the shared DN set(s). If the handset is not the MARP, the shared DN 
MARP set can cancel call forward. If the handset is the MARP, the handset 
overrides any call forward which is setup from other shared DN set(s).

Card audit

Card audit does not work with VTNs.

Network Message Service

The MSMN feature does not change the handling of unanswered network 
calls. The Meridian Mail or Call Pilot network mail service does not change 
with multiple DNs configured against a single mailbox. The visiting DN 
receives the Message Waiting Indication (MWI) at the visited site.

Feature packaging

The MSMN feature requires the following packages:

• Multi-site Mobility Networking (MSMN) package 370.

• Meridian 1 Companion Option (MCMO) package 240.

• Phantom TN (PHTN) package 254.

• Meridian Companion Enhanced Capacity (MC32) package 350.

• Flexible Feature Codes (FFC) package 139.

Messaging and alarms
The DECT Messaging system allows text messages to be sent to and from 
C4040 and C4050 handsets. When there is an incoming message, the handset 
alerts the user in various ways, depending on the message’s priority. The 
handsets are subscribed to the DECT system using OTM.
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Note: For more detailed information on DECT Messaging, refer to 
DECT Messaging (P0989045).

DECT Messaging is a data system. It operates independently of the voice 
system. Text messages can be received even if the handset is in use. (The only 
exception is if the handset is ringing.)

Figure 69
DECT Messaging system overview
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Messaging Server

The DECT Messaging system uses a Messaging Server that interfaces to 
DECT through a DMC8 card. The Messaging Server acts as an interface 
between the DECT system to external systems and applications, such as 
alarms.

The Messaging Server supports two standard interfaces to connect to external 
systems:

• Telelocator Alphanumeric Protocol (TAP) over a serial link.

• Simple Network Paging Protocol (SNPP) over IP.

The Messaging Server provides the following functionality:

• The ability to send messages to a DECT handset from a standard web 
browser.

• Connection from external paging systems into DECT using standard 
protocols and interfaces. It supports both hard-wired serial connections 
and dial-up over modems.

• Handset-to-handset messaging.

• Connection over the IP network to DECT.

• Standard interfaces to allow external applications to be built.

• Web management of subscriber information and configuration data.

• An audit trail of all messages and responses kept by the system. These 
can be time-stamped to allow administrators to see what has happened at 
particular times, and to allow statistics to be generated.

Alarms

External applications, such as alarms and radio paging replacement, are 
supported by DECT Messaging. When an external alarm is triggered from the 
alarm system, the alarm sends a text message to the DECT Messaging system. 
The DECT Messaging system forwards the text message to the DECT 
handset.
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External systems can be connected using TAP and SNPP protocols. The 
supported protocols are:

• SNPP RFC1861 – for LAN access.

• TAP v1.8 – for external paging systems.
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System capabilities and limits
This section examines several issues surrounding DECT’s capabilities and 
limits. Information about system hardware and software parameters is also 
provided.

System concentration traffic

A DECT system without concentration supports a maximum number of 1024 
handsets. With the concentration feature, in theory, the handset limit is 510 
per DECT Mobility Card x 32 cards = 16320 handsets. However, in practice, 
traffic limits the number of handsets per card.

Each IPE card slot supports 32 channels of voice and data at the same time 
through the DS30X interface. Concentration removes the existing fixed ratio 
of 32 handsets per DMC.
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Blocking

Calls in DECT can be blocked at many stages, including the following:

• At the base station – when all channels (6 or 12) of an base station are in 
use, calls through that base station (both to and from a PP) are rejected.

• At the Backbone interface – when the base stations of one DMC together 
have 32 radio connections, calls through those base stations (both to and 
from a handset) are rejected.

• At the IPE backplane interface – when all 32 speech channels to the 
DS30X interface on the a DMC8 are occupied, calls to and from handsets 
which have that specific DMC8 as their home DMC8 are rejected.

• At the Network interface – usually the IPE shelf connectivity is a 
blocking configuration, where the number of network timeslots provided 
for a shelf is less than the actual number of terminals configured on that 
shelf.

Traffic definitions

Busy hour traffic – Busy hour traffic is the hour of the day during which a 
telephone system carries the most calls, voice or data. The unit for busy hour 
traffic is the Erlang or Centi Call Second (CCS).

Erlang – One Erlang is equal to the continuous use of a circuit for one hour.

CCS – One hundred Call Seconds (CCS) or 100 seconds of continuous use of 
a circuit. Normally referred to as CCS per hour. For example, a call on a 
circuit for one hour is equal to 36 CCS. 
(60 minutes x 60 seconds = 3600/100 = 36 CCS)

Blocking – A condition when a telephone call does not complete, and the 
calling party normally hears a busy signal.

Grade of Service – Grade of Service, given as a decimal fraction, indicates 
the probability of call blocking. For most applications, acceptable figures for 
blocking are between 0.01 and 0.03.
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Traffic assumptions used for table calculations

The following are traffic assumptions used for table calculations:

• A handset that always has good radio contact with a base station assumes 
that the radio deployment is acceptable.

• The Grade of Service used in all calculations is 1%.

• There is little or no overlap between base stations. (In practice, there is 
overlap, but to apply standard traffic calculations, it is necessary to 
simplify the calculation). For example, where there are two 6-channel 
base stations in the same cell, they will deliver a higher traffic flow.

• Ignore radio channels for handover. The traffic calculations allocate a 
slightly higher traffic capability to a base station than it can have in 
practice.

• Blocking occurs at three main areas: the base stations, the backplane, and 
the network loops. The traffic calculations only use the Erlang values 
where blocking occurs. For example, if there are three areas each 
delivering 10 Erlangs, traffic calculations take the total traffic capability 
as 10 Erlangs, not as 30 Erlangs. Real traffic capacity in this example is 
possibly more than 10 Erlangs.

• Handset handover continues without interruption.

• Handsets are distributed equally between the system DMC cards.

• All calculations are based on resident handset users. Visiting handset 
users have a negligible effect on traffic. In unusual circumstances where 
a site has a large number of visiting handset users, traffic capacity can 
require adjustments.
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System hardware parameters

Tables 3, 4, 5, and 6 detail the minimum and maximum configurations for 
DECT with the Concentration feature. 

†Due to number of Virtual TNs available. Subject to engineering rules and constraints. 

†Due to number of Virtual TNs available. Subject to engineering rules and constraints.  

Table 3
Minimum configuration

System type

Shelves 
or 

cabinets DMC8 DMC8-E
Base 

station Handset

All systems 1 1 0 1 to 8† 1 to 510†

Table 4
Maximum Large System configuration

System type Shelves DMC8 DMC8-E
Base 

station Handset

Large System 2 30 2 256† 16 320†

Table 5
Maximum Option 11 configuration

System type Cabinets DMC8 DMC8-E
Base 

station Handset

Cabinet system without 
CPU cabinet

2 18 2 160† 640†

Cabinet system with 
CPU cabinet

2 17* 2 152† 640†

Chassis system 
(Main cabinet)

1** 3* 0 16† 640†

Chassis system 
(Expansion cabinet)

1** 3* 1 32† 640†
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*One of the DMC8 positions in the CPU cabinet is required by the NTAK20 Clock 
Controller Daughterboard.

** DECT can only exist in one cabinet. The cabinets cannot be joined.

†Due to number of Virtual TNs available. Subject to engineering rules and constraints. 

† Due to number of Virtual TNs available. Subject to engineering rules and 
constraints.

*** DECT can only exist in one Media Gateway. The Media Gateways cannot be 
joined.

If a cabinet or Media Gateway has a “9th slot”, the slot must be provisioned 
with a DMC8-E card. All other cards are DMC8s.

The DECT system components have the following capacities:

• One NTCW00AB DMC8 or one NTCW01AB DMC8-E can support up 
to 8 base stations.

• One C4600 base station can support 6 active calls.

• One C4610 base station can support 12 active calls.

• One C4610E base station can support 12 active calls.

Multiple DECT systems can co-exist in the same PBX system if they are 
synchronized to the same clock source. However, from a user’s perspective, 
the DECT systems are separate.

Table 6
Maximum Succession CSE 1000 configuration

System type Cabinets DMC8 DMC8-E
Base 

station Handset

the first Media Gateway 1*** 3 1 32† 640†

all other Media Gateways 1*** 4 0 32† 640†
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System software parameters

The software that operates the DECT system resides as firmware in the 
DMCs. The firmware consists of an operating program and a system database 
configuration. The operating program controls base station and handset 
functions. The operating program also communicates with the system and the 
OTM DECT Manager. The system data defines hardware and hardware 
addressing.

The DMC8/DMC8-E with the ensuing software releases supports the 
following:

• Release 23 can support basic configuration, CLID and CPND, DECT 
card addressing within OA&M, and 16 users on each card.

• Release 24.2x can support up to 32 handsets on each card.

Release 25.xx can support up to 510 handsets with Concentration and 
MSMN.

DMC8 engineering guidelines
This section describes the recommended engineering guidelines for the 
installation of phantom powered base stations. 

The optimum capacity mix of 6-channel and 12-channel base stations is six 
6-channel and two 12-channel base stations. Using three or more 12-channel 
base stations per DMC8 is possible but is not an efficient use of the DMC8’s 
32 channels.

Nortel Networks recommends that the 12-channel base stations be distributed 
over the DMC8s. 
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Table 7 lists engineering guidelines for various deployments of 
phantom-powered base stations.

Table 7  
DMC8 engineering guidelines for 6-channel RFP (base station) and 12-channel RFP (base 
station) (Part 1 of 2)

System
Number of base stations that can be phantom 
powered per shelf or cabinet Total

Large System
eight 6-channel or six 6-channel + two 12-channel 
@ 0.5 km

128

seven 6-channel or five 6-channel + two 12-channel 
@1.0 km

112

seven 6-channel @ 1.7 km 112

new base stations – any mix at 1.7 km 128

Cabinet

seven 6-channel or five 6-channel + two 12-channel 
@ 0.5 km

70

six 6-channel or four 6-channel + two 12-channel 
@1.0 km

60

six 6-channel @ 1.7 km 60

new base stations – any mix at 1.7 km 80

Chassis

eight 6-channel or six 6-channel + two 12-channel 
@ 0.5 km

32

eight 6-channel or six 6-channel + two 12-channel 
@ 1.0 km

32

eight 6-channel @ 1.7 km 32

new base stations – any mix at 1.7 km 32



Page 128 of 612  Engineering guidelines

553-3001-370 Standard 1.00 October 2003

Using the maximum of eight base stations on a DMC8 imposes engineering 
restrictions on the remaining slots, as listed in Table 8.

Succession 1000

eight 6-channel or six 6-channel + two 12-channel 
@ 0.5 km

32

eight 6-channel or six 6-channel + two 12-channel 
@ 1.0 km

32

eight 6-channel @ 1.7 km 32

new base stations – any mix at 1.7 km 32

Table 8
DMC8 Ordering Tool – system slot restrictions for different base station lengths 
(Part 1 of 2)

System

Base station 
average line 
length Required number of unoccupied slots

Large System
0.5 km no restrictions

1.0 km for every 1 – 15 slots, one slot must be unoccupied

1.7km for every 1 – 6 slots, one slot must be unoccupied

Cabinet 0.5 km for every 1 – 9 slots, one slot must be unoccupied

1.0 km for every 1 – 8 slots, one slot must be unoccupied

1.7km for every 1 – 15 slots, one slot must be unoccupied

Chassis 0.5 km no restrictions

1.0 km no restrictions

1.7km no restrictions

Table 7  
DMC8 engineering guidelines for 6-channel RFP (base station) and 12-channel RFP (base 
station) (Part 2 of 2)

System
Number of base stations that can be phantom 
powered per shelf or cabinet Total
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Netprice Order Tool

The Netprice Order Tool makes certain approximations in provisioning 
DMC8. This provides a simplified configuration that meets the needs of most 
sites.

DECT on Large Systems

The Order Tool allows the first 80 base stations to be phantom powered. 
When more than 80 base stations are requested, the extra base stations are 
assumed to be local powered. Power adapters are provided as follows:

• C4610 ac adapters 
= (sum of 6-channel and 12-channel base stations) – 80

• Adapters must be purchased separately

Note: Because it is not possible to determine how the cards are spread 
over the two shelves, it is assumed that there are 80 phantom powered 
base stations per system.

Succession 1000

0.5 km no restrictions

1.0 km no restrictions

1.7km no restrictions

Table 8
DMC8 Ordering Tool – system slot restrictions for different base station lengths (Part 2 of 2) 
(Continued)

System

Base station 
average line 
length Required number of unoccupied slots
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DECT on Cabinet system

The Order Tool allows the first 40 base stations to be phantom powered. 
When more than 40 base stations are requested, the extra base stations are 
assumed to be local powered. Power adapters are provided as follows:

• C4610 ac adapters 
= (sum of 6-channel and 12-channel base stations) – 80

• Adapters must be purchased separately

DECT on Chassis system

All base stations can be powered from the cabinet power supply.

DECT on Succession 1000

All base stations can be powered from the Media Gateway power supply.

Rules with new base stations

With the new base stations, the provisioning rules are relaxed to allow the 
maximum number of base stations to be provisioned for each shelf, without 
the requirements.
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Base station combinations for handsets on a DMC8

Low traffic for a 0.1 Erlang capacity

Table 9 shows the 6-channel and 12-channel base station combinations 
required to support a maximum number of handsets on a DMC card. The 
calculations are based on each handset generating 0.1 Erlangs of traffic. 

Table 9
Number of handsets for a 0.1 Erlang capacity  

Number of 12-channel base stations

0 1 2 3 4 5 6 7 8

Number 
of

6-channel
base 

stations

0 0 58 117 176 176 220 220 220 220

1 19 77 136 195 220 220 220 220

2 38 97 155 214 220 220 220

3 57 116 174 220 220 220

4 76 135 194 220 220

5 95 154 213 220

6 114 173 220

7 133 192

8 152
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Medium traffic for a 0.15 Erlang capacity

Table 10 shows the 6-channel and 12-channel base station combinations 
required to support a maximum number of handsets on a DMC card. The 
calculations are based on each handset generating 0.15 Erlangs of traffic. 

Table 10
Number of handsets for a 0.15 Erlang capacity

Number of 12-channel base stations

0 1 2 3 4 5 6 7 8

Number 
of

6-channel
base 

stations

0 0 39 78 117 146 146 146 146 146

1 12 51 91 130 146 146 146 146

2 25 64 103 143 146 146 146

3 38 77 116 146 146 146

4 50 90 129 146 146

5 30 102 146 146

6 76 115

7 89 128

8 101
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High traffic for a 0.2 Erlang capacity

Table 11 shows the 6-channel and 12-channel base station combinations 
required to support a maximum number of handsets on a DMC card. The 
calculations are based on each handset generating 0.2 Erlangs of traffic. 

Table 11
Number of handsets for a 0.2 Erlang capacity

Number of 12-channel base stations

0 1 2 3 4 5 6 7 8

Number 
of

6-channel
base 

stations

0 0 29 58 88 110 110 110 110 110

1 9 38 68 97 110 110 110 110

2 19 48 77 107 110 110 110

3 28 58 87 110 110 110

4 38 67 97 110 110

5 47 77 106 110

6 57 86 110

7 66 96

8 76
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Superloop and IPE shelf calculations

Table 12 shows the maximum number of handset users on a DMC8 card for 
varying traffic levels. 

Note: Superloops do not apply to Chassis systems or Succession 1000 
systems.

Simplified guidelines

Use Table 12 to calculate the superloop capacity. 

Low traffic example of one superloop on each IPE shelf

• Sixty-nine (69) handsets per DMC8 card x 16 DMC8 cards per shelf = 
1104 (1000)

Medium traffic example of one superloop on each IPE shelf

• Forty-six (46) handsets per DMC8 card x 16 DMC8 cards per shelf = 736 
(750)

High traffic example of one superloop on each IPE shelf

• Thirty-four (34) handsets per DMC8 card x 16 DMC8 cards per shelf = 
544 (500)

Table 12
Handset capacity/DMC8 for Superloop/IPE

Superloops per 
IPE shelf

Low traff ic 
0.1 Erlang

Medium traff ic 
0.15 Erlang

High traffic 
0.2 Erlang

2 138 handsets/DMC 92 handsets/DMC 69 handsets/DMC

1 69 handsets/DMC 46 handsets/DMC 34 handsets/DMC

0.5 34 handsets/DMC 23 handsets/DMC 17 handsets/DMC

Cabinet system 220 handsets/DMC 146 handsets/DMC 110 handsets/DMC
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230

Site planning

Contents
This section contains information on the following topics:

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Site survey . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136

Deployment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

Deployment tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168

How to use the deployment tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182

DECT Deployment Kit 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184

Deploying DECT. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187

Correcting problems with audio quality . . . . . . . . . . . . . . . . . . . . . . . . 191

Deploying an external base station . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191

Single and multiple floor deployment. . . . . . . . . . . . . . . . . . . . . . . . . . 193

Cell re-engineering for high traffic areas  . . . . . . . . . . . . . . . . . . . . . . . 206

Cell division requirements in special cases. . . . . . . . . . . . . . . . . . . . . . 219

High handset density deployment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 222

Deployment review . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

Overview
Site planning starts with a site survey and ends with deployment. The site 
survey process is an information gathering process. The information received 
in the site survey determines customer requirements and the number of cells 
required to support traffic. 
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Deployment is the process of locating base stations at the site. The module 
titled “Installing the base station” on page 239 contains general information 
about the deployment process. This module includes information about a key 
piece of deployment equipment, the Companion DECT Radio Deployment 
Tool. The section titled “Preparing the tool for deployment” on page 171 
explains how to prepare equipment for deployment.

Other modules describe in detail the procedures related to deployment. These 
procedures vary according to site details and user requirements. 

Site survey
The site survey begins by researching the customer’s requirements. The 
research will identify a variety of information such as contact names, the 
number of handset users, and building details.

Customer requirements

The customer must provide:

a a site contact name and telephone number;

b site plans;

c building details;

d information on available house cabling;

e radio coverage requirements; and, 

f number of users.

On-site contact

The on-site contact provides:

a time and date scheduling; 

b access to restricted or locked areas; and, 

c additional information when required.
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Site plans

A complete set of site plans are required. Dimensions must be clearly stated 
on the plans. 

Building details

System deployment and installation depends upon the following building 
details.

• Building identification 

• Construction materials, such as walls, floors, ceilings

• Type of use, such as an office, hotel, factory, or store

• Dimensions

• Number of floors

• Height of floors

• Partitioning of floors

Position and use of available cabling

Cables that connect the base station to the DECT system must meet or exceed 
the UTP Cat 3 standard. UTP Cat 5 is recommended as it provides a greater 
line length before signal degradation occurs. New cabling is required if the 
existing cabling does not meet the standard. 

Radio coverage

A base station coverage list is required to indicate:

a areas where radio coverage is required;

b areas excluded from radio coverage due to the proximity of sensitive 
electronic equipment;

c areas where radio coverage is not required;

d areas where radio coverage is not feasible or requires specific base 
stations;
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e objects inside buildings; and,

f details of furniture, cupboards, and machinery on every floor of the 
building’s interior

Base station installations can be required to be out of sight. A customer could 
request base stations to be mounted in unsuitable locations, such as stone 
columns, air ducts or horizontally on the ceiling. Radio coverage cannot be 
guaranteed when base stations are mounted in unsuitable locations.

Know in advance where coverage is required. Some examples of coverage 
areas are:

• elevators

• stairwells

• toilets

• outdoor areas 

Number of handset users

The following information must be available.

1 The number of handset users

2 The potential growth of handset users

3 The areas of above average and below average traffic density Number of 
cells required to support traffic

Traffic requirements are determined for each cell. The deployer will calculate 
system requirements to support user traffic.

Customer review

After the site survey and before the deployment process, the person deploying 
the site must review coverage requirements with the customer representative. 
The person deploying the site must explain to the customer representative 
how the survey is conducted. The customer representative must tell fellow 
employees that a person deploying the site will be taking measurements in 
their work place.
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Site survey example 

The site survey process is an information gathering process. The information 
received in the site survey determines customer requirements and the number 
of cells required to support traffic.

A normal site survey

The site survey process includes gathering:

1 Survey materials

2 Site contact information

3 Site plans or maps

4 Building information

5 Existing cable information

6 Base station radio coverage information

7 Handset user information

8 Reviewing the work

Methods and examples for surveying more detailed sites are shown in the 
Detailed Site Planning section of this guide. Use one or more of the following 
surveying methods in the site survey:

• Single floor

• Subsequent system installation

• High handset density area

• Multiple systems installation

Site planning example: Able-Studio

This section describes a site survey for Able-Studio, a fictitious company. 
Follow this example to conduct the site survey. 

The facts for Able-Studio

• The contact is Rolf Sundby at 555-0000. A guest lab coat is necessary to 
be on the site. Get this lab coat from Rolf.
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• The sales representative has recommended DECT.

• The location of the users’ offices (and their wired telephones) often 
changes within the coverage area.

• Not all users have offices and desk telephones. Some users only have 
handsets.

• The customer does not need coverage in the toilet facility.

• The telephone switch room is next to the toilet facility.

• The customer has no installation restrictions.

The site survey process for Able-Studio

The technician must gather the following information to conduct a site 
survey: 

1 Gather survey items, page 140

2 Identifying site contacts, page 141

3 Obtaining site plans, page 142

4 Gathering building information, page 144

5 Identifying existing cabling, page 145

6 Assessing radio coverage, page 145

7 Profiling handset use, page 147

Gather survey items

Obtain the following items before beginning the site survey. The items are not 
customer supplied.

• Pick up the DECT tool kit (consisting of tripod and deployment tool kit).

• Get the appropriate Companion Provisioning Record.

• Gather a pencil, an eraser, a ruler, and colored pencils.
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Identifying site contacts

Gather the following information and enter it into the work-order and the 
Provisioning records. The installer requires the following information.

Table 13 
Identifying site contacts  (Part 1 of 2)

Step Action

1 Get the company name.

Record this information.

2 Get the company address.

Record this information.

3 Contact name.

Record this information.

4 Obtain the contact telephone number.

Record this information.

5 Obtain scheduling times and date. 

Record this information.

6 Access to controlled areas.

Record this information.

7 Obtain any keys or codes needed for secured site areas where radio coverage is 
required.

8 Obtain additional contact information, if required.

Record this information.
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Obtaining site plans

Obtain two scaled plans. The scale is required to check wiring distances from 
the controller to the base stations. The scale is in the form of a measured line 
so that it remains in proportion to the floor plan through reduction copiers.

9 Obtain any required safety equipment, such as a hard hat or safety glasses.

10 Find out if there is an another DECT system within the radio coverage area.

Record this information. 

Table 13 
Identifying site contacts  (Part 2 of 2)

Step Action

END
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Figure 70 
Example of a site coverage floor plan

Table 14 
Obtaining site plans 

Step Action

1 Obtain two site plans/maps, with dimensions marked.

One working copy to identify critical points, cell centers, and cell boundaries. One 
clean copy to attach to the site Provisioning Record for the installer, customer, or 
maintenance.

553-8073.EPSuser's desk/office

Able-Studio Inc.

0 30m

Factory Area
Office Area

Office
area

END
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Gathering building information

Gather the following information and enter it into the work-order.

Table 15 
Gathering building information

Step Action

1 Obtain building identification.

Record this information.

2 Obtain information on construction materials, such as walls, floors, ceilings.

Record this information.

3 Note the type of use of facilities, such as office, hotel, factory, store.

Record this information.

4 Find the number of floors.

Record this information. If the building contains atriums, multiple floors, floors not all 
the same shape or any unusual conditions, see “Multiple floor deployment” on page 
201.

5 Find the height of floors.

Record this information.

6 Ask about the partitioning of floors.

Record this information.

7 Discuss the details of furniture, cupboards, and machinery in the interior of buildings on 
every floor.

Record this information.

8 Ask about other building details, as necessary.

Record this information. 

END
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Identifying existing cabling

Gather the following information and enter it into the work-order.

Assessing radio coverage

Note: If the customer requires the base stations be installed out of sight, 
this can reduce the coverage capability of each base station. It can limit 
the performance of the system and substantially increase the cost.

Gather the following information and enter it into the work-order. 

Table 16 
Identifying existing cabling 

Step Action

1 Obtain the location of the telephone switching room.

Determine the total length of the cable.

2 Ask about the existing cabling for base station to MDF wiring.

Wiring from the base station to the shelf or cabinet must be at least UTP Cat 3. UTP 
Cat 5 is recommended as it provides greater line length before signal degradation 
occurs.

3 Review the possibility of new UTP Cat 5 cabling required.

If the cabling is not at least UTP Cat 3, have UTP Cat 5 installed. 

END
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Table 17 
Assessing radio coverage  

Step Action

1 Inquire about areas where radio coverage is required.

Record this information.

2 Ask about areas where radio coverage is not required.

Record this information.

3 Ask about external or outdoor radio coverage.

Record this information.

4 Discuss areas where radio coverage is not feasible or requires specific base stations.

Record this information.

5 Discuss areas excluded from radio coverage due to the proximity of sensitive 
electronic equipment.

Record this information.

6 Ask about objects inside buildings that could affect radio coverage.

Record this information.

7 Discuss unsuitable base station locations, such as stone columns, air ducts or 
horizontally on the ceiling.

8 Discuss what base stations are to be installed out of sight.

Discuss with the customer. See the preceding note.

9 Inquire about areas of special coverage, such as, elevators, stairwells, toilets.

END
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Profiling handset use

Areas of above average traffic density can have a low number of incumbent 
users but many incoming users. These can include areas such as cafeterias, 
restaurants, canteens, and meeting room areas where handset users tend to 
gather.

A further example of above average traffic density is an environment where 
all occupants of a given area are provided with handsets. This area will 
require special planning.

Areas of below average traffic density are areas infrequently accessed by 
users, such as store rooms and maintenance areas.

Obtain the following information and enter it into the work-order.

Table 18 
Profiling handset users

Step Action

1 Document the number of handset users.

Record this information.

2 Get an estimate of the potential growth of handset users.

Record this information.

3 Locate areas of above average and below average traffic density.

Record this information. See the preceding note.

4 Determine which users have a wired telephone in their office.

Record this information.
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Deployment
A deployment determines the locations of base stations and cells. The 
deployment process consists of the following steps.

• Identifying initial critical points on the floor plan (page 148).

• Locating cell centers (page 149).

• Determining cell boundaries (page 151).

• Identifying critical points and cell boundaries (page 153).

• Marking the points, centers, and boundaries on the floor plan (page 154).

Identifying initial critical points on the floor plan

A critical point is a place that can be difficult for the radio signal to reach, 
such as a corner of a room, lifts and stairwells. Initial critical points are shown 
in Figure 71 as P1, P2, P3, and P4. 

Figure 71 shows the following:

a stairwell

b second floor plan

5 Determine the locations of users’ offices.

Record this information.

6 Ask about the mobility of the users. For example, will the users move from cell to cell, 
or is the area of movement restricted, such that the users will always be within one 
cell?

Record this information.

Table 18 
Profiling handset users

Step Action

END
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Figure 71
Critical points

Locating cell centers

Figure 72 shows the following:

a stairwell

b second floor plan

A cell center is located by placing the deployment tool at one critical point, 
for example P1, then using the deployment handset to obtain a change in 
audio quality. The audio quality change determines the cell boundary 
contour. This process is repeated at an adjacent critical point, for example P2. 
Where the cell boundaries of both critical points meet is the cell center. The 
cell center position is marked on a floor plan. The cell center determines the 
location of a base station, shown in Figure 72, as arc 2C1.

553-8177.EPS

b

a

P3

P4

P1

P2

initial critical point
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Figure 72
Cell centers

Rules and guidelines for selecting cell centres

Comply with the following when selecting cell centres.

• Ensure that the installation complies with local electrical codes.

• Install base stations indoors where there is no condensation and the 
temperature remains between 0°C and 50°C.

• Install base stations within 1500 meters of the Main Distribution Frame 
(MDF). Wiring from the base station to the shelf or cabinet must be at 
least UTP Cat 3. UTP Cat 5 is recommended as it provides a greater line 
length before signal degradation occurs.

2C1 2C2
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• Position base stations upright on walls. Base stations must be at least 30 
centimeters from the ceiling.

• Position base stations at least 1 m from large concrete or stone columns 
and from any major building structural members such as support beams 
or columns.

• Position the base stations high enough to clear obstructions between the 
base stations and the cell edge close to the ceiling.

• Mount the base stations clear of obstacles such as pipes or ducts.

• Do not install base stations in spaces that transport air, such as ducts or 
plenums.

• Do not mount base stations on the ceiling.

Determining cell boundaries

A specific RSSI value on the handset defines the cell boundary range. Links 
can be made outside the cell boundary but the audio quality of the link is poor. 
The link drops when the handset and the base station are too far apart.

As shown in Figure 73, the cell boundary is the furthest point from the cell 
center where a clear radio signal can be heard.

The range from the cell center to the cell boundary, or the distance to a 
potential cell center from a critical point, is determined by using the cell 
boundary value and the deployment tool.
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Figure 73 
Cell boundary terminology

Figure 74 shows the following:

a stairwell

b second floor plan

A cell boundary for the cell center is determined by placing the deployment 
tool at the cell center, for example 2C1, and using the deployment handset to 
establish the cell boundary. The cell boundary contour is marked on the floor 
plan, and shown in Figure 74 by a dash-dot line.

553-8070.EPS
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Cell Boundary
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Poor Quality

Good Quality

cell centre
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Figure 74
Cell boundaries

Identifying critical points and cell boundaries

Figure 75 shows the following:

a stairwell

b second floor plan

Additional critical points, shown in Figure 75 as P5, P6, P7, and P8, are 
identified to ensure base station radio coverage for the entire area.
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Figure 75
Additional critical points and cell boundaries

Marking the points, centers, and boundaries on
the floor plan

This section describes how to label critical points, cell centers, and cell 
boundaries on the floor plan.

Mark the information clearly on the floor plans during the survey. The 
customer, the sales group, the installer, and maintenance personnel need to 
read these floor plans.
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Use a different color for each cell. Use the same color for each cell center and 
its corresponding cell boundaries. Indicate the information on the floor plan 
as follows:

• critical points – mark  on the floor plan.

• cell centers – mark  on the floor plan. 

• cell center - label each as xCn where x is the floor and n is the next 
sequential cell center.

• cell boundaries – mark wide, colored lines on the floor plan.

For example, label a cell center on the second floor as 2C3. The 2 before the 
C indicates that the cell center is on the second floor. The 3 after the C 
indicates that this cell is the third cell in sequence in the site planning process. 

Figure 76
Example cell boundaries  

Table 19 
Example cell labels

Floor Cell label

First floor 2C1, 2C2, 2C3

Ground floor 1C1, 1C2, 1C3

Basement level one –1C1, –1C2, –1C3

Basement level two –2C1, –2C2, –2C3

553-8072.EPS

cell center
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Figure 77
Points, centers, and boundaries on the floor plan

Figure 77 shows a typical floor plan marked-up after determining subsequent 
cell boundaries. The completed floor plan would appear as follows:

• Initial critical points are shown at P1, P2, P3, and P4.

• Cell centers are located where arcs from P1/P2, P3/P4 intersect.

• 2C1 and 2C2 show cell centers or base station locations.

• Dashed and dotted lines show cell boundaries.

• Additional critical points are shown at P5 P6 P7 P8.

• 2C3 and 2C4 cell centers provide full coverage of the floor.
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Two copies of the floor plan are required. One copy is used during the site 
planning. The second copy is marked with the information from the site 
planning copy and attached to Provisioning records, page 233 for the installer.

Deployment illustrations

These illustrations represent the deployment process from start to finish.

Figure 78 
Example of initial critical points
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Figure 79 
Cell contour of the initial critical point

Figure 80 
Cell contour of the closest adjacent critical point to the initial critical point

553-8081.EPS

P5

P6

P3

P2

P1

P7Able-Studio

0 40m
critical point
user's desk/office

Factory Area
Office Area

Office
area

553-8080.EPS

P5

P6

P3

P2

P1

P7Able-Studio

0 40m
critical point
user's desk/office

Factory Area
Office Area

Office
area



 Site planning  Page 159 of 612

DECT Description, Planning, Installation, and Operation

Figure 81 
Example of a cell center

Figure 82 
Example of a cell center boundary
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Figure 83 
Example of new critical points (P8 and P9)

Figure 84 
Example of deployment for cell center 1C2
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Figure 85 
Example of deployment for cells 1C3 and 1C4

Figure 86 
Identify new critical points (P11, P12, P13, P14, P15, P16, P17)
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Figure 87 
Contours formed by critical points P11, P13 and P16

Figure 88 
Cell center 1C5 formed by critical points P11, P13 and P16
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Figure 89 
Cell boundary 1C5 formed by critical points P11, P13 and P16 

Figure 90 
Example of critical point cell boundaries
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Figure 91 
Example of cell center boundary 1C6

Figure 92 
Example of a floor plan showing complete radio coverage
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Deployment terms

Terms associated with deployment are listed in the following table.

The following figure, Figure 93, illustrates these terms.

Table 20 
Deployment terms

Term Definition

Coverage area An area where a handset can be used to make and receive calls.

Cell The coverage area provided by the base station antennas.

Cell boundary The parameter of a cell coverage area.

Critical point A point or location defined as the extreme corner of a coverage 
area, that can be difficult for the radio signal to reach.

Cell centre The installation point of the base station serving the cell.

Range The distance from a cell centre to its cell boundary.

Traffic table Traffic tables record site traffic information from the floor plan 
and the customer. The traffic table helps to determine the 
required number of base stations for each cell.
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Figure 93
Example showing deployment terms

Coverage terms

The terms used in this guide are described in Table 21 and illustrated in 
Figure 94.

Table 21 
Coverage terms 

Term Definition

Estimated number of 
handsets

The average number of handsets expected in a particular cell.

Cell The coverage area provided by a base station.

Cell boundary The edge of a cell showing the cell coverage area.

Cell center The place where all the base stations are installed.

Companion DECT Radio 
Deployment Tool

The tool used to determine the radio range of a base station.

Critical point A point or location defined as an outer corner of a coverage area, 
or points that can be difficult for the radio signal to reach.
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Figure 94 
Coverage terms

Coverage area The area defined by the customer in which a handset user 
should be able to make and receive calls.

Link When a handset and a base station are in radio communication 
with each other.

Range The distance from a cell center to the cell boundary.

Office The location where a handset user spends the majority of their 
day.

Traffic table Traffic tables record site traffic information from the floor plan 
and the customer. The traffic table helps to determine the 
required number of base stations for each cell.

Table 21 
Coverage terms 

Term Definition
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Deployment tool
The DECT Deployment Tool (deployment tool) determines cell centers and 
cell boundaries. See Figure 104 and Figure 105 on page 185.

Figure 95 
Deployment tool carrying case and packing details 
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Figure 96
Assembled deployment tool

Key

a base station

b power cord 

c battery

553-8066.EPS

a g

b

j

i

l

k

e

d

f

h

c



Page 170 of 612  Site planning

553-3001-370 Standard 1.00 October 2003

d battery mount

e adjustable tripod 

f extender arm connector

g extender arm swivel and clamp

h extender arm

i battery charger (separately ordered)

j battery charger cable

k deployment handset

l deployment handset battery charger

The deployment tool tripod is available in three heights: 

• 2.4 meters

• 3.6 meters 

• 4.8 meters

Figure 97
Deployment tool base station 
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Do not position the deployment tool base station next to large concrete or 
stone columns. This affects the contour of the cell boundary. Keep the 
deployment tool base station at least 1 m from such columns.

Preparing the tool for deployment

Preparing the tool for deployment involves:

1 “Charging the deployment tool battery” on page 171

2 “Charging the deployment handset battery” on page 173

3 “Assembling the deployment tool” on page 175

4 “Testing the deployment handset” on page 179

Charging the deployment tool battery

Charge the deployment tool battery for at least six hours before using.

Figure 98 
Deployment tool battery charger

CAUTION — Equipment Damage

Use the Nortel Networks’ battery charger. This charger is 
a separately ordered item. Failure to use an automatic 
shut-off battery charger can damage the battery.

Do not use the battery supplied with the CT2 deployment 
tool. The CT2 and DECT batteries are not 
interchangeable.
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Key

a battery charger (must be ordered separately)

b battery charger cable

 

Table 22
Charging the deployment tool battery

Step Action

1 Set up the deployment tool battery charging equipment.

Remove the deployment tool battery, charger, and charger cord from the yellow case.

2 Charge the deployment tool battery.

Connect the charger cord plug into the battery. Connect the red alligator clip to the 
positive lead of the charger, and the black clip to the negative lead of the charger. 
Connect the battery charger to the ac mains.

3 Remove the deployment tool battery from the charger after it is charged.

The battery must charge for at least six hours.

END
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Charging the deployment handset battery

Figure 99 
Deployment handset battery charger

Charging time

Charge the deployment handset battery for at least 12 hours before using the 
first time. Charge the handset at least six hours before any subsequent use.
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Table 23 
Charging the deployment handset battery

Step Action

1 Set up the deployment handset battery charging equipment.

Remove the deployment handset battery, charger and charger cord from the yellow 
case.

2 Charge the deployment tool battery.

Connect the charger cord to the charging stand. Connect the charger cord to the AC 
mains. Place the handset into the charging stand. The red LED flashes while the 
handset is charging.

3 Remove the handset from the charger when it is ready for use.

END
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Assembling the deployment tool

Figure 100 
Deployment tool extension details

Key

a adjustable tripod

b extender arm connector

c extender arm swivel

d detente stop

e detente

f extension thumb screw

g telescopic extension

h allen key
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i base station attaching thumb screw

j base station

Note: The deployment tool battery and the deployment handset battery 
must be charged for at least six hours before use.

Figure 101 
Deployment tool battery details

Key

a battery mount

b allen screws

c thumb screw

d battery pack

e guides

f thumb screw nut

g power cord
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h power cord receptacle

i tripod

Table 24 
Assembling the deployment tool (Part 1 of 2)

Step Action

1 Set up the tripod.

Remove the tripod from its carrying case and set upright. Lock the casters.

2 If required, install the extension arm fitting on the tripod. If not required, go to step 4.

Place the extension arm fitting, shown in Figure 104 on page 184, onto the brass fitting 
on the top of the tripod.

3 If required, secure the extension arm fitting.

Use the Allen key attached to the extender arm to secure the extension arm fitting allen 
screw.

4 Mount the extension arm on the tripod.

Place the brass end of the extension arm into the fitting, so that the keying hole of the 
extension arm mates with the retaining thump screw locking device of the tripod fitting. 
The thump screw locking device will click into the keying hole of the extension arm.

5 Position the extension arm.

Orient the arm into the proper position. Secure the tripod fitting and the extension arm 
thumb screw.

6 Affix the base station to the extension arm.

Remove the base station from the yellow case. Mount the base station onto the end of 
the arm. Screw the arm’s brass thumb screw into the bottom of the base station and 
secure into place with the grey lock thumb screw.

7 Position the antenna.

Rotate the antenna from its stowed position, against the body of the base station, to its 
upright operating position.

8 Position the base station. The normal position is with the antenna pointing upwards.
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Secure the base station with the arm thumb screw.

9 Mount the battery fixture on the tripod.

Remove the battery bracket, shown in Figure 101, from the yellow case. Screw the 
battery bracket onto the tripod caster brace, with the two machine screws.

10 Mount the battery.

Pull the release pin on the bracket back and slide the battery grooves on to the bracket. 
Ensure the bracket pin locks into the battery.

11 Connect the base station to the battery.

Plug the base station power cord connector into the upper right edge of the battery. 

Table 24 
Assembling the deployment tool (Part 2 of 2)

Step Action

END
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Testing the deployment handset

Figure 102 
Handset display and keypad details
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How the deployment tool works

The deployment tool base station and the deployment handset establish a 
radio link when:

a the handset is in the deployment mode; and, 

b the handset and base station are within range of one another. 

Table 25 
Testing the deployment tool handset

Step Action

1 Start the test and establish a link with the base station.

Remove the handset from its charger.

2 Turn on the handset.

Press the shift key  and press the ON/OFF button. The handset displays DECT 
HANDSET.

3 Select system mode.

Press the shift key and press the local key. The handset displays SYSTEM.

4 Select the monitor mode.

Press the star key. The handset displays MONITOR MODE.

5 Select the monitor mode code.

Press the lock button. The handset displays CODE.

6 Enter the monitor mode code.

On the dial pad, enter 2530. Press the lock button.

7 Interpret the handset RSSI display and test tone.

Follow the explanation in “How the deployment tool works” on page 180 and “How to 
use the deployment tool” on page 182.

END
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The closer the handset is to the base station the stronger the link. As the 
handset moves away from the base station, a point is reached where the signal 
is no longer reliable for telephone conversations.

When a link is established, the handset emits a continuous 1.4kHz tone and 
displays a Radio Signal Strength Indication (RSSI). 

Figure 103 
Deployment handset link display   

The display, shown in Figure 103, means as follows:

• A circle and dot indicates a locked signal.

• The antenna symbol indicates a link establishment.

• The number 10 indicates an RSSI value.

• The dash, equal sign and shaded box icons indicate 
signal strength.

The maximum RSSI is 10. As signal strength diminishes, the number 10 
decreases and the icons disappear. For example, at signal strength 7, the three 
shaded boxes that are on the right side of the display disappear. At signal 
strength 5, all the shaded boxes and one of the equal sign icons disappear.

The signal strength diminishes as the distance between the handset and the 
base station increases. The tone will remain unchanged until the handset is out 
of range of the base station.

553-8069.EPS
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How to use the deployment tool
The deployment tool is assembled as shown in Figure 96 on page 169, with 
the extension arm parallel to the floor. Position the base station antenna 
upwards. Place the base station as close to the wall as possible and at the 
height recommended for base stations.

To test the deployment tool, stand in an open area approximately three to five 
meters away from the deployment tool on its tripod. Establish a link between 
the base station and the handset. Keep the deployment tool base station in 
plain view. Ensure there are no obstructions (including people).

Walk away from the base station and observe the deployment handset link 
display. As the deployment handset moves away from the base station, the 
RSSI value changes. When the RSSI value changes from 7 to 6 and the last 
shaded block disappears, the cell boundary has been reached.

When the cell boundary is reached, stop and listen to the tone. Make sure the 
tone is clear with no tone changes, tone break-up, modulation, mutes or 
clicks.

Do not select a cell edge that has an RSSI reading of less than 6. However, 
keep the following in mind.

• There can be environments that cause poor tone at a RSSI meter reading 
of between 7 and 10. In this case, get help from the Nortel Networks’ 
support team.

• The tone stops when the radio link is lost.

Interpreting handset tones

The handset tones indicate how close the handset is to the deployment tool 
base station.

• Steady tone – the handset is within the cell boundary, or at the cell 
boundary edge.

• Tone change, tone break-up, modulation, mute or click – the handset is 
beyond cell boundary edge.
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Rules for outdoor deployment

1 Cover outdoor areas before covering indoor areas. Use the deployment 
tool to determine outdoor cell centers.

2 Use the deployment handset to determine the outdoor coverage provided 
by a base station located indoors.

3 External housings for outdoor base stations must be mounted directly on 
walls or similar vertical surfaces.

4 When using the deployment tool outdoors, ensure that the deployment 
tool does not fall over or come in contact with electrical wires and cables.

5 If an outdoor critical point cannot be reached, inform the customer.

6 Do not use the deployment tool on windy days.

7 Do not use the deployment tool in bad weather.

8 Keep all personnel away from the apparatus.

9 Follow all safety requirements.

10 Use batteries to power the deployment tool.

11 Charge the batteries indoors.
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DECT Deployment Kit 2
The DECT Deployment Kit 2 is shown in Figure 104. Refer to the DeTeWe 
User Manual that accompanies each kit for additional information. 

Figure 104 
Deployment Kit 2 and carrying case 

The following information can be used in conjunction with the DeTeWe User 
Manual that accompanies the deployment tool.

1 The two DeTeWe handsets with the kit are subscribed to the base station 
and are numbered 13 and 15. Refer to Figure 105 on page 185 to view the 
assembled base station and the DeTeWe handsets. 

2 The  key on the handset is the Off-Hook key. 
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3 To enter Site Survey Mode on the handset:

— Press Menu 

— Scroll to System

— Dial ***76#

— Scroll to Site Survey

— Press OK

4 The FE value for the PP is the number of detected Sync/ACRC errors 
within the last 100 receiving frames (i.e., 1 sec.). 

5 The FE value is for the FP is the number of received Q1/Q2 bit 
information within the last 100 receiving frames (i.e., 1 sec.). 

Figure 105
Assembled Deployment Kit 2 and DeTeWe handsets
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Figure 106
Deployment Kit 2 base station 
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Deploying DECT
Follow the procedure in Table 26 to deploy the DECT system. 

Table 26 
Deploying a DECT system  (Part 1 of 4)

Step Action

1 Identify and mark initial critical points.

Mark critical initial points on the floor plan with the symbol: . Figure 78 on 
page 157 shows the initial critical points: P1, P2, P3, P5, P6 and P7.

2 Demarcate the cell contour for the critical point farthest from the center of the full 
coverage area.

To demarcate a cell contour:

a Set up the deployment tool base station. Raise the deployment tool base 
station as high as possible, or until it is at the height recommended for base 
stations.

b Establish a link. See “Deployment tool” on page 168 for details.

c Measure the range into the coverage area in a few directions to determine 
where a cell centre can be located and still be within range of the critical point. 
Listen to the deployment tool handset while moving away from the base 
station. When the RSSI value changes from 7 to 6, the cell boundary has 
been detected.

d Mark the cell boundary on the floor plan with a small x.

e Repeat steps c and d until there are enough x’s to draw a thin contour arc 
through the x’s.

In Figure 79 on page 158, P1 is the initial critical point.

3 Demarcate the cell contour of the closest adjacent critical point to the first critical 
point.

See step 2 for details. In Figure 80 on page 158, P2 is the closest adjacent 
critical point to the first critical point.
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4 Use the cell contours to locate a cell center. 

Locate the cell center where the cell contours meet. Choose a position on the floor 
plan that:

• is furthest from the critical points,

• still provides good audio quality at the critical point, 

• complies with the Rules and guidelines for selecting cell centres, page 150, and

• is in the coverage area.

With a pencil, label the cell center on the floor plan with the symbol:  xCn, where 
x = the floor and n = is the cell number in sequence of the entire plan.

In Figure 81 on page 159, IC1 is a cell center.

5 Demarcate a cell boundary. 

To demarcate a cell boundary:

a Set up the deployment tool base station at the cell center.

b Establish a link.

c Refer to the floor plan and check audio quality in user offices within the cell. 
If a user office is in a zone where audio quality deteriorates, relocate the cell 
center closer to the critical point or the office.

d Walk into all of the areas (rooms) necessary to demarcate the complete cell 
boundary. Radio signals travel further in uncluttered areas than they do in 
cluttered areas. Record the cell boundary.

e Find the cell boundary by measuring the range and marking it on the floor 
plan with a small x. Repeat steps c and d until there are enough x’s so that a 
contour arc can be drawn around the cell center.

See Figure 82 on page 159 for an example of a cell boundary.

Table 26 
Deploying a DECT system  (Part 2 of 4)

Step Action
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6 Mark and label the cell boundary on the floor plan

Follow these steps:

a Mark each office within the cell that is isolated from the office area.

b Label any subsequent critical point on the floor plan the following 
symbol:

c Mark the cell contour on the floor plan. Trace a contour line through the x’s 
with a marker.

d Trace the cell boundaries and cell centers with colored markers.

7 Identify new critical points.

Follow these steps:

a Identify one new critical point just inside of where the cell boundary meets the 
outside wall. In Figure 83 on page 160, this new critical point is P9.

b Identify another new critical point which is adjacent to the first new critical 
point. Locate this critical point on the opposite side of the cell boundary area. 
In Figure 83 on page 160, the cell boundary area is IC1 and the new critical 
point is P8.

8 Mark and label these new critical points on the floor plan with 
the symbol: .

See step 6 on page 189 for details.

9 Using the critical points from step 7, demarcate new cell contours, a new 
cell center and a new cell boundary. 

See steps 2 to 5 starting on page 187 for details.

Note:  Cell contour arcs must pass near the cell boundary of adjacent cells. 
For an example of this, see Figure 84 on page 160.

Table 26 
Deploying a DECT system  (Part 3 of 4)

Step Action
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10 Demarcate additional cell contours, centers and boundaries at the other end of the 
building.

Repeat steps 1 to 8 as necessary to demarcate new cell boundaries at the 
other end of the building. In Figure 85 on page 161, new cells are formed 
around cell centers IC3 and IC4.

11 Identify new critical points:

These critical points must be:

• adjacent to a critical point and on the opposite side of the cell boundary area. 
(critical point = P11 in Figure 86 on page 161, where cell boundary area = IC2),

• just inside of where the cell boundary meets the outside wall (P12, P13, P14 and 
P15 in Figure 86 on page 161), and

• where cell boundaries meet (P16 and P17 in Figure 86 on page 161).

12 Demarcate additional cell boundaries to cover all areas of the building.

Repeat steps 1 to 8 as necessary to demarcate new cell boundaries in the middle 
of the building.

Refer to Figures 87, 88, and 89 starting on page 162. Critical points P11, P13 and 
P16 form:

• contours in Figure 87 on page 162 

• the cell center 1C5 in Figure 88 on page 162 

• a new cell boundary in Figure 89 on page 163

Refer to Figures 90 and 91 starting on page 163. 
Critical points P11, P12 and P17 form:

• contours in Figure 90 on page 163

• a new boundary based on cell center 1C6 in Figure 91 on page 164

Figure 87 on page 162 shows a floor plan with complete radio coverage. The floor 
plan is made complete by cell boundary 1C7.

Table 26 
Deploying a DECT system  (Part 4 of 4)

Step Action

END
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Correcting problems with audio quality
If a user office is near the critical point and the audio quality deteriorates 
within the user office, then the deployment tool and the cell center are not 
properly located.

Deploying an external base station
Follow Procedure 1 to deploy an external base station.

Procedure 1
Deploying an external base station

1 On the site plan, note each of the critical points that are to be reached.

2 Position the deployment tool at the potential location for a cell center that 
is closest to the critical point.

3 Check for outdoor coverage to the critical point with the deployment 
handset.

Table 27 
Correcting problems with audio quality

Step Action

1 Move the cell center closer to the office or work area in question.

2 Repeat the coverage test in that area and ensure that coverage is sufficient.

This can impact the coverage at other points, and you must ensure that all critical 
points are still properly covered by the new location.

3 Go into every location where users make and receive calls.

This includes washrooms, coffee areas, and meeting rooms. Do not speculate 
where users may make calls.

END
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4 If the critical point is reached, your cell center is at the position of the 
deployment tool. Determine the cell boundary. If you cannot reach the 
critical point, determine and record the cell boundary that you did reach 
on the site plan.

5 For each critical point, determine the potential location of external base 
stations. The location should be:

a. outdoors,

b. as close as possible to the critical point that you need 
to reach, and

c. more than 4 m  above the highest ground to be covered.

Figure 107 
Elevation of external base station and terrain
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Key

a External housing positioned at least 4 m from the ground.

b Clear line of sight to the external housing at the cell boundary.

c The range does not encompass any structures or earth mounds more 
than 2 m tall and more than 2 m wide.

6 If the critical point cannot be reached, inform the customer to determine if 
planning should continue.

7 Repeat this procedure until all of the outdoor areas have been completely 
covered.

End of Procedure

Single and multiple floor deployment
Whether the deployment situation involves a single floor or multiple floors, 
the deployment process uses basic rules: 

1 Deploy the external or outdoor areas first. 

2 Deploy from one side of the coverage area, then deploy the opposite side 
of the coverage area. 

3 Finish by deploying the middle of the coverage area.

Follow these rules to prevent cell centers from clustering at one end of the 
site.

Check the floor plan to be sure that there are no areas where a handset in the 
required coverage area could be outside the range of a cell center.

Defining a cell typically takes 25 to 40 minutes.

Single-floor deployment

Deploying a single floor coverage area involves methods that apply to all 
other applications of coverage. For multi-floor deployment, see page 201.

Use one or all of the following methods of deploying cells.
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When determining a cell center, one or all of the following methods of 
deploying cells are used:

• Single cell deployment – covers the distance between two outside 
corners at the end of a coverage area with one cell.

• Double cell deployment – covers the distance between two outside 
corners at the end of a coverage area with two cells.

• Multi cell deployment – covers the distance between two outside 
corners at the end of a coverage area with more than two cells.

Always begin with the single-cell method, because the range is not always 
known; therefore, it is not known how many cells are needed to cover the area 
between the critical points.

Start at the “short” side of the coverage area. First cover the corners, then the 
side between those corners, and finally inward to the center of the coverage 
area. Repeat the process for the other end of the coverage area.

By deploying the site using this method, cell centers are distributed 
throughout the site. If the site is deployed from one end to the other, cell 
centers can be clustered at one end of the site.

Single cell deployment

Always start with the single-cell technique regardless of the width between 
the two critical points. using this technique, one cell center is found that 
serves two critical points, as shown in Figure 108. 
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Figure 108 
Single cell distance

Procedure 2
Single cell deployment

1 Identify the initial critical points. Mark them on the floor plan with a . 
Use different color pencils for each critical point.

2 Choose the first critical point at the edge of the coverage area furthest 
away from the center of the coverage area. Place the deployment tool at 
this critical point.

3 Establish a link. Refer to “Deployment tool” on page 168 for details.

4 Measure the range into the coverage area in a few directions to determine 
where a cell centre can be located, and still remain within range of the 
critical point. Observe the deployment tool handset RSSI value while 
moving away from the base station. When the display value changes from 
7 to 6, the cell boundary has been detected.

5 Record the cell boundary by marking a small x on the floor plan where the 
cell boundary value was reached. Use a pencil that is the same color as 
the critical point where the deployment tool is located.
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6 Repeat step 4 and 5 several times, walking in different directions to 
determine where the cell center can be located and still remain within 
range of the critical point.

7 Draw a thin contour line through the x’s to mark an arc on the floor plan. 

8 Choose the other critical point adjacent to the first critical point and repeat 
steps 3 to 7.

9 If the contour lines do not cross, or if they cross close to the edge of the 
coverage area between the two critical points, then see “Double cell 
deployment” on page 196. Choose a position on the floor plan for the cell 
center that:

a. is furthest from the critical points and still provides good audio quality 
at the critical point,

b. complies with the “Rules and guidelines for selecting cell centres” on 
page 150, and 

c. is in the coverage area.

10 With a pencil, label the cell center on the floor plan with  xCn. The x 
is the floor, and n is the cell number in sequence of the entire plan.

11 Place the deployment tool at each cell center to locate the cell boundary.

12 Mark the cell boundary on the floor plan.

13 Repeat this task for the remaining coverage area from the extremes of the 
coverage area toward the center until the entire floor has been covered.

14 If the cell boundary covers any other critical points, ignore these critical 
points when proceeding with coverage deployment.

Note: If it is not possible to place the base station at the exact crossover 
points of the arcs, place the base station as close as possible to the 
crossover.

End of Procedure

Double cell deployment

Use the double cell technique only if referred here from the single-cell 
technique. Before beginning this technique, there should be two critical 
points that one cell center cannot serve. Using the double cell technique, two 
locations for cell centers that cover three critical points will be found, as 
shown in Figure 109.
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Figure 109 
Double cell distance

Procedure 3
Double cell deployment

1 Mark a third critical point mid-way between the two critical points already 
identified. 

2 Place the deployment tool at this mid-way critical point.

3 Establish a link.

4 Walk briskly into the coverage area within range of either of the first two 
critical points until the cell boundary is reached.

5 Record the cell boundary by marking a small x on the floor plan where the 
cell boundary is located.

6 Repeat step 4 and 5 several times, walking in different directions to 
determine where the cell center can be located and still be within range of 
the critical point.

7 Draw a thin contour line through the x’s to mark an arc on the floor plan.

8 Repeat steps 2 through 5 walking into the coverage area of the other of 
the first two critical points.
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9 If the contour lines do not cross, or if the amount of overlap between the 
cells is less than 1/2 the distance between the cell center and the cell 
boundary, then see “Multi cell deployment” on page 198.

10 Choose a position on the floor plan for the cell center that:

a. is furthest from the critical points and still provides good audio quality 
at the critical point,

b. complies with the “Rules and guidelines for selecting cell centres” on 
page 150, and 

c. is in the coverage area.

11 Mark each cell center on the floor plan  and label them 1C1 and 
1C2.

12 Place the deployment tool at each cell center to find the cell boundary and 
mark it on the floor plan. 

13 Repeat this technique for the remaining coverage area from the outer 
extremes of the coverage area toward the center until the entire floor has 
been covered. If the cell boundary covers any other critical points, ignore 
these critical points when proceeding with coverage deploying.

End of Procedure

Multi cell deployment

Use the multi cell technique only if referred here from the double cell 
technique. Before beginning this technique, there should be two critical 
points that one cell center cannot serve. Using the multi cell technique, two 
cell centers, each one serving one of the two critical points, are found, as 
shown in Figure 110.
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Figure 110 
Multi-cell distance   

Procedure 4
Multi-cell deployment

1 Choose a position on the floor plan for the cell center that:

a. is furthest from the critical points and still provides good audio quality 
at the critical point,

b. complies with the “Rules and guidelines for selecting cell centres” on 
page 150, and

c. is in the coverage area.

2 Place the deployment tool at critical point P1.

3 Establish a link.

4 Walk briskly into the coverage area away from the critical point until the 
cell boundary is reached.

5 Mark a small x on the floor plan where the cell boundary is found.

6 Repeat step 4 and 5 several times, walking in different directions from the 
critical point to establish an arc. The arc is at the cell boundary and is 
within range of the critical point.

7 Draw a thin contour line to mark an arc through the x’s on the floor plan.
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8 Repeat steps 4 through 7 walking into the coverage area of critical point 
P2.

9 Locate the cell center on the arc along a line from the critical point that is 
equal distant from the adjacent walls.

10 Mark each cell center on the floor plan  and label them 1C1 and 
1C2.

11 Place the deployment tool at each cell center.

12 Locate the cell boundary and mark it on the floor plan. (Mark the contours 
in different colors for easy differentiation of cell centers.)

13 Define and mark on the plan any subsequent critical points, where each 
cell boundary crosses the edge of the coverage area.

14 If the cell boundary covers any other critical points, ignore these critical 
points when proceeding with coverage deploying.

15 Repeat the multi cell technique for the remaining area to be covered, from 
the extremes of the coverage area toward the center, until all of the floor 
is covered.

Figure 111 
Multi cell distance using the single cell technique
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16 Use the subsequent critical points to fill in the coverage area between the 
first two cells using the “Single cell deployment” on page 194. An example 
of this is shown in Figure 111.

End of Procedure

Multiple floor deployment

This applies to deployment scenarios in the following situations:

• The coverage area is on more than one floor.

• The floors are not adjacent to each other.

Checking for through-the-floor coverage

The first step in covering a multi-floor building is assessing the availability 
of through-the-floor coverage. In buildings mainly constructed of wood, 
through-the-floor coverage can be used. However, due to the construction of 
most modern buildings with raised floors, high metal content, and reinforced 
concrete, through-the-floor coverage with DECT is limited. 

Table 28 
Checking for through-the-floor coverage (Part 1 of 2)

Step Action

1 Place the deployment tool in a middle floor of the site.

2 Go to the floor above the deployment tool and establish a link with the deployment 
handset.

Follow the procedure on Table 25 on page 180.

3 Measure the deployment contour as if the base station was on this floor, instead of the 
floor below.

If only a small area is covered (less than 10 meters radius), then there is effectively no 
through-the-floor coverage on the floor above an installed base station.
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Assess floor layout

The deployment procedure changes according to the similarities and 
differences of the floors.

All floors have the same layout

To begin a multi-floor deployment when all of the floors have the same 
layout, deploy one floor and enter the data on the floor plan. Use the data from 
the deployed floor for other identical floors.

For example, if floor 2 of an office tower is laid out with cubicle style offices 
with a perimeter of enclosed offices, and floor 3 is designed and laid out in 
the exact same manner, then both floors can have the exact same installation 
profile for base stations. 

All floors do not have the same layout

If there are any deviations in the floor plan from floor to floor, use the critical 
point method to deploy each distinct floor. For more information, see 
“Preparing the tool for deployment” on page 171.

Note: Do not underestimate the importance of changes in floor layout. 
Simple changes in a room from a meeting room to a storage room can 
have significant impact on the coverage from a base station.

4 Go to the floor below the deployment tool and repeat the above process.

If the area that can be covered is small, then there is no through-the-floor coverage 
below a base station location.

5 If there is no through floor coverage or just small coverage.

Deploy each floor using critical points, or if the floors are exactly similar, deploy as 
multi floors with the same layout. 

Table 28 
Checking for through-the-floor coverage (Part 2 of 2)

Step Action

END
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Multi-floor coverage situations

The following situations require multi-floor coverage:

1 Atriums (page 203).

2 High rise buildings (page 204).

3 Unusual conditions (page 204).

Use Multi-floor coverage procedure, if instructed to do so, from Gathering 
building information, page 144.

Atriums

Cells in an atrium, as shown in Figure 112 on page 203, are usually larger 
than the cells of the rest of the building. This section gives guidelines on how 
to plan an atrium. There are no precise steps to follow when deploying an 
atrium, however there are points to consider. Also see “Unusual conditions” 
on page 204.

Figure 112 
An atrium

Consider the following when deploying an atrium:

• Plan atriums to their full height.

• Plan an atrium as one full size room, not floor by floor.

553-8193.EPS
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• Place cell centers within an atrium only when they are intended to cover 
the atrium.

• Do not put cell centers into an atrium if they are intended to serve 
adjacent areas.

• To serve adjacent areas, put the cell centers into these areas.

• Deploy the atrium first if the atrium is more than a third the size of the 
building, or more than one cell in size.

• If cell centers in adjacent dense areas serve one floor of an atrium, check 
the coverage of the cell on all of the floors that meet with the atrium.

High rise buildings

Deploy high rises buildings as unusual conditions of multi-floor deployment.

Test through-the-floor coverage first. If there is no through-the-floor 
coverage, then deploy each floor. Repeat as many floors as possible where the 
floor layout is the exact same as any other, in all other cases deploy floor by 
floor. A floor with many meeting rooms will deploy differently from a 
building with cubicle style offices.

Unusual conditions

There are no precise steps to follow when deploying for an unusual condition; 
however, there are points to be considered.

To plan an unusual condition, consider the following situations:

1 Cell centers are too close (page 204)

2 Cell centers are too far apart (page 205)

3 Too many cell centers (page 205)

Cell centers are too close

If cell centers are deployed less than 10 meters apart, the handsets can initiate 
unnecessary handovers. Unnecessary handovers result in excessive internal 
messaging and degraded speech quality.
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Cell centers are too far apart

If cell centers are deployed too far apart, the edge of a cell does not overlap 
the coverage from another cell.

Cell centers must be located within the edge of other cell centers to provide 
satisfactory overlap.

Overlap can be difficult to achieve where coverage is received from the floor 
above or the floor below. Internal structures can cause overlap deficiencies.

It is not necessary that the cell center be on the same floor or an adjacent floor 
of the area that it is covering. It is only necessary to be within the cell 
boundary, as indicated by the deployment tool.

The installation of base stations in places other than the location shown on the 
plan can cause coverage problems; for example, if the base station is mounted 
on the opposite side of a wall from its planned location. 

Consider the following when choosing base station locations: 

• Choose locations only where it is possible to mount base stations.

• Install base stations as close as possible to planned locations.

• Follow safety codes or aesthetic considerations.

• Allow sufficient access for installation of base stations.

• Provide clear installation instructions.

• Test the coverage during post-deployment checks.

Too many cell centers

The primary concern with deploying too many cell centers is cost. To deploy 
the correct number of cell centers and reduce cost, do the following:

• Check the coverage and traffic volume before adding additional cells.

• Remove a cell served by other cells unless it is required for high handset 
density.

• Check the coverage area of each cell.
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• Verify that there is at least one area that each cell serves that is not served 
by another cell.

In the example shown in Figure 113, cell 1C3 is redundant unless required for 
high handset density.

Figure 113 
Locating redundant cells

Cell re-engineering for high traffic areas
To accommodate the demand in high traffic areas, follow the “The cell 
re-engineering process” on page 207.

Traffic volume

The deployment process ensures coverage throughout the service area. It does 
not, however, take into account the effect of traffic. In a high traffic area, a 
shortage of radio channels at the base station can cause calls to be blocked.

Two options are available to support the volume of telephone calls in cells 
that carry heavy traffic:

• increase the number of cells deployed

• use 12-channel base stations
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The calculation of expected telephone traffic includes an allowance for the 
user population in a cell, and the roaming user.

About the 12-channel base station

An optional 12-channel base station must be used where telephone traffic 
levels exceed those that can be carried on the standard 6-channel base station. 
The radio performance of the 12-channel unit is the same as that of the 
6-channel unit so the cell sizes are the same for both units.

Do not connect more than two 12-channel base stations to a DMC card. Two 
6-channel base stations can also be attached to a DMC serving two 
12-channel units. If loop resistance exceeds 100 ohms, external power must 
be used.

The cell re-engineering process

The cell re-engineering process involves:

1 “Estimating traffic within a cell” on page 208.

2 “Separating the coverage area and recording the number of offices” on 
page 209.

3 “Creating an estimate table” on page 210.

4 “Calculating the number of users inside the cell with an office” on 
page 211.

5 “Calculating the number of users with an office outside the cell who walk 
into the cell” on page 212.

6 “Calculating the number of users without an office” on page 213.

7 “Totalling the estimate for users in a cell” on page 214.

8 “Calculating the data for all remaining cells” on page 215.

9 “Creating a table to document “telephone types in a cell”” on page 216.

10 “Determining cell re-engineering” on page 217.
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Estimating traffic within a cell

Modify the previous deployment procedure to adjust the estimated number of 
users. To carry out this procedure:

• Determine the number of handset users with an office within each cell.

• Determine how many of these users have wired sets.

• Determine how many users without an office are normally in each cell.

Some users have both wired and handset telephones; other users rely on 
handsets only.

Re-engineered cells for high traffic areas are represented by an adjusted 
estimate for the two groups: handset and wireless, and handset only. Use the 
adjusted estimate to determine whether the cell sizes, indicated by the earlier 
deployment procedure, can handle the telephone traffic. 

If the traffic handling capacity of the cells is not adequate, use 12-channel 
base stations and subdivide them into smaller cells to ensure the traffic is 
handled properly in accordance with these instructions.



 Site planning  Page 209 of 612

DECT Description, Planning, Installation, and Operation

Separating the coverage area and recording the number of 
offices

Figure 114
Example of dividing the coverage area and recording offices  

Table 29 
Separating the coverage area and record the number of offices

Step Action

1 Divide the floor plan into cell areas.

Mark the cell areas on the floor plan, one area for each cell, splitting cell overlap areas 
in half. Shown in Figure 114 as heavy dotted lines.

2 Count the number of users’ offices in each cell area.

Record the number of users’ offices on the floor plan in each cell area. 
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Creating an estimate table

Use this table later to estimate the number of handset users for each cell. 

Table 30 
Estimate users in a cell

 Estimate for: 1C1 1C2 1C3 1Cn

Users inside the cell with an office

Users with an office outside of a cell who 
walk into the cell

Users without an office

Users in a cell

Table 31 
Creating an estimate table

Step Action

1 Make an estimate table.

Include as many columns as there are cell centers.

2 Label the rows. 

Example shown in Table 30 on page 210.

3 Label each column heading with the cell center indicator.

Use this table to determine how many times to subdivide each cell to carry the handset 
telephone traffic. 

END
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Calculating the number of users inside the cell
with an office 

Note: Traffic engineering has determined that handset users with an 
office spend seventy percent of their time within their home cell.

Table 32 
Example of the table first row calculation

 Estimate for: 1C1 1C2 1C3 1C4 1C5 1C6 1C7

Users inside the cell with an 
office

8.4

Users with an office outside 
of a cell who walk into the 
cell

Users without an office

Users in a cell

Table 33 
Calculating the number of users inside the cell with an office

Step Action

1 Calculate the estimate for users in the first cell with an office.

Use the formula: 

2 Enter the result in the row, “users inside the cell with an office”.

In the example shown in Figure 114 on page 209, twelve users in cell 1C1 spend 70% 
of their time in their offices. (12 x 0.7 = 8.4) 

Users with an office in the cell 0.7×( )

END
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Calculating the number of users with an office
outside the cell who walk into the cell

Table 34 
Example of the table second row calculation

 Estimate for: 1C1 1C2 1C3 1C4 1C5 1C6 1C7

Users inside the cell with an office 8.4

Users with an office outside of a 
cell who walk into the cell

3.2

Users without an office

Users in a cell

Table 35 
Calculating the number of users with an office outside the cell who walk into the cell

Step Action

1 Calculate the estimate for users in the first cell with an office outside of the cell who 
walk into the cell.

Use the formula:

2 Enter the result in the row, “users with an office outside the cell who walk into the cell.”

For the example shown in Figure 114 on page 209, there are a total of 75 telephone 
users in Able-Studio, minus the 12 users already in cell 1C1. Therefore, 63 users can 
walk into cell 1C1. However, the 63 walk in users only spend 30% of their time outside 
their offices. There are seven cells on the floor plan minus cell 1C1. Accordingly, an 
estimate of 3.2 walk-in users can be in cell 1C1.

 

Total users with an office Users with an office inside the cell–( ) 0.3×
Total number of cells 1–( )

-------------------------------------------------------------------------------------------------------------------------------------------------------------------------

75 12–( ) 0.3×
7 1–( )

------------------------------------ 3.2=

END
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Calculating the number of users without an office 

Table 36 
Example of the table third row calculation

 Estimate for: 1C1 1C2 1C3 1C4 1C5 1C6 1C7

Users inside the cell with an office 8.4

Users with an office outside of a 
cell who walk into the cell

3.2

Users without an office 0

Users in a cell

Table 37 
Calculating the number of users without an office

Step Action

1 Calculate the estimate for users in the first cell without an office.

Use the formula:

2 Enter the result in the row, “users without an office”.

 In the example shown in Figure 114 on page 209, there are no users without an office. 

Total number of users without an office
Number of cells

-----------------------------------------------------------------------------------------------

END
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Totalling the estimate for users in a cell 

Table 38 
Example of the table first column total

 Estimate for: 1C1 1C2 1C3 1C4 1C5 1C6 1C7

Users inside the cell with an office 8.4

Users with an office outside of a 
cell who walk into the cell

3.2

Users without an office 0

Users in a cell 11.6

Table 39 
Totalling the estimate for users in a cell

Step Action

1 Total the estimate for the number of users in the first cell by adding the three rows in 
the first column.

2 Enter the result in the bottom row “users in a cell”.

For the example shown in Figure 114 on page 209, the 1C1 handset estimate equals 
11.6.

8.4 + 3.2 + 0 = 11.6. 

END
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Calculating the data for all remaining cells    

Table 40 
Example of a completed estimate table

 Estimate for: 1C1 1C2 1C3 1C4 1C5 1C6 1C7

Users inside the cell with an office 8.4 0.7 21.0 14.7 0.7 4.9 2.1

Users with an office outside of a 
cell who walk into the cell

3.2 3.7 2.3 2.7 3.7 3.4 3.6

Users without an office 0 0 0 0 0 0 0

Users in a cell 11.6 4.4 23.3 17.7 4.4 8.3 5.7

Table 41 
Calculating the data for all remaining cells

Step Action

1 Repeat the last four tasks to calculate all the remaining user cell estimates.

2 Enter the result in the estimate table.

The information contained in Figure 114 on page 209, is shown entered into Table 41. 
This table will be used to note the results of the calculations for cells that require 
re-engineering.

END
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Creating a table to document “telephone types in a cell”

Use a table like Table 42 to record the different telephone types in each cell. 

Use the following symbols in each cell to denote the type of telephones in use 
in the cell:

• H&W refer to a cell in which all the users have both wired and handsets 
(wireless sets).

• H refers to a cell in which users have only handsets (wireless sets).

• M refers to a mix of H and H&W users.

Table 42 
Telephone types in a cell

Telephone type 1C1 1C2 1C3 1Cn

User telephone types

Table 43 
Creating a table to document “telephone types in a cell”

Step Action

1 Make a Telephone types table.

2 Label the row, “User telephone types” and include as many columns as there are cell 
centers.

3 Label each column heading with the cell center indicator.

The information in this table is used to determine the number of cells that require 
re-engineering.  

END
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Determining cell re-engineering 

 

Table 44 
Example of a completed estimate table

 Estimate for: 1C1 1C2 1C3 1C4 1C5 1C6 1C7

Users inside the cell with an office 8.4 0.7 21.0 14.7 0.7 4.9 2.1

Users with an office outside of a 
cell who walk into the cell

3.2 3.7 2.3 2.7 3.7 3.4 3.6

Users without an office 0 0 0 0 0 0 0

Users in a cell 11.6 4.4 23.3 17.7 4.4 8.3 5.7

Table 45 
Example of a completed telephone types table

Telephone type 1C1 1C2 1C3 1C4 1C5 1C6 1C7

User telephone 
types

H&W H&W M M H&W H&W H&W
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Note: Use Table 46 only for user types H&W and H. For user type “M” 
see page 220.

Table 46 
Cell re-engineering

Estimate for:

Users with both a handset 
and a wired telephone

Users with only a handset Action

From 0 up to 20 From 0 up to 12 Keep cell size as deployed.

Greater than 20 but no more 
than 80

Greater than 12, but no more 
than 40

Install a 12-channel base 
station or sub divide the cella.

Greater than 80 Greater than 40 Sub divide the cella to meet 
the above conditions.

a. For details on how to subdivide cells, refer to High handset density deployment, page 222.
 Use a 12-channel base station in areas of high traffic capacity. Cell subdivision is appropriate 
when it helps to improve coverage where the loop resistance exceeds 100 ohms or when a 
DMC can not support more than two 12-channel units. 

Table 47 
Determining cell re-engineering  (Part 1 of 2)

Step Action

1 Locate the estimate for users in the first cell.

In the example shown in Table 44 on page 217, the handset estimate is 11.6.

2 Determine the telephone types in the first cell. 

In the example shown in Table 45 on page 217, the telephone type is H&W.

3 Locate the telephone type column in Table 45 on page 217.

In the example H&W is the “users with both a handset and a wired telephone”.

4 Find the handset estimate range in Table 46 on page 218.

In the example, 11.6 falls within the “From 0 up to 20” category.
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Cell division requirements in special cases
This section describes how to determine cell division in the following special 
cases where:

a no office information is available; and, 

b there is a mix of handset users with and without wired telephones.

No office information

If it is not known where any of the users offices are, calculate the estimated 
number of handsets for each cell using this formula:

The formula assumes that users are located evenly throughout the cells. 
However, most users offices are clustered in specific areas of a building.

The formula has limitations, as cells can vary in size. The method described 
starting on page 206 gives more accurate cell division results.

5 Determine if a cell requires division or will use a 12-channel base station.

In the example “From 0 up to 20”, division is not required. 

6 Repeat the above steps to determine the required number of cells that need subdivision, 
except for telephone types M. For M see “A mix of users with and without wired 
telephones in a cell” on page 220.

7 Transfer the results of Table 47 into the Provisioning records.

Table 47 
Determining cell re-engineering  (Part 2 of 2)

Step Action

END

Number of handsets
Number of cells

------------------------------------------------
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A mix of users with and without wired telephones in a cell

Use this procedure for mixed handset users. This procedure then enables the 
telephone traffic generated by handset users, to be equated to that of handset 
and wired users. Combine the two groups for cell size recalculation purposes.     

Table 48 
 Adjustment for users without wired telephones  (Part 1 of 2)

Estimated number of handsets for users 
without wired telephones

Adjusted estimated number of handsets for 
each cell

0 0

1 2

2 3

3 5

4 7

5 9

6 11

7 12

8 14

9 16

10 18

11 20

12 22

13 24

14 25

15 27

16 29

17 31

18 34

19 36
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20 38

21 40

22 42

23 44

24 46

25 48

26 49

27 50

28 53

29 55

30 57

31 60

32 62

33 64

34 66

35 69

36 71

37 73

38 76

39 78

40 80

Table 48 
 Adjustment for users without wired telephones  (Part 2 of 2)

Estimated number of handsets for users 
without wired telephones

Adjusted estimated number of handsets for 
each cell
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High handset density deployment
The high handset density deployment includes limiting the expected number 
of handsets for each cell center.

Note: Use the high handset density procedure if instructed to do so from 
Table 46, “Cell re-engineering,” on page 218. Do not use more than one 
base station for each cell centre.

Table 49 
Adjusting for users without wired telephones 

Step Action

1 Count the number of user’s offices that have handsets and wired telephones (H&W), 
and record the number.

2 Count the number of user’s offices that have only wireless handsets, (H).

3 Use Table 48 to determine the equivalent number of H&W users and record this 
number.

4 Add the numbers received from steps 1 and 3 to determine and adjust the value for the 
number of users with wired telephones.

5 Use Table 48 to determine the criteria shown in the left column to determine if the cell 
has to be resized in the same manner described in the section “Determine cell 
re-engineering”.

END
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 Limiting the anticipated number of handsets

Limit the anticipated number of handsets for each cell centre to the limits 
shown in Table 46 on page 218. Only subdivide high handset density areas. 
If a cell falls into the category of a high density area, use the procedure on the 
following page to subdivide the cell.

Subdividing a cell

To subdivide the area for smaller cells, divide the cell into as many smaller 
cells as necessary to provide for the number of users in the area.

Figure 115 
Example of a subdivided cell

553-8213.EPS

1C1
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1

1C2
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In Figure 115, cell 1C1 has 140 handset users and cell 1C2 has 100 handset 
users. For example, Table 46 on page 218 indicates the following:

• If the handset users in cell 1C1 are all handset only users, one cell can 
support 39 handset only users. Therefore, four cells are needed to support 
140 users (140÷39 = 3.5 cells).

• If the handset users in cell 1C1 are handset and wired telephone users, 
and one cell can support 83 users, then two cells are needed to support 
140 handset and wired telephone users (140÷83 = 1.6 cells).

Table 50
High handset density deployment  (Part 1 of 2)

Step Action

1 Determine the number of handset users in the high handset density cell.

Count the number of users. Include users served by through-the-floor coverage of this 
cell.

2 Calculate the cell subdivisions as required.

Divide the number of users by the appropriate value (12 or 20) shown in Table 46 on 
page 218. Round up the result to the next whole number. The result will equal the 
number of cells required after subdividing the cell.

3 Divide the cell.

Draw lines from the cell center to the critical points on the cell boundary. Shown in 
Figure 115, the cell 1C1 divides into four sectors and cell 1C2 divides into three 
sectors.

4 Relocate new cell centers.

Mark new cell centers within the sectored areas.

5 Check the number of handset users in the new cell areas.

Count the number of user offices within each smaller sector. Make sure there are fewer 
user offices within the cell than the traffic limit.

6 Check the locations.
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Take the deployment tool to the locations that have been calculated on the floor plan. 
Make sure that there is a location that meets the guidelines on page 150. 

7 Check the new cells for complete coverage.

Use the deployment handset to check coverage.

8 Repeat the anticipated handsets for each cell calculation to make sure that each 
smaller cell provides appropriate traffic coverage to the users in the area.

Table 50
High handset density deployment  (Part 2 of 2)

Step Action

END
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Deployment review
Review the plan to make sure that the sales group can use it. The plan must 
be complete for the installer, legible for maintenance purposes, and 
acceptable to the customer.

Completing a floor plan

Table 51 
Completing a floor plan

Step Action

1 Record the planner’s name and telephone number on the floor plans.

2 Record the name of the customer company on the floor plans.

3 Record the site contact’s name and telephone number on the floor plans.

4 Record any installation restrictions. 

5 Record the details of the installation of an identified cell on the floor plans, recording 
any 12-channel base stations.

6 Record the positions of users’ offices on the floor plans.

END
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Figure 116
Example of a completed floor plan

553-8085.EPS
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Checking system capacity

Table 52 
Checking system capacity

Step Action

1 Check that the system does not exceed the Companion DECT system capacity: that is, 
no more than 512 handsets or 128 base stations for the system with no more than 
sixty-four 12-channel base stations.

2 Check that there is no ‘cell’ limit for a Companion DECT system. The limit is the total 
count of the base stations.

3 Check that the limits on base stations and handsets are independent of each other. 
Increasing the handset count does not decrease the number of base stations available 
to install, as in a Companion CT2 system.

4 If more than 128 base stations are deployed, it is necessary to replan the site with 
multiple systems. See the Detailed Site Planning section.

5 Make sure that the location of the controller is not more than 1500 m (wiring length for 
Category 5 UTP) from all 6-channel base stations or 1000 m from 12-channel base 
stations (unless external power is used). If the location is farther than the allowed 
distance, the customer needs to examine other installation and equipment 
configurations with the sales representative and Nortel Networks support personnel.

END
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Review with the customer

When the planning is finished, show the customer:

a the final positions of the base stations with a walk-about; and, 

b the areas, if any, where the coverage requirements cannot be met. 

Record floor plan information

Provide the planning information to the installer or the sales group. It is 
important that this information be communicated in a clear and accurate way.

Neatly transfer the information from the working copy to the clean copy of 
the floor plan. Use the colored markers to mark the cell boundaries and 
matching cell centers.

Record or attach the following information to the floor plans.

1 All areas needing coverage.

2 The location of the controller.

3 The total number of all base stations.

4 All the named cell centers (for example, 2C5) and their matching cell 
boundaries.

5 All the critical points that were used.

6 Any installation restrictions.

7 Any notes detailing the installation at a identified cell, recording any 
12-channel base stations.

8 The location of any base station servicing outdoor areas, and the current 
restrictions on the placing of those base stations.

9 Attach a completed traffic table with the floor plans.
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Record provisioning record information

Record the following information on the applicable provisioning record.

1 The date prepared

2 The Customer information

3 The Deployer information (name)

4 The cell numbers

5 The location of the base stations (cell centers)

6 The calculated number of users in each cell

7 Include some notes on the agreed coverage area of the site and any 
information for the installer

Review the work

At the completion of the site plan, ensure that you have:

a a customer, satisfied with the plan for a Companion system; 

b a clean floor plan with all the information, as shown in Figure 116;

c a traffic table; and, 

d a completed provisioning record.
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410

Installation and configuration

Contents
This chapter contains information on the following topics:

Before you begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231

Unpacking the equipment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 232

Provisioning records . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233

Installing the base station  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 239

Installing additional IPE shelves or Small System cabinets . . . . . . . . . 259

Installing DMC8 and faceplate cables  . . . . . . . . . . . . . . . . . . . . . . . . . 270

Installing the OTM DECT application . . . . . . . . . . . . . . . . . . . . . . . . . 289

Configuring DECT on the OTM server  . . . . . . . . . . . . . . . . . . . . . . . . 303

Configuring handsets and retrieve subscription data  . . . . . . . . . . . . . . 322

Base Station Powering and Muting. . . . . . . . . . . . . . . . . . . . . . . . . . . . 345

Adding a V.24 serial connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 348

Implementing and operating MSMN  . . . . . . . . . . . . . . . . . . . . . . . . . . 404

Before you begin
The following three tasks must be completed before DECT is installed.

1 The site survey

2 The deployment

3 The installation of the house wiring for base stations
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After these tasks have been completed, the following information and 
materials are required before continuing with DECT installation.

• Site work order

• List of equipment to be installed, showing quantities

• A marked-up floor plan

• A volt/ohm meter

• Hand tools and hardware, such as:

— screwdrivers and pliers

— spanners and socket wrenches

— drill and drill bits

— screws and screw anchors

— punch-down tools for MDF and RJ45 Connect Box

— cable continuity checking equipment

Unpacking the equipment
To unpack the equipment, complete the steps in the following table.

Table 53
Unpacking and examining the equipment

Step Action

1 Check the items shipped for discrepancies against the list of equipment required for the 
installation.

If any items are missing, take the action that is appropriate for 
this situation.

2 Carefully unpack and examine the equipment for damage.

If any items are missing, take the action that is appropriate for 
this situation. 

END
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Note: Store the equipment containers away from the installation area. 
Use the containers to return damaged equipment.

Using the Provisioning Records, marked-up floor plans, and the site work 
order, the installation proceeds in this sequence:

1 Install base station 

2 Install additional IPE shelves or cabinets

3 Install DMC8 cards and faceplate cables

4 Install OTM DECT application 

5 Configure DECT on the OTM server 

6 Configure handsets and retrieve subscription data

7 Handset subscription

8 Base Station Power and Muting 

9 Add a V.24 serial connection

Provisioning records
The Companion Provisioning Records consists of the following:

• System Site Information Record

• Provisioning Information Record

• Installation Record

• System Programming Record

• Handset User Information Record

A copy of these records should be kept at the customer site. Vendors involved 
in maintaining DECT should also have a copy of these records.

Note: Use a pencil to record information that can vary. Make 
photocopies of the tables as necessary. 
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System information record

Contacts

Client

Company name

Address

Contact name

Telephone number

Billing number

Date received

Supplier

Company name

Address

Contact name

Telephone number

Invoice number

Date shipped

Installer

Name

Installation date
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Provisioning information record

Base station cell

Sheet ______

Cell label
Base station 

location
Number of Base 

station
Base station 

number
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Installation record

Base station connection

Sheet ______

Base station number
MDF designator or I/O 

panel label
MDF RJ45 number
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TN to DECT TN assignment

Sheet ______    

TN DECT TN TN DECT TN
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System programming record

System name: __________________________
PARI licence string: __________________________

Handset user information record

Sheet_________

User name DN
WRLS 

TN
MCRD/
MCRA

CLS 
CNDD/
CNDA
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Installing the base station
Following the DECT base station rules, installation involves the following 
tasks:

• Install C4600 and C4610 base stations:

— Install Base Station wiring to the MDF. 

— Install the C4610 base station external power supply. 

• Install base station in the external housing. 

• Attach the external housing to a wall. 

• Connect the external housing wiring to the MDF.

Rules and guidelines

The following rules and guidelines apply to base station installation.

• For dc-powered systems, an input voltage of at least –48 volts is required 
for maximum base station line length.

• One hundred ohms is the maximum line length for a C4610 high traffic 
base station. If the line measurement approaches 100 ohms, use an 
external power supply.

• If the exact location is not accessible, mount the base station as close as 
possible to the location in the site survey.

• Mount the base station in a vertical position, not horizontally, on a 
ceiling.

• Lead the base station cable directly away from the base station. Surplus 
cable can cause base station malfunctions.

• Place the base station where it is unlikely to be damaged. For example, a 
base station in a warehouse must be placed where it cannot be damaged 
by a forklift truck.

• Surrounding objects must not affect the base station. For example, a base 
station in a car park needs to be placed higher than any vehicle parked 
next to it.
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• The minimum distance between two base stations must be greater than 
two meters.

• Do not mount base stations on large concrete or stone columns, air ducts 
or large metal objects.

• The external base station is powered from the line connection and does 
not require a mains connection.

• Use the external housing kit to mount any base station out-of-doors.

• Use the external housing kit for any base station subject to conductive 
pollution or dust that could become conductive due to condensation.

Compatibility

The C4600, C4610, and C4610E base stations are compatible with all 
software releases for DECT, Meridian 1, Succession 1000, and 
Succession 1000M systems. The base stations are backward compatible.

C4610E and external antenna

The C4610E 12-channel base station has an adaptor to support an external 
antenna. The external antenna increases the operating distance between the 
base station and the DECT handset. Nortel Networks recommends the use of 
a Hoper & Suhner dual-planar directional antenna. Directional antennas are 
suitable for use in places such as large halls, outside parking lots, and between 
buildings. See Figure 117 on page 241.

Note: The Huber & Suhner 8.0dBi and 10.5dBi antenna packages were 
tested with the C4610E base station. Other third-party directional 
antenna are available, but have not been tested with this base station.
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Figure 117
A Huber & Suhner dual-planar directional antenna 

Installing C4600, C4610, and C4610E base stations

Consult the work order and marked-up floor plan to determine the position of 
the base station, then perform the steps in Table 54 on page 243.
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Figure 118
Base station mounting details

Key

a screw mounting slot 

b screw and cable tie retaining washer hole

c cable tie grooves

553-AAA0294
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b
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Installing the wiring to the MDF

Consult the work order and marked-up floor plan to determine the base 
station to MDF connections, then follow the steps in Table 55 on page 245.

Table 54
Installing C4600, C4610, and C4610E base station

Step Action

1 Locate the base station mounting position.

2 Install the base station mounting screw.

If required, drill the holes for a screw anchor and install the anchor.

3 Fasten the base station on the wall or a building protrusion.

Hang the base station on the screw or use cable ties to mount the base station. Insert 
the cable ties in the vertical or horizontal grooves on the back of the base station. 
Secure the cable ties to the base station with the retaining washers and screws 
provided. Fasten the cable ties to the building protrusion.

4 If installing the C4610E base station, install the external antenna according to the 
manufacturer’s instructions.

 

CAUTION — Service Interruption

For maximum line length before signal degradation 
occurs, use UTP Cat 5 cabling between the base station 
and the shelf or cabinet. If the line length exceeds 100 
ohms for the 4610 base station, an external power supply 
must be used.

The maximum distance when using external power with 
UTP Cat 5 cabling is approximately 1.7 km.

END
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Figure 119
Base station, MDF, and I/O panel details

Key

a RJ45 Connection Box

b MDF

c recommended UTP Cat 5 cable

d IPE shelf I/O connector panel
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Note: The BIX tip and ring connections shown in Table 56 on page 246 
correspond to standard BIX designation. The first pair are labeled T0 and 
R0. See Large System: Installation and Configuration (553-3021-210), 
chapter Planning and designating the Modular Distribution Frame 
(MDF).

Table 55
Installing Base Station wiring to the MDF

Step Action

1 Connect one end of the NTCW10 cable into the base station RJ45 jack.

Use the supplied cable.

2 Install the RJ45 Connection Box.

Use the NTCW10 cable length to measure the location of the RJ45 Connection Box.

3 See Table 56 on page 246 for connection details.

Note 1: Ensure that the cable is twisted pair from beginning to end.

Note 2: If there are other twisted pairs available then ensure that the other pairs in the 
cable are not used for analogue interfaces.

4 Connect the free end of the NTCW10 cable into the RJ45 Connection Box.

END
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Figure 120
RJ45 Connection Box pin-out

Table 56
Base station RJ45 to BIX MDF connections  (Part 1 of 2)

 Base station number RJ45 Connection Box MDF connection

Base station 1

5 T8 

4  R8

6  T9

3  R9

Base station 2

5  T10

4  R10

6  T11

3  R11
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Base station 3 

5  T12

4  R12

6  T13

3  R13

Base station 4 

5  T14

4  R14

6  T15

3  R15

Base station 5

5 T16

4  R16

6  T17

3  R17

Base station 6

5  T18

4  R18

6  T19

3  R19

Base station 7

5  T20

4  R20

6  T21

3  R21

Base station 8

5  T22

4  R22

6  T23

3  R23

Table 56
Base station RJ45 to BIX MDF connections  (Part 2 of 2)

 Base station number RJ45 Connection Box MDF connection
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Installing the external power supply

For the C4600, C4610, and C4610E base stations, an external power supply 
must be installed if the UTP Cat 5 line resistance exceeds 100 ohms.

Figure 121
C4610 base station external power
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Figure 122
C4610E external power and external antenna connectors 
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Table 57
Installing the C4610 base station external power supply

Step Action

1 Remove the plastic stopper from the C4610 base station power socket.

The power socket is located next to the yellow LED.

2 Plug the external power supply jack into the C4610 base station 
power socket.

3 Connect the external power supply to the ac mains outlet.

END
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Installing the external housing

Consult the work order, then perform the steps in Table 59 on page 255.

Figure 123
External housing details

Key

a component mounting plate

b power transformer (not used)

c cable connecting box

d base station

e plate retaining nuts

f cable outlet

g external housing cabinet

553-AAA0298

d

e

f

b
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g
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Figure 124
Base station mounting details 

CAUTION — Equipment Damage

The following procedure requires the removal of the base 
station cover. The circuit board is attached to the base 
station cover. Do not damage the circuit board or bend 
the two antennas on the bottom of the circuit board.

553-AAA0299
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Table 58
Installing the base station in the external housing

Step Action

1 Open the external housing cover.

Insert the external housing key and turn clockwise.

2 Remove the base station mounting plate.

Unscrew the four nuts securing the plate and pull the plate from the cabinet.

3 Remove the base station cover. See the preceding caution note on page 252.

Carefully pry one corner of the cover from the base station, then the other corner. 

4 Remove the base station lower screw hole cover.

Push the screw hole cover out of the base station.

5 Mount the base station to the housing plate.

Affix with the screws as shown in Figure 124.

6 Replace the base station cover.

Snap the cover in place.

7 Connect the connecting box cable to the base station.

Snap the connecting box cable into the base station RJ45 Connection Box. Lead the 
cable away from the base station for optimal performance of the antennas.

8 Replace the base station mounting plate.

Secure the plate with the four nuts. 

END
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Attaching the external housing to a wall

Consult the work order and marked-up floor plan to determine the mounting 
position of the base station external housing, then perform the steps listed in 
Table 59.

Figure 125
External housing mounting lugs 

Figure 126
External housing wall mounting 

553-AAA0300

553-AAA0301
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DANGER — Electric Shock

Do not drill into electrical wires that are embedded in the 
wall.

Table 59
Attaching the external housing to a wall

Step Action

1 Choose the vertical or horizontal mounting position.

See Figure 125 on page 254 for details. Reposition mounting lugs if necessary.

2 Drill mounting holes in the wall.

Use the drilling jig to align the holes.

3 Mount the external housing to the wall.

See Figure 126 on page 254 for details. Use the screws, and appropriate inserts, to 
fasten the housing to the wall.

END
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Connecting the external housing wiring to the MDF

Consult the work order, then perform the steps in Table 60.

Figure 127
External housing MDF connection details 

Note:  The BIX tip and ring connections shown in Table 61 on page 257 
correspond to standard BIX designation. The first pair are labelled T0 
and R0. See Large System: Installation and Configuration 
(553-3021-210), chapter Planning and designating the Modular 
Distribution Frame (MDF).

Table 60
Connecting the external housing wiring to the MDF  (Part 1 of 2)

Step Action

1 Lead the building cable into the external housing.

Route the cable through the cable outlet in the external housing.

553-AAA0302
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2 Secure the cable in the connecting box.

Use a cable tie-wrap.

3 Connect the external housing wiring from the connecting box to the MDF.

Note:  See Figure 127 on page 256 and Table 61 on page 257 for wiring connections.
For DMC8 types NTCW00AB and NTCW01AB, connect from base station 1 to base 
station 8.

Note:  To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC) IPE modules 
requires 24 tip and ring pair backplane to I/O panel connections. To re-cable NT8D37 
from 16 pair to 24 pair, see Large System: Installation and Configuration 
(553-3021-210), Appendix B.

Table 61
External housing base station to BIX MDF connections  (Part 1 of 2)

 External housing 
base station number

 External housing 
connector box in number MDF connection

Base station 1

3 T8 

4  R8

2  T9

5  R9

Base station 2 

3  T10

4  R10

2  T11

5  R11

Table 60
Connecting the external housing wiring to the MDF  (Part 2 of 2)

Step Action

END
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Base station 3 

3  T12

4  R12

2  T13

5  R13

Base station 4 

3  T14

4  R14

2  T15

Base station 5

4 T16

5  R16

6  T17

3  R17

Base station 6

4  T18

5  R18

6  T19

3  R19

Base station 7

4  T20

5  R20

6  T21

3  R21

Base station 8

4  T22

5  R22

6  T23

3  R23

Table 61
External housing base station to BIX MDF connections  (Part 2 of 2)

 External housing 
base station number

 External housing 
connector box in number MDF connection
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Installing additional IPE shelves or Small System cabinets
Installing additional IPE shelves or cabinets includes the following tasks:

• Install additional IPE modules. 

• Install additional cabinets:

— Install IPE module wiring to the MDF. 

— Install cabinet wiring to the MDF.

Installing additional IPE modules

Consult the work order and marked-up floor plan to determine if additional 
IPE modules are required, then perform the steps in Table 62.

Note: If unfamiliar with this process, refer to Large System: Installation 
and Configuration (553-3021-210).

Table 62
Installing additional IPE modules  (Part 1 of 2)

Step Action

1 Remove the IPE module front and rear covers.

Remove the covers from the module on which the DECT module will sit.

2 Remove the air grills.

Release the air grill tabs or Southco® fasteners and lift the air grill off.

3 Remove the top cap.

Loosen and remove the three front and rear top cap bolts. Lift off top cap.

4 Unfasten the column LED. 

Remove the LED bracket bolts.

5 Remove the I/O back panel cover.

Unlock the four Southco fasteners.
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6 Disconnect the column LED.

Unlock LED wiring connector latches on the module backplane. Detach the LED wiring 
connector.

7 Disconnect the thermal sensor connector.

Unlock the sensor connector latches on the 36 pin orange/brown colored connector, 
located to the left of the LED connector. Unplug the sensor connector.

8 Remove the EMI perf panel.

Lift directly up.

9 Place the new module on top of the column.

Keep hands and fingers out from under the module when placing the module on top of 
the equipment column.

10 Connect the new module wiring.

Install the sensor connector of the new module into the vertical connector housing of 
the module below.

11 Secure the new module.

Insert the five bolts and lock washers into the base of the new module. Tighten the 
bolts into the original module.

12 Attach the power cable.

Connect the ribbon cable of the new module to J2 of the module below.

13 Re-install the EMI perf panel and the LED.

Install the LED connector and the sensor connector on the new module.

14 Replace the air grills and covers.

Reverse the procedure for steps 1 to 4. 

Table 62
Installing additional IPE modules  (Part 2 of 2)

Step Action

END
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Installing additional Small System cabinets

Consult the work order and marked-up floor plan to determine if additional 
Small System cabinets are required, then perform the steps in Table 63.

Note: If not familiar with this process, refer to Large System: 
Installation and Configuration (553-3021-210). 

DANGER — Electrostatic Sensitive Device

Wear a properly connected antistatic wrist strap to handle 
circuit cards. Only touch the edges. Do not touch the 
contacts or components. Set the cards on a protective 
antistatic bag. If an antistatic bag is not available, 
hand-hold the card, or set it in a card cage unseated from 
the connectors.

Table 63
Installing additional Small System cabinets  (Part 1 of 3)

Step Action

1 Mount the expansion cabinet.

For a wall mount, draw a level line, rest the bottom of mounting bracket on the line, 
screw the mounting bracket to the wall. Hang the cabinet on the mounting bracket. 
Fasten the bottom of the cabinet to the wall.
For a floor mount, install the cabinet on the pedestal. Position the cabinet according to 
the equipment layout plan.

2 Remove the drip tray.

Slide drip tray outward.

3 Install ground wire.

As a minimum, use #6AWG ground wire. Tag the main ground connection at the 
ground source to ensure it is not accidently discontinued. Test the ground.

4 Install the power supply.
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Wear the anti-static wrist strap. Turn power supply circuit breaker to OFF. Check the 
option switches on the power supply.

5 Install the fiber routing guide.

Mount the guide in the area below the circuit cards and secure with the existing 
screws.

6 Connect the fiber optic cable or copper cable as applicable. 

For the A0618443 cable, remove the two plugs on the Fiber Receiver card. Connect 
the cable to the card so the “V” shaped groove is facing inward. For the glass fiber 
optic cable, remove the plug on one connector on the card, and the cap on the cable. 
Insert the connector and secure with a half turn clockwise. Wind the excess cable on 
the storage device.

7 Insert the circuit cards in the expansion cabinet.

Refer to “Install DMC8-Es” Table 70 on page 277 and the work order for card 
placement.

8 Install or expand the MDF cross-connect terminal.

Consult the marked-up floor plan for the MDF addition location.

9 Install cables from the cabinet to the MDF cross-connect.

Consult the marked-up floor plan for the cable location.

10 Install PFTU and SDI cable if required.

Consult the marked-up floor plan for the cable location.

11 Replace the expansion cabinet drip tray.

Slide the drip tray inward.

12 Remove the main cabinet cover and drip tray.

Undo the catches on the main cabinet and slide the drip tray outward.

13 Install a Fiber Routing guide in the main cabinet, if required.

Table 63
Installing additional Small System cabinets  (Part 2 of 3)

Step Action
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The Fiber Routing guide is secured to the under side of the bottom card rail and uses 
the screws to the left of the CPU card label and under the card 2 label.

14 Turn the power supply circuit breaker to OFF.

15 Unseat the NTDK20 SSC card and install a Fiber Expansion daughterboard.

Connect the Fiber Expansion daughterboard to the connector “Fiber 1” if this is the first 
expansion cabinet, or to “Fiber 2” if this is the second expansion cabinet.

16 Connect the fiber optic cable to the Fiber Expansion daughterboard.

For the A0618443 cable, remove the two plugs on the Fiber Receiver card. Connect 
the cable to the card so the “V” shaped groove is facing inward. For the glass fiber 
optic cable, remove the plug on one connector on the card and the cap on the cable. 
Insert the connector and secure with a half turn clockwise. Wind the excess cable on 
the storage device.

17 Re-seat the NTDK20 SCC card.

18 Route the fiber optic cable through the Fiber Routing Guide.

19 Set the circuit breaker in the main cabinet to ON.

The system reloads. Check time and date using LD 2.

20 Re-install the drip tray in the main cabinet.

21 Re-install the main cabinet cover.

Table 63
Installing additional Small System cabinets  (Part 3 of 3)

Step Action

END
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Installing IPE module wiring to the MDF

Consult the work order to determine the layout of the module I/O panel to 
MDF cabling route, then perform the steps in Table 64 on page 266.

Figure 128
IPE I/O cable to BIX MDF termination

CAUTION — Service Interruption

The existing MDF cabling can be used; however, UTP 
Cat 5 – NTCW15, NTCW16, or NTCW17 MDF to PBX 
cabling is recommended, as it provides a greater line 
length before signal degradation occurs.
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Note: In NT8D11AC or NT8D11DC CE/PE and NT8D37AC or 
NT8D37DC IPE modules, these BIX connectors are not used. However, 
they are used in the NT8D11BC or NT8D11EC CE/PE and NT8D37BA 
or NT8D37 EC IPE modules.

Figure 129
IPE I/O cable to Krone MD termination  
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Table 64
Installing IPE module wiring to the MDF

Step Action

1 Identify the UTP Cat 5 twenty-five pair MDF cable.

Label both ends of the cable with the IPE module number and the 
I/O panel letter designation.

2 Connect the IPE or cabinet end of the cable.

Insert the cable’s Amphenol® connector into the appropriate 
I/O panel connector. See Table 65.

3 Run the cable to the MDF.

4 Terminate the cable on the MDF.

For BIX MDF, refer to Figure 128 on page 264 to locate the BIX connectors and Table 
65 on page 266 to locate the cable color code. For Krone MDF, refer to Figure 129 on 
page 265 to locate the Krone connectors and Table 65 to locate the cable color code.

Table 65
Color code for 25 pair cable  (Part 1 of 2)

Amphenol pin number
Tip Ring

Body/Band Body/Band

26/1 White/Blue Blue/White

27/2 White/Orange Orange/White

28/3 White/Green Green/White

29/4 White/Brown Brown/White

30/5 White/Slate Slate/White

31/6 Red/Blue Blue/Red

32/7 Red/Orange Orange/Red

33/8 Red/Green Green/Red

END
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34/9 Red/Brown Brown/Red

35/10 Red/Slate Slate/Red

36/11 Black/Blue Blue/Black

37/12 Black/Orange Orange/Black

38/13 Black/Green Green/Black

39/14 Black/Brown Brown/Black

40/15 Black/Slate Slate/Black

41/16 Yellow/Blue Blue/Yellow

42/17 Yellow/Orange Orange/Yellow

43/18 Yellow/Green Green/Yellow

44/19 Yellow/Brown Brown/Yellow

45/20 Yellow/Slate Slate/Yellow

46/21 Violet/Blue Blue/Violet

47/22 Violet/Orange Orange/Violet

48/23 Violet/Green Green/Violet

49/24 Violet/Brown Brown/Violet

50/25 Violet/Slate Slate/Violet

Table 65
Color code for 25 pair cable  (Part 2 of 2)

Amphenol pin number
Tip Ring

Body/Band Body/Band
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Installing Small System cabinet wiring to the MDF

Consult the work order to determine the Small System cabinet-to-MDF 
cabling route, then perform the steps in Table 66 on page 269.

Figure 130
Option 11 MDF details 
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Chassis expander installation

For information on installing an Chassis expander, refer to Small System: 
Installation and Configuration (553-3011-210).

Succession 1000 Media Gateway Expansion installation

For information on installing a Media Gateway Expansion, refer to 
Succession 1000 System: Installation and Configuration (553-3031-210).

Table 66
Installing Small System cabinet wiring to the MDF

Step Action

1 Identify the UTP Cat 5 twenty five pair MDF cable.

Label both ends of the cable with the cabinet jack number.

2 Connect the cabinet end of the cable.

Insert the cable’s Amphenol connector into the appropriate cabinet connector jack.

3 Run the cable to the MDF.

4 Terminate the cable on the MDF.

For BIX MDF, refer to Figure 130 on page 268 to locate the BIX connectors and Table 
65 on page 266 to locate the cable color code. 

END
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Installing DMC8 and faceplate cables
Installing the DMC8 cards and faceplate cables involves the following tasks:

1 Cross-connect base stations to the DMC8 positions. 

2 Cross-connect base stations to the DMC8 Relay card.

3 Install DMC8 and DMC8-E in an IPE shelf.

4 Install DMC8-E in a Cabinet system. 

5 Install faceplate cables and inter-shelf/cabinet cable.

Compatibility

The NTCW00AB DMC8 and NTCW01AB DMC8-E are compatible with the 
following software releases:

• Release 23 and later supports basic configuration, CLID and CPND, 
DECT card addressing within OA&M, 16 users per card.

• Release 24B and later supports 32 users per card.

• Release 25 and later supports MSMN and Concentration.

Cross-connecting base stations to the DMC8 positions

Consult the work order to determine the cross-connect details and perform the 
following steps.  

CAUTION — Service Interruption

The jumper wire on the MDF must be at least UTP Cat 3. 
UTP Cat 5 is recommended as it provides a greater line 
length before signal degradation occurs.
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Note: The BIX tip and ring connections shown in Table 68 correspond 
to standard BIX designation. The first pair are labeled T0 and R0. See 
Large System: Installation and Configuration (553-3021-210), chapter 
Planning and designating the Modular Distribution Frame (MDF). 

Table 67
Cross-connecting base stations to the DMC8 positions

Step Action

1 Cross-connect from the base station house side connector to the DMC8 equipment 
side connector.

Connect a jumper wire from the tip and ring of the house side connector to the tip and 
ring of the equipment side connector. Refer to Table 68 on page 271 for the tip and ring 
designators. For DMC8s type NTCW00AB and NTCW01AB, connect from base station 
1 to base station 8.

Note:  To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC) IPE modules, 
use 24 tip and ring pair backplane to I/O panel connections. To re-cable NT8D37 from 
16 pair to 24 pair, see Large System: Installation and Configuration (553-3021-210).

2 Cross-connect the remaining base stations.

Repeat step one until all base stations are cross-connected. 

Table 68
Base station tip and ring connections  (Part 1 of 3)

 Base station number 
Base station MDF 

connection DMC8 MDF connection

Base station 1

T8 T8

R8 R8

T9 T9

R9 R9

END
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Base station 2 

T10 T10

R10 R10

T11 T11

R11 R11

Base station 3 

T12 T12

R12 R12

T13 T13

R13 R13

Base station 4

T14 T14

R14 R14

T15 T15

R15 R15

Base station 5

T16 T16

R16  R16

T17  T17

R17  R17

Base station 6

T18  T18

R18  R18

T19  T19

 R19  R19

Base station 7

T20  T20

R20  R20

T21  T21

R2  R21

Table 68
Base station tip and ring connections  (Part 2 of 3)

 Base station number 
Base station MDF 

connection DMC8 MDF connection
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Cross-connecting base stations to the DMC8 Relay card

Consult the work order to determine the cross-connect details, then perform 
the steps in Table 69 on page 274.

Figure 131
DMC8 Relay card to base station connections

Base station 8

T22  T22

R22  R22

T23  T23

R23  R23

Table 68
Base station tip and ring connections  (Part 3 of 3)

 Base station number 
Base station MDF 

connection DMC8 MDF connection

DMC4 Relay card

553-AAA0309

 

 

UTP CAT 5
MDF cable

Equipment side House side

Base station

P1 Backplane 
connector

P2 MDF
connector

NTCW12DA
Ethernet cable
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Table 69
Cross-connecting base stations to the DMC8 positions 

Step Action

1 Connect the NTCW12DA cable to the DMC8 Relay card.

Insert P1 into the DMC8 Relay card backplane connector located on the PBX shelf/
module or the Cabinet.

2 Connect the MDF cable to the NTCW12DA cable.

Insert the MDF cable connector into P2.

3 Connect the MDF cable to the equipment side MDF cross-connect terminal block.

See the chapter in Large System: Installation and Configuration (553-3021-210) that 
discusses cabling lines and trunks. See the chapter in Small System: Installation and 
Configuration (553-3011-210) that discusses installing and connecting cross-connect 
terminal to cabinets.

4 Cross-connect from the base station house-side connector to the DMC8 Relay card 
equipment side connector.

Connect a jumper wire from the tip and ring of the house-side connector to the tip and 
ring of the equipment-side connector. Refer to Table 68 on page 271 for the tip and ring 
designators. For DMC8s, type NTCW00AB and NTCW01AB connect from base station 
1 to base station 8.

To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC) IPE modules requires 
24 tip and ring pair backplane to I/O panel connections. To re-cable NT8D37 from 16 
pair to 24 pair, see Large System: Installation and Configuration (553-3021-210).

END



 Installation and configuration  Page 275 of 612

DECT Description, Planning, Installation, and Operation

Installing DMC8 and DMC8-E in an IPE shelf

Refer to the work order and marked-up floor plan to determine the position of 
the DMC8 and DMC8-E, then perform the steps in Table 70 on page 277.

Note 1:  Install the DMC8s next to each other so the faceplate cables 
connect to the ports.

Note 2:  See “System software parameters” on page 126 for DMC8 and 
DMC8-E software package compatibility.

                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                         

DANGER — Electrostatic Sensitive Device

Wear a properly connected antistatic wrist strap to handle 
circuit cards. Only touch the edges. Do not touch the 
contacts or components. Set the cards on a protective 
antistatic bag, whenever possible. If an antistatic bag is 
not available, hand-hold the card, or set it in a card cage 
removed from the connectors.

CAUTION — Service Interruption

Only install DMC8-Es in slot 8.
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Figure 132
DMC8/DMC8-E jumper details

See Table 70 for card jumper settings.

CAUTION — Service Interruption

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to 
J9 are in the ETH position for operation on a dedicated 
LAN.

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to 
J9 are in the V.24 position for operation on a serial 
connection to the OTM server.
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Table 70
Installing DMC8 and DMC8-E in an IPE shelf 

Step Action

1 Install J1 jumper straps on the DMC8 and the DMC8-Es for Card ID.

For pre-Release 23 software, strap A B. For post-Release 23 software, and Multi-Site 
Mobility Networking, strap B C.

2 Install J2 jumper straps on the DMC8 and the DMC8-Es for the system type.

Strap A B for IPE shelf.

3 Install J3 jumper straps on the DMC8 and the DMC8-Es for cabinet or IPE shelf 
number.

For shelf 0, the lower TN IPE shelf, strap B C. For shelf 1, the higher TN IPE shelf, 
strap A B.

4 Install J6 to J9 jumper straps on the DMC8 and the DMC8-Es used as the Relay card 
for either V.24 connection or Ethernet connection.

For the V.24 connection strap jumpers J6 to J9 to the V24 position. For the Ethernet 
connection strap jumpers J6 to J9 to the ETH position. 

5 Insert DMC8-E(s), if required.

Place DMC8-E(s) in slot 8.

6 Insert DMC(s).

Place DMC8s in the slots as indicated on the work order. Do not place DMC8s in slot 8. 

END
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Figure 133
Example of a full system housed in two IPE shelves
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Figure 134
Example of a 16 card system housed in two IPE shelves
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Figure 135
Example of a 17 card system housed in two IPE shelves
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Figure 136
Example of an eight card system housed in one IPE shelf

Installing DMC8-E in a Small System or Succession 1000

Consult the work order and marked-up floor plan to determine the position of 
the DMC8 and DMC8-Es, then perform the steps in Table 71 on page 283.  

DANGER — Electrostatic Sensitive Device

Wear a properly connected antistatic wrist strap when 
handling circuit cards. Handle cards by the edges only. 
Do not touch the contacts or components. Set the cards 
on a protective antistatic bag, whenever possible. If an 
antistatic bag is not available, hand-hold the card, or set it 
in a card cage unseated from the connectors.

CAUTION — Service Interruption

Do not install DMC8-Es into any slot except slots 9, 19, 
or 29.

DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8

J1

Cont

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15Pwr Sup Rng Gen

553-AAA0314
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Note 1: The DMC8s must be adjacent to each other so the faceplate 
cables can be connected to the ports.

Note 2:  See System software parameters, page 126 for DMC8 and 
DMC8-E software package compatibility.

Figure 137
DMC8/DMC8-E jumper details

See Table 70 for card jumper settings.

553-AAA0310

J1 J2 J3 J4 J5

C
B

A
4

5
3

1
6

3
7

8
3

7
8

6
7

W
a

rra
n

ty S
ta

rt D
a

te
M

0
1

0
 2

1
 N

o
v 2

0
0

0

AT
T

E
N

T
IO

N
E

LE
C

T
R

O
S

TAT
IC

35222547042
M

ade in C
anada

5007000585

030061521303

100J

100J

100J

100J

J6
   

   
 J

7 
   

   
J8

   
   

 J
9

E
T

H
V

24



 Installation and configuration  Page 283 of 612

DECT Description, Planning, Installation, and Operation

CAUTION — Service Interruption

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to 
J9 are in the ETH position for operation on a dedicated 
LAN.

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to 
J9 are in the V.24 position for operation on a serial 
connection to the OTM server.

Table 71
Installing DMC8-E in a Cabinet, Chassis, Media Gateway, or Media Gateway Expansion 
(Part 1 of 2)

Step Action

1 Install J1 jumper straps on the DMC8 and the DMC8-Es for Card ID.

For pre Release 23 software strap A B. For post Release 23 software, and Multi-Site 
Mobility Networking, strap B C.

2 Install J2 jumper straps on the DMC8 and the DMC8-Es for system type.

Strap B C for Option 11C, 11C Mini, Media Gateway, or Media Gateway Expansion.

3 Install J3 jumper straps on the DMC8 and the DMC8-Es for shelf number.

For the lower TN cabinet, strap B C. For the higher TN cabinet, strap A B.

4 Insert DMC8-E(s), if required.

Place DMC8-E(s) in slot 9, slot 19 or slot 29. See examples in Figure 138, Figure 
139, Figure 140, and Figure 141.
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Figure 138
Example of full Small System without CPU cabinet

5 Install J6 to J9 jumper straps on the DMC8 and the DMC8-Es used as the Relay card 
for either V.24 connection or Ethernet connection.

For the V.24 connection strap jumpers J6 to J9 to the V24 position. For the Ethernet 
connection strap jumpers J6 to J9 to the ETH position. 

6 Insert DMC8(s).

Place DMC8s in the slots as indicated on the work order. Do not place DMC8s in slot 
9, slot 19 or slot 29.

Table 71
Installing DMC8-E in a Cabinet, Chassis, Media Gateway, or Media Gateway Expansion 
(Part 2 of 2)

Step Action

END

AC / DC Pwr DMC8

A: B:

DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8-E DMC8AC / DC Pwr DMC8

A: B:

DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8-E DMC8

553-AAA0315

21 22 23 24 25 26 27 28SSCPwr Sup 29 3011 12 13 14 15 16 17 18 SSCPwr Sup 19 20

Meridian 1Meridian 1
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Figure 139
Example of full Small System with CPU cabinet

Figure 140
Example of an 8-card system in two Cabinets

AC / DC Pwr DMC8

A: B:

DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8-EAC / DC Pwr DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8-E DMC8 DMC8

553-AAA0316

11 12 13 14 15 16 17 18SSCPwr Sup 19 20

Meridian 1

1 2 3 4 5 6 7 8SSCPwr Sup 9 10 MM2 MM3

N
T
D
K
2
0

N
T
A
K
2
0
B
C

Meridian 1

DMC8 DMC8 DMC8-E DMC8DMC8 DMC8 DMC8-E DMC8

553-AAA0317

21 22 23 24 25 26 27 28SSCPwr Sup 29 30

Meridian 1

11 12 13 14 15 16 17 18SSCPwr Sup 19 20

Meridian 1
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Figure 141
Example of an 8-card system in one Cabinet

Chassis installation

For information on installing circuit cards, refer to Small System: Installation 
and Configuration (553-3011-210).

AC / DC Pwr DMC8

A: B:

DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8

553-AAA0318

11 12 13 14 15 16 17 18 SSCPwr Sup 19 20

Meridian 1
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Figure 142
Chassis and expander connected with 2 NTDK95 and CE-MUX/DS-30SX 
bus cables 

Figure 143
Media Gateway and Media Gateway Expansion cabling
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Installing faceplate cables and inter-shelf/cabinet cable

Consult the work order to determine the position of the faceplate cable layout 
and NTCW11EA DMC8-E to DMC8-E inter-shelf cables, then perform the 
steps in Table 72 on page 289.

Figure 144
NTCW11EA DMC8-E to DMC8-E faceplate cable

CAUTION — Service Interruption

The NTCW11EA DMC8-E to DMC8-E faceplate cable 
has four sets of movable ferrites. The position of the 
ferrites on the cable is important.

Each end of the cable must have a group of 20 ferrites. 
One quarter of the distance from each end of the cable 
must have a group of 10 ferrites. The maximum length of 
the cable is 1.5 meters, limiting the position of DECT 
shelves 0 and 1 to adjacent IPE modules or Small 
System cabinets.

Group of 20
ferrites

Group of 10
ferrites
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Consult the work order to determine the position of the terminator plugs, then 
perform the following steps.

Installing the OTM DECT application
Installing OTM DECT application involves the following tasks:

• Ensure the DECT application is on the OTM server:

— Ensure a communications profile is associated with the DECT 
application.

— Add a communications profile for the DECT application.

— Add an Ethernet profile.

Table 72
Installing faceplate cables and inter-shelf/cabinet cable

Step Action

1 Connect the DMC8 to DMC8 faceplate cables.

Arrange the NTCW11AA DMC8 to DMC8 cables so that the DMC8 to DMC8-E cable is 
connected into the ports shown in Figures 133 to Figure 136.

2 If required, connect the NTCW11BA DMC8 to DMC8-E cable on the IPE shelf. Not 
required on Option 11C.

Plug the cable into the lower port of the DMC8 in slot 7. Plug the other end of the cable 
into the arrow pointing left port of the DMC8-E in slot 8. See Figure 133, Figure 134, 
and Figure 135.

3 Connect the NTCW11EA DMC8-E to DMC8-E inter-IPE shelf or inter-cabinet cable, if 
required.

Plug the DMC8-E to DMC8-E cable into each DMC8-E lower port. 

END
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Connecting to a DECT system

When the first connection to a new, installed DECT system is opened, the 
OTM DECT Application retrieves the DMC configuration from the OTM 
database. The OTM DECT Application reads the parameters from the DECT 
system for the manager database.

Perform one of the following actions to open a connection to a DECT system 
from an OTM DECT Application:

• Check the Permanent Connection box, allowing the connection to open 
when the OTM server starts. See Figure 34 on page 69.

• Select a DECT system in the list and click the Connect icon.

• Select an action on the menu bar that requires a system connection. For 
example, when Firmware > Upload is chosen, the connection opens to 
carry out the upload and then closes. 

Note: Do not use this type of connection for subscription actions. When 
using this type of connection, the subscription status is not refreshed 
when an on-air subscription or de-subscription occurs.

The status bar of the application provides progress feedback while the 
connection opens.

Synchronizing the DECT Application to a DECT system

When the DECT Manager connects to DECT, synchronization occurs. 
Synchronization compares the database on the DECT Manager to the DECT 
system. Database mismatches are flagged by dialogs. The opportunity is then 
given to change either the system data or manager data.

A number of synchronization steps occur during connection. The 
Synchronization process flags changes made to a DECT system database by 
other managers.
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Two types of synchronization occur when the connection state goes from 
Disconnected to Connected:

1 When the File menu or tool button is used to connect. The 
synchronization can be controlled through dialogs.

2 When the OTM re-establishes a permanent connection to DECT. A 
synchronization report is available in the Event log on the OTM server.

When connecting to a DECT system that has data that does not match the 
OTM DECT Application data, do one of the following:

• Update the OTM DECT Application database from DECT data.

• Update DECT data with the OTM DECT Application database.

Figure 145
Synchronize DECT PARI and SARI Mismatch dialog

If there is a PARI or SARI mismatch between the OTM DECT Application 
database, and the DECT database, the mismatch dialog enables the update of 
PARI and SARI parameters on both the connected DECT system and the 
OTM DECT Application. See Figure 145.

553-AAA0322
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Figure 146
Synchronize DECT Parameters Mismatch dialog

If there is a Parameter mismatch between the OTM DECT Application 
database, and the DECT system database, the mismatch dialog enables the 
update of Parameters on both the connected DECT system and the OTM 
DECT Application. See Figure 146.

553-AAA0323
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Figure 147
Synchronize DECT Board Configuration Mismatch dialog

Figure 147 shows DMC TNs (Boards) listed in the OTM DECT Application 
database that are not operational on the DECT system. Delete the check in the 
check boxes. This allows the DMCs that are no longer required in the OTM 
DECT Application database to be removed.

Figure 148
Synchronize DECT Radio Fixed Part Configuration Mismatch dialog

553-AAA0325

553-AAA0326
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Figure 148 shows Radio Fixed Parts (base stations) listed in the OTM DECT 
Application database that are not operational on DECT. Delete the check in 
the check boxes. This allows the base stations no longer required in the OTM 
DECT Application database to be removed.

Figure 149
Synchronize Radio Fixed Part Settings Mismatch dialog 

A Power Source/Alarm Muting setting was changed by another manager. 
Figure 149 says that the OTM DECT Application database automatically 
updates to match the changed settings.

Figure 150
Synchronize DECT Upstream Manager IP Address Mismatch dialog

If there is an Upstream Manager IP address mismatch between the OTM 
DECT Application database and the DECT system database, the mismatch 
dialog enables an update of the Upstream Manager IP address on both the 
connected DECT system and the OTM DECT Application. See Figure 150.

553-AAA0327

553-AAA0328
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Figure 151
DECT Subscription Configuration Mismatch dialog

The dialog warns of a DMC mismatch between DECT and the OTM server 
database. The manager cannot automatically solve the mismatch. The 
mismatch must be solved manually.

553-AAA0329
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Ensuring the DECT application is on the OTM server

Figure 152
Applications to Re-install

Complete the following steps.

Table 73
Ensuring the DECT application is on the OTM server

Step Action

1 If there is a check in the DECT box in the Applications to Re-install dialog.

Go to “Configuring DECT on the OTM server” on page 303.

2 If there is no check in the DECT box in the Applications to Re-install dialog. 

Note:  Installation is like any other application.

Select the check-box and click on the Next button. 

553-AAA0330

END
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Ensuring a Communications Profile is associated with 
the DECT application 

The DECT application must be associated with a Communications Profile. 

Figure 153
Systems Properties – Applications

The following describes the OK, Cancel, and Apply button actions:

• OK adds the changes that were made, then returns to the previous screen.

• Apply adds the changes and leaves the properties open so that other 
information can be added to this properties dialog.

• Cancel closes the dialog box without adding the changes.

553-AAA0331
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Complete the following steps.

Table 74
Ensuring a Communications Profile is associated with the DECT application

Step Action

1 Open the Systems Properties sheet.

Choose Properties from the OTM Navigator window File menu.

2 Select the Applications tab.

Click on the Applications tab.

3 If there is a check in the Enabled column next to DECT in the Name column. 

Go to “Configuring DECT on the OTM server” on page 303. 

4 If there is no check in the Enabled column next to DECT in the Name column.

Highlight DECT in the name column.

5 Select a Communication Profile.

Choose any entry from the Communication Profile drop-down list.

Note:  If there are no entries in the Communication Profile drop-down list, go to “Adding 
a Communications Profile for the DECT application” on page 299.

6 Accept the changes.

Click the OK button.

END
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Adding a Communications Profile for the DECT application

Figure 154
Add Communications Profile

Complete the following steps.

Table 75
Adding new PBX Communications Profile  (Part 1 of 2)

Step Action

1 In the Navigator window, select the Sample Site.

Double click on Sample Site.

2 Choose the Properties dialog.

Click on Properties from the File menu.

3 Open the Add Communications Profile dialog.

Click on the Communications tap and click Add.

4 Select a communications type.

553-AAA0332
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Highlight Ethernet in the Type box.

Note:  The DECT application does not use the Communications Profile. Unless there is 
another application that requires a specific Communications Profile, choosing Ethernet 
is the least complicated profile to implement.

5 Program the Profile Name.

Enter a Profile Name.

6 Accept the changes.

Click OK.

Table 75
Adding new PBX Communications Profile  (Part 2 of 2)

Step Action

END
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Adding an Ethernet profile 

Figure 155
System Properties – Communications

553-AAA0333
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Complete the following steps.

Table 76
Adding the PBX Ethernet profile

Step Action

1 Fill in the communications information for the Ethernet profile.

Enter any IP address.

Note:  Unless there is another application that requires a specific IP address, enter a 
non-existing address.

2 Accept changes.

Click Apply.

3 Return to configuring a communications profile.

Go to “Ensuring a Communications Profile is associated with the DECT application” on 
page 297.

END
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Configuring DECT on the OTM server

Installing the DME on the DMC8 Relay card

Figure 156
NTCW25AA DECT Manager Ethernet (DME) daughterboard location 

553-AAA0334
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The NTFZ38AA Ethernet Management Connection package is available, 
containing the following:

a one NTCW25AA DECT Mobility Ethernet (DME) card, and

b one NTCW12DA DMC8 I/O cable.

Table 77
Installing the DME on the DMC8 Relay card

Step Action

1 Unpack the NTCW25AA DECT Manager Ethernet (DME) daughterboard.

Remove the packing material.

2 Install the DME.

Carefully position the daughterboard over the four standoff posts and press onto the 
DMC8 relay card.

END
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Changing the DMC8 Relay card default IP address

Connecting the DMC8 Relay card to a configuring PC

Figure 157 
NTCW12DA Ethernet cable to configuring PC connections 

For information on connecting OTM through a V.24 serial connection, see 
“Adding a V.24 serial connection” on page 348.

CAUTION — Service Interruption

The DMC8 is shipped with a default IP address 
192.168.1.1. The default address must be changed to 
conform to the network IP address plan.

DECT System 

DMC4 Relay card

NTCW12DA
Ethernet cable

553-AAA0335

Captive LAN

P2 MDF connector

Configuring PC

RJ-45
P3 Ethernet 

connector

P1 Shelf / Cabinet
Backplane connector
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Note: The configuring PC can be the OTM server or another PC.
If the configuring PC is the OTM server, the Captive LAN shown in 
Figure 157 will be the OTM Server Dedicated LAN shown in 
Figure 131 on page 273.

Consult the work order to determine the DMC8 Relay card location, then 
perform the steps in Table 78 on page 306.

Note: The Relay card can be any of the DMC 8 or DMC8-E cards. 
Usually, the lowest-numbered card is used 

Resetting the DMC8 Relay card default IP address to 
the LAN IP address

The DMC8 Relay card default IP address 192.168.1.1 must be changed to 
conform to the server network IP address plan.

Table 78
Connecting the DMC8 Relay card to a configuring PC

Step Action

1 Connect the NTCW12DA cable to the connector on the backplane of the DMC8 Relay 
card.

Insert P1 into the DMC8 Relay card backplane connector located on the PBX shelf/
module or Cabinet. 

2 If the Configuring PC is on a captive LAN, link the DMC8 Relay card to the 
Configuring PC.

Insert P3 into the captive LAN RJ45 connector.

3 If the Configuring PC is on the OTM server dedicated LAN,

Insert P3 into the OTM server dedicated LAN RJ45 connector.See “Connecting the 
DMC8 Relay card to the OTM server” on page 308. 

END
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Figure 158
Telnet 192.168.1.1

Complete the following steps.  

Table 79
Resetting the DMC8 Relay card default IP address to the LAN IP address 

Step Action

1 Open the Telnet dialog.

Click on Start>Accessories>Telnet.

2 Enter user name and password.

Type user name dasuser and password dasuser.

3 When the connection prompt local appears, change the DMC8 Relay card address.

Enter the following command: 
ipconfig xxx.xxx.xxx.xxx yyy.yyy.yyy.yyy zzz.zzz.zzz.zzz

xxx.xxx.xxx.xxx = new IP address of the DMC8 Relay card.

yyy.yyy.yyy.yyy = subnet mask, usually 255.255.255.0

zzz.zzz.zzz.zzz = IP address if this is the gateway for the network.

Note:  zzz.zzz.zzz.zzz should be set to the IP address of the OTM server Ethernet 
interface. If there are two Ethernet interfaces on the OTM server, zzz.zzz.zzz.zzz should 
be set to the IP address of the interface which is on the same network as the DMC8 
Relay card.

553-AAA0336

END
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Connecting the DMC8 Relay card to the OTM server

Figure 159
NTCW12DA Ethernet cable to OTM Server LAN connections

DECT System

DMC8 Relay card MDF 

OTM Server

NTCW12DA
Ethernet cableP2 MDF

connector

DMC8 Relay card

connector
P1 Backplane 

  

MDF Cable

P3 Ethernet 
connector

RJ-45 RJ-45

Dedicated LAN
553-AAA0337
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Complete the following steps.

Table 80
Connecting the DMC8 Relay card to a Captive LAN

Step Action

1 If the DMC8 Relay card was configured on a captive LAN, remove the NTCW12DA 
Ethernet cable from the captive LAN.

Disconnect P3 from the captive LAN RJ45 connector.

2 Connect the NTCW12DA cable to the OTM Server Dedicated LAN.

Insert P3 into the Dedicated LAN RJ45 connector. 

END
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Launching the DECT application

Figure 160
M1 System Window

Complete the following step:

Table 81
Launching the DECT application

Step Action

1 Launch the DECT application.

Double click on the DECT icon.

END
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Adding DECT

Adding General System Properties

Figure 161
DECT systems and DECT System Properties 

553-AAA0363

553-AAA0362
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Complete the following steps.

Table 82
Adding DECT

Step Action

1 Open the DECT System Properties dialog.

Pull down File>Properties. 

2 Enter the DECT system name.

Type the system name in the DECT System Name box.

3 Accept the changes.

Click on the Apply button.

END
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Setting the DECT system IP address to match the 
DMC8 Relay card

Figure 162
System Properties – Communication
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Complete the following steps.

Table 83
Setting the IP address of the DMC8 Relay card in the manager

Step Action

1 Open the Communications dialog.

Click on the Communications tab.

2 Enter the IP address.

Type the IP address that was entered in Table 79 on page 307.

3 If the communication link is Ethernet, select Ethernet.

Click on the Ethernet radio button.

4 If the communication link is Serial, select Serial.

Click on Serial radio button, and go to “Adding a V.24 serial connection” on page 348.

5 Accept the changes.

Click on the OK button.

Note:  When the OK button or Apply button is clicked at this point, the manager attempts 
to connect to the DECT system to write the MIB2 system name. 

6 If required, program an Upstream Manager.

Go to page 315.

7 If an Upstream Manager is not required.

Go to “Synchronizing data with DECT” on page 316.

END
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Adding the upstream manager IP address, if required

Figure 163
System Properties – Alarm

553-AAA0365
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Complete the following steps.

Synchronizing data with DECT

When the DECT manager connects to DECT, synchronization occurs. 
Synchronization compares the database on the manager to the database of the 
DECT system. Database mismatches are flagged by dialogs. The opportunity 
to change either the DECT system data or the manager data is given.

Table 84
Adding the upstream IP address, if required

Step Action

1 Open the DECT System Properties dialog.

Pull down File>Add. 

2 Open the Alarm dialog.

Click on the Alarm tab.

3 Enter the IP address.

Type the Upstream manager IP address.

4 Accept the changes.

Click on the OK button. 

END
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Figure 164
DECT Systems

Complete the following steps:

Table 85
Synchronizing data with the DECT system 

Step Action

1 If the toolbar icon is red, the connection to the DECT system is enabled. Disconnect 
from the DECT system.

Double click on the icon, or use File>Disonnect. Go to “Synchronizing DECT PARI and 
SARI” on page 318.

2 If the toolbar icon is green, re-connect to the DECT system

Double click on the red icon, or use File>Connect.

553-AAA0366

END
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Synchronizing DECT PARI and SARI

Figure 165
Synchronize DECT PARI and SARI Mismatch dialog

Complete the following step:

Table 86
Synchronizing DECT PARI and SARI 

Step Action

1 Store the DECT system PARI SARI parameters in the OTM Manager database.

Click on the Update DECT Manager button.

553-AAA0322

END
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Synchronizing DECT parameters

Figure 166
Synchronize DECT Parameters Mismatch dialog

Complete the following step:

Table 87
Synchronizing DECT Parameters

Step Action

1 Store the DECT system DECT Parameters in the OTM Manager database.

Click on the Update DECT Manager button.

553-AAA0323

END
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Synchronizing DECT Upstream Manager IP address

Figure 167
Synchronize DECT Upstream Manager IP address mismatch dialog

Complete the following step:

Table 88
Synchronizing DECT Upstream Manager IP address 

Step Action

1 Store the DECT system Upstream Manager IP address in the OTM Manager database.

Click on the Update DECT Manager button.

553-AAA0328

END
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Un-installing DECT Manager – Caution

Before un-installing DECT Manager, read the following information.

CAUTION — Service Interruption

When the OTM DECT Manager is un-installed, the 
Sentinel driver is also un-installed, even if other 
applications require the driver. Any attempt to launch 
other OTM systems or applications generates the 
message:

           “No dongle attached to the PC.”

It is necessary to re-install the Sentinel driver. Download 
the driver from the internet.Go to 
www.rainbow.com.tech/downloads.html

In the product drop-down menu, scroll down and select 
System Drivers.

On the System Drivers page, select the Sentinel System 
Driver – Driver Only file and download the zipped file. 
After download is complete, unzip the file and install the 
driver.
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Configuring handsets and retrieve subscription data 

Configuring non-concentrated Large System handsets

For information about System Administration, see Optivity Telephony 
Manager: System Administration (553-3001-330).

Opening the Station Administration window

Figure 168
System Window

Complete the following step: 

553-AAA0368
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Table 89
Opening the Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the M1 System Window.

END



Page 324 of 612  Installation and configuration

553-3001-370 Standard 1.00 October 2003

Accessing Add Station dialog

Figure 169
Station Administration window

Complete the following step:

Table 90
Accessing Add Station dialog

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.

553-AAA0369

END
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Adding 500 analog standard

Figure 170
Add Station dialog

Complete the following step:

Table 91
Adding 500 analog standard

Step Action

1 Add 500 analog standard.

Highlight 500 Analog Standard, and click OK.

553-AAA0370

END
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Accessing features

Figure 171
500 dialog

Complete the following step:

Table 92
Accessing features

Step Action

1 Access the features.

Click on the Features button.

553-AAA0371

END
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Accessing wireless type

Figure 172
Features dialog

Complete the following step:

Table 93
Accessing wireless type

Step Action

1 Access wireless type.

Highlight Wireless Type, and click on the Select button.

553-AAA0372

END
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Selecting wireless type

Figure 173
Wireless dialog

Complete the following step:

Table 94
Selecting wireless type

Step Action

1 Select wireless type.

From the Wireless Type (WTYP) pull-down menu select YES.

END
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Selecting DECT wireless set

Figure 174
Wireless dialog

Complete the following step:

Table 95
Selecting DECT wireless set

Step Action

1 Select DECT handset.

From the Wireless Type (WTYP) pull-down menu, click on DECT Wireless Set. Click 
OK.

553-AAA0374

END
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Accepting changes

Figure 175
Features dialog

Complete the following step:

Table 96
Accepting changes

Step Action

1 Accept changes.

Click on the Done button.

553-AAA0372

END
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Configuring concentrated handsets on a Large System

Opening Station Administration window

Figure 176
M1 System Window

Complete the following step.

Table 97
Opening the Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the System Window.

553-AAA0368

END
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Accessing Add Station dialog

Figure 177
Station Administration window

Complete the following step:

Table 98
Accessing Add Station dialog

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.

553-AAA0369

END
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Selecting Digital Cordless Set

Figure 178
Add Station dialog

Table 99
Selecting Digital Cordless Set

Step Action

1 Select Digital Cordless Set.

Highlight DCS. Click on the OK button.

553-AAA0376

END
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Selecting Features

Figure 179
DCS dialog

Table 100
Selecting Features

Step Action

1 Select the features.

Click on the Features button.

553-AAA0377

END
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Selecting wireless type

Figure 180
Features dialog

 

Table 101
Selecting wireless type

Step Action

1 Select wireless type.

Highlight WTYP, and click on the Select button.

553-AAA0375

END
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Selecting Visiting DECT SET or local calling only

Figure 181
Wireless dialog  

Table 102
Selecting Visiting DECT Set or local calling only

Step Action

1 Select Visiting DECT Set as Yes if the handset is to visit this PBX. Select No if this 
handset is to be used for local calling only.

If Visiting DECT Set is Yes, go to step 2. If this handset is to be used for local calling 
only, go to step 3.

2 Select a Home DN.

Enter a DN in the Home Directory Number (HMDN) box.

3 If the handset is to be used for local calling only, from the Visiting DECT Set (VSIT) 
list, select No.

4 Accept changes.

Click on the OK button.

553-AAA0378

END
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Selecting an index

Figure 182
Features dialog

Table 103
Selecting an index

Step Action

1 Select an index.

Highlight INDX, and click on the Select button.

END
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Provisioning hardware

Figure 183
Hardware Provisioning dialog

Table 104
Provisioning hardware

Step Action

1 Select a DMC TN.

Enter a TN in the DECT Mobility Controller (DMC) box.

2 Select an index.

Enter an index in the Index on DMC (INDX) box. Index range is 0 to 509.

Note:  The Terminal Number (TN) is a virtual TN and is selected by the system.

3 Accept changes.

Click the OK button.

553-AAA0380

END
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Accepting changes

Figure 184
Features dialog

Table 105
Accepting changes

Step Action

1 Accept changes.

Click on the Done button.

553-AAA0381

END
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Selecting Single Line Features

Figure 185
500 dialog

Note: Complete the “System programming record” on page 238 and 
“Provisioning information record” on page 235. 

Table 106
Selecting Single Line Features

Step Action

1 For information on other Single Line Features.

Refer to the OTM Station Administration in Optivity Telephony Manager: System 
Administration (553-3001-330).

553-AAA0371

END
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Retrieving subscription data for handsets

Figure 186
DECT Systems window and Subscriptions window

553-AAA0382

553-AAA0281



Page 342 of 612  Installation and configuration

553-3001-370 Standard 1.00 October 2003

Complete the following steps.

Table 107
Subscribing handsets

Step Action

1 Launch the Subscriptions window from the DECT Systems window.

Click on the Applications pull-down menu, click on Subscriptions.

2 Retrieve the subscription configuration data from the OTM Station Administration 
database.

Note:  At this point, no handset data appears in the Subscriptions window.

In the Subscriptions window, click on the Operations pull-down menu, click on 
Retrieve OTM Configuration.

3 Open the Configure DECT Subscription dialog.

Note:  At this point, all handsets configured on OTM Station Administration are shown 
in the Subscriptions window

Click on the File pull-down menu, click on Add or click on .

END
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Enabling subscription

Figure 187
Subscriptions window 

Complete the following steps for each handset:

Table 108
Configuring handsets

Step Action

1 Note:  At this point, there are no PINs shown in the Subscriptions window.

Select a handset from the list.

Click on one handset in the list to highlight a row.

2 Enable handsets.

Click on the Operations pull-down menu, click on Enable or click on .

END
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Activating the PIN on the handsets

Figure 188
Subscriptions window

Complete the following step:

Note: When a handset is subscribed, the Subscription window shows the 
Status column as Subscribed and does not show a PIN.

Table 109
Obtaining the PIN

Step Action

1 Note:  At this point, in the Subscriptions window, the PINs are shown and the Status is 
Enabled.

Subscribe the DECT handsets.

See “Handset subscription” on page 345.

END
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Handset subscription

For detailed information on subscribing a handset, refer to Subscribing the 
C4010, C4010 Ex, C4020 handsets, page 472 and Subscribing the C4050 
handset, page 480, or the individual handset’s User Guide.

Base Station Powering and Muting

Opening RFP window

Figure 189
DECT Systems main window and RFP window

553-AAA0383

553-AAA0281
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Complete the following steps:

Table 110
Opening RFP window

Step Action

1 Launch the DECT Systems window.

2 Launch the Boards window.

On the DECT Systems window, click on the Applications pull-down menu, click on 
Boards.

3 Select a base station from the list.

Click on one RFP in the list to highlight a row.

4 Open the Radio Fixed Part properties dialog.

Click on the File pull-down menu, click on Properties.

END
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Setting base station alarm muting, line power, and comments

Figure 190
DECT Radio Fixed Parts

Complete the following steps:

Table 111
Setting alarm muting, line power, and comments for base stations

Step Action

1 Set alarm muting. Select No to deny alarm muting or Yes to allow alarm muting.

Click on No or Yes.

2 Enter up to 80 characters for comments.

Type comments.

3 Select local powered or line powered for the selected base station.

Click the Line Powered or Local Powered radio button.

4 Apply the selections.

Click the OK button.

553-AAA0384

END
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Adding a V.24 serial connection

DMC8 to OTM server serial connections

A DMC8 Relay card-to-OTM server serial connection is required if a DME 
daughterboard is not present on the relay card. There are two types of serial 
connections:

• When the relay card and OTM server are local, and connected without a 
modem

• When the relay card and OTM server are remote, and connected with a 
modem

Serial connection for Windows 2000

For information on how to configure a serial connection using Windows 
2000, see “V.24 connection using Windows 2000” on page 385.

CAUTION — Service Interruption

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to 
J9 are in the V.24 position for operation on a serial 
connection to the OTM server.
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Connecting the relay card to a local OTM server without a 
modem

Figure 191
DMC8 Relay card connection to a local OTM server without a modem

 

DMC4 Relay card
without NTCW25AA
DME daughterboard

NTCW12AA
MDF to modem 

cable A0773252
Null modem 

adaptor

OTM Server

553-AAA0386

Standard
DB-25 to DB-9

cable
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Note: The BIX tip and ring connections shown in Table 113 on page 350 
correspond to standard BIX designation. The first pair are labeled T0 and 
R0. See the planning and designating the MDF section in Large System: 
Installation and Configuration (553-3021-210). 

Table 112
Connecting the Relay card to a local OTM server 

Step Action

1 Connect the NTCW12AA cable to the DMC8 Relay card MDF connector.

Refer to Table 113 on page 350 for the NTCW12AA cable tip and ring connections.

2 Choose the OTM server COM port from the work order.

Connect the DB-9 cable connector into the OTM COM port.

3 Install the null modem plug.

Connect the DB-25 connector end and the NTCW12AA cable end into the AO773252 
null modem adapter.

Table 113
NTCW12AA cable to MDF connections

DMC8 Relay card 
MDF connection Cable color

DB25 connector pin 
number Signal designator

T1 Grey 8 V.24DCD

R2 Yellow 4 V.24RTS

T3 Blue 2 V.24TXD

R3 Red 3 V.24RXD

T4 Pink 7 V.24GND

END
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Connecting the relay card to a remote OTM server 
with modems

Figure 192
DMC8 relay card connection to a remote OTM server

DMC4 Relay card
without NTCW25AA
DME daughterboard

NTCW12AA
MDF to modem 

cable

OTM Server

553-AAA0385

Standard
DB-25 to DB-9

cable

 

PSTN

Modem
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Table 114
Connecting the remote OTM server to a modem 

Step Action

1 Connect the OTM COM port to the modem.

Connect the DB-9 end of the V.24 cable to the OTM COM port. Connect the DB-25 end 
of the V.24 cable to the modem.

2 Set up the OTM modem.

Follow the manufacturers set-up procedures. Set modem as follows:

• Line speed = 38400b/s

• No parity

• 1 stop bit

• 8 bit words

• No output control

• No timer

3 Connect the modem to the Public Switched Telephone Network.

Plug a teledapt cable into the modem RJ-11 jack. Connect the other end of the teledapt 
cable to the PSTN.

END
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Table 115
Connecting the DMC8 Relay card to a modem 

Step Action

1 Connect the NTCW12AA cable to the DMC8 Relay card MDF connector.

Refer to Table 113 on page 350 for the NTCW12AA cable tip and ring connections.

2 Set up the OTM modem.

Follow the manufacturers set-up procedures. Set modem as follows:

• Line speed = 38400b/s

• No parity

• 1 stop bit

• 8 bit words

• No output control

• No timer

3 Connect the NTCW12AA cable to the modem.

4 Connect the OTM modem to the Public Switched Telephone Network (PSTN).

Plug a teledapt cable into the modem RJ11 jack. Connect the other end of the teledapt 
cable to the PSTN.

END
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Installing a virtual modem on the PC

A virtual modem is required for a local serial connection.

Figure 193
Install New Modem

553-AAA0387
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Complete the following steps:

Table 116
Installing a modem on the PC 

Step Action

1 Go to Control Panel.

Click on Modem.

2 In the Manufacturers field.

Select [Standard Modem Types].

3 In the Models field.

Select Dial-Up Networking Serial Cable between 2 PCs.

4 Continue.

Click on Next.

END
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Configuring modem properties

The properties must be configured to interface serially to the DECT system.

Figure 194
Model Properties

553-AAA0388
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Complete the following steps:

Table 117
Configuring modem properties 

Step Action

1 Go to Control Panel.

Click on Modem.

2 Select the modem installed.

Click on the modem in the list.

3 Open the properties dialog.

Click the Properties button.

END
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Setting modem speed 

Figure 195
Dial-Up Networking Serial Cable between 2PCs #... General tab

Complete the following steps:

Table 118
Setting modem speed

Step Action

1 Select maximum modem speed.

Choose 38400.

2 Apply selection.

Click OK.

553-AAA0390

END
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Setting connection preferences

Figure 196
Dial-Up Networking Serial Cable between 2PCs #... Connection tab 

553-AAA0391
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Complete the following steps:

Table 119
Setting connection preferences 

Step Action

1 Set Data bits.

Select 8.

2 Set Parity.

Select None.

3 Set Stop bits

Select 1.

4 Open Advanced dialog.

Click on the Advanced button.

END
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Disabling flow control

Figure 197
Advanced Connection Settings 

Complete the following step:

Table 120
Disabling flow control

Step Action

1 Ensure that flow control is disabled.

Remove check from the Use flow control box.

553-AAA0392

END
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Configuring Remote Access Service (RAS)

Figure 198
Network – Services
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Complete the following steps:

Table 121
Configuring Remote Access Service

Step Action

1 Open the Network property dialog.

Start> Control Panel> click on the network icon.

2 Select Services.

Click on Services tab.

3 Select the Remote Access Service.

Click on Remote Access Service.

END
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Setting RAS modem and port usage

Figure 199
Remote Access Setup and Configure Port Usage

Complete the following steps:

Table 122
Setting modem and port usage 

Step Action

1 Select a modem.

Highlight a device.

2 Configure.

Click on the Configure... button.

3 Select Port Usage.

Click on the Dial out only radio button.

END
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Configuring RAS setup and network

Figure 200
Remote Access Setup and Network Configuration

Complete the following steps:

Table 123
Configuring Remote Access Service 

Step Action

1 Select a modem.

Highlight a device.

2 Select Network.
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Click on the Network button.

3 Select TCP/IP protocol for this port.

Click a check in the TCP/IP box.

Table 123
Configuring Remote Access Service 

Step Action

END



 Installation and configuration  Page 367 of 612

DECT Description, Planning, Installation, and Operation

Configuring NetBIOS services

The NetBIOS Interface Service must be installed. If this is not done, there will 
be no PPP protocols configured on the RAS ports.

Figure 201
Network – Services
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Complete the following steps:

Table 124
Configuring Remote Access Service  

Step Action

1 Ensure that the NetBIOS Interface Service is installed.

Double-click on the Control Panel’s Network and Dial-up Connections icon. Right-click 
on the appropriate connection. Click Properties. Click the Services tab.

2 Observe if the NetBIOS Interface is on the list of Network Services.

If the NetBIOS Interface is on the list of Network Services, click Close. Go to “Setting 
up and configuring a RAS Phone book entry” on page 369.
If the NetBIOS Interface is not on the list of Network Services, click Add. 
See Figure 201.

3 The Select Network Component appears. Select the required network component.

Select Protocol. Click Add

4 The Select Network Protocol window opens. Select the desired protocol.

Select NetBIOS Interface. Click Install. Click Close. 

END
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Setting up and configuring a RAS Phone book entry

Opening the Dial-up Networking dialog

Figure 202
Dial-up Networking dialog 

Complete the following steps:

Table 125
Opening the Dial-up Networking dialog 

Step Action

1 Open the Dial-up Networking property dialog on Windows NT.

Start> Program> Accessories> Dial-up Networking.

2 Continue.

Press the New button.

END



Page 370 of 612  Installation and configuration

553-3001-370 Standard 1.00 October 2003

Setting up the phone book entry name

Figure 203
New Phonebook Entry Wizard 

Complete the following steps:

Table 126
Setting up the phone book entry name

Step Action

1 Name the phone book entry.

Enter the system name.

2 Accept the changes.

Press the Next button.

END
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Setting up the server dialog

Figure 204
Server 

Complete the following steps:

Table 127
Configuring Remote Access Service

Step Action

1 Set up the server dialog.

Check the Send my plain text password... box.

2 Accept the changes.

Press the Next button.

END
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Going to the next dialog

Figure 205
Phone Number 

Complete the following step:

Table 128
Going to the next dialog

Step Action

1 Omit this dialog.

Press the Next button.

END
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Completing set up

Figure 206
New Phonebook Entry Wizard 

Complete the following step:

Table 129
Setting up complete

Step Action

1 Complete the set up.

Press the Finish button.

END
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Configuring the networking dial-up

Figure 207
Dial-Up Networking 

Complete the following steps:

Table 130
Configuring the networking dial-up

Step Action

1 Open the Dial-up Network property dialog on Windows NT.

Start> Program> Accessories> Dial-up Networking.

2 Select edit phone book.

Under the More drop-down list, select Edit entry and modem properties.

END
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Configuring the Dial using an entry

Figure 208
Edit Phonebook Entry – Basic 

Complete the following steps:

Table 131
Configuring the Dial using an entry

Step Action

1 Configure an entry from the Dial using drop-down list.

Note:  The list shows modems that were previously configured.

Select an appropriate entry from the Dial using drop-down list.

2 Accept the changes.

Press the OK button.

END



Page 376 of 612  Installation and configuration

553-3001-370 Standard 1.00 October 2003

Configuring the Dial-up server type

Figure 209
Edit Phonebook Entry – Server

Complete the following steps:

Table 132
Configuring the Dial-up server type

Step Action

1 Configure the Dial-up server type.

Select PPP: Windows NT... and check the boxes shown in Figure 209 on page 376.

2 Open the PPP TCP/IP Settings dialog.

Press the TCP/IP settings button.

END
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Configuring IP address

Figure 210
PPP TCP/IP Settings 

Complete the following steps:

Table 133
Configuring IP address 

Step Action

1 Select the settings.

Click the Specify an IP address and the Server assigned name server address 
radio buttons.
Click on both check boxes.

2 Specify an IP address.

Enter the IP address.

END
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Accepting the configuration changes

Figure 211
Services

Complete the following step:

Table 134
Accepting the configuration changes

Step Action

1 Accept the configuration changes.

Press the OK button.

END
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Establishing the RAS connection

Figure 212
Dial-Up Networking 

Complete the following steps:

Table 135
Establishing the RAS connection

Step Action

1 Open the Dial-up Network property dialog on Windows NT.

Start> Program> Accessories> Dial-up Networking.

2 Select the Phonebook entry to dial.

Highlight the entry.

3 Dial.

Press the Dial button.

END
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Establishing a connection to the DECT system

Figure 213
Connect to my DECT system 

Complete the following step:

Table 136
Establishing a connection to the DECT system

Step Action

1 Establish access.

Note:  No input to this dialog needed.

Press the OK button.

END
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Establishing connection complete

Figure 214
Connection Complete 

Complete the following step:

Table 137
Establishing connection complete

Step Action

1 Finish.

Press the OK button.

END
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Setting the IP address through Telnet

Figure 215
Connect

Complete the following steps:

Table 138
Setting the IP address through Telnet

Step Action

1 Open the Dial-up Network property dialog on Windows NT.

Start> Program> Accessories> Telnet.

2 Address the DMC8 Relay card using the card’s default IP address.

Enter 192.168.1.1 in the Host Name: box.

3 Connect to the DMC8 Relay card.

Press the Connect button.

END
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Configuring the IP address

Figure 216
Telnet 192.168.1.1

Complete the following steps:

Table 139
Configuring the IP address

Step Action

1 Login.

Enter dasuser.

2 Password.

Enter dasuser.

3 Configure the IP address.

Use ipconfig as shown on the bottom line in Figure 216 on page 383.

4 Disconnect the Telnet connection.

Click on the close box in the upper right corner.

END
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Hanging-up the RAS connection

Figure 217
Dial-up networking 

Complete the following step:

Table 140
Hanging up the RAS connection

Step Action

1 Hang up the RAS connection.

Click the Hang Up button.

END
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V.24 connection using Windows 2000

For the OTM-DECT Manager to communicate with DECT remotely over 
Point-to-Point Protocol (PPP), RAS must be configured for dial-out using the 
appropriate modem. See “Configuring Remote Access Service (RAS)” on 
page 362.

Note 1: The DECT system can also directly communicate over a modem 
to a remote OTM-DECT Manager.

Note 2:  The back-end process must be visible to make a connection. See 
“Launching OTM-DECT back-end” on page 401 for more information. 
If the back-end is closed in error, OTM-DECT will not operate.

Configuring the dial-up

Configure dial-up on the OTM server using Windows 2000. Perform the 
following steps.

1 Select the Control Panel > Phone and Modem Options > Modems tab.

2 Click Add.

3 Click check box Don’t detect my modem.... Click NEXT.

4 From Manufacturer’s List Type list, select Standard Modem.

5 From Model’s list, select Communications cable between two 
computers. Click Next.

Note: Step 5 is required only if there is no Ethernet connection to the 
DMC8 card.

6 Select a COM port supported by the PC. Click Next.

7 Click Finish.

Configuring the modem

Configure the modem properties for serial interface. To configure the 
modem, perform the following steps.

1 Select Control Panel > Phone and Modem Options> Modems tab.

2 Select the modem Communications cable between two computers. 
Click Properties. See Figure 218 on page 386. 



Page 386 of 612  Installation and configuration

553-3001-370 Standard 1.00 October 2003

Figure 218
Control Panel > Phone and Modem Options > Modems tab

3 In the Maximum Port Speed drop-down menu, select 38400. 
See Figure 219 on page 387.

553-AAA0396
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Figure 219
Modem tab – Properties button 

4 Click the Advanced tab.

5 Set the Data bits to 8. 
Set the Parity bits to None. 
Set the Stop bits to 1.

6 Click OK. 

Configuring network and dial-up connections

Note: Ensure that the NetBIOS Interface Service is installed; otherwise 
PPP is not configured on the RAS ports.
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To configure network and dial-up connections, perform the following steps.

1 Select Control Panel > Network and Dial-up Connections.

2 Click the Make new connection icon. The Connection Wizard starts. 
See Figure 220.

Figure 220
Network Connection Wizard 

3 Click Next.

4 Click the Connect directly to another computer radio button. Click 
Next. See Figure 221 on page 389.

Note: If using a modem connection to the DMC8 card, click the 
Dial up to private network radio button.

553-AAA0398
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Figure 221
Network Connection Type radio buttons

5 Click the Guest radio button. Click Next. See Figure 222 on page 390.

553-AAA0399
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Figure 222
Host or Guest

6 From the Select a Device drop-down list, select Communications cable 
between two computers. Click Next. See Figure 223 on page 391.

553-AAA0436
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Figure 223
Select a Device

7 Click the For all users radio button. Click Next. See Figure 224 on 
page 392.

553-AAA0437
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Figure 224
Connection Availability

8 Type a name for the connection. Click Finish. 
See Figure 225 on page 393.
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Figure 225
Completing the Network Connection Wizard

A new window appears automatically. The window is titled with the 
connection name entered earlier. See Figure 226 on page 394.

It is not necessary to enter a user name or password.
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Figure 226
New connection window 

9 Click Properties. A new window opens.

10 Select the General tab. Select Communications cable between two 
computers (COM2) from the Select a device drop-down menu. See 
Figure 227 on page 395.
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Figure 227
General tab

11 Click Configure. The Modem Configuration window opens. Ensure that 
the Maximum speed (bps) is 38400 bauds. See Figure 228 on page 396. 
Click OK.
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Figure 228
Modem Configuration window 

12 Select the Security tab. Click the Security Options – Typical radio 
button. Select Allow unsecured password from the drop-down menu. 
Click OK. See Figure 229 on page 397.
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Figure 229
Security tab

13 Click the Networking tab. Select Internet Protocol (TCP/IP). Click 
Properties.

14 Click the radio button for Use the following IP address. Enter the IP 
address of the OTM server. 

15 Click Advanced. Check all three boxes in the PPP Settings window. 
Click OK.

16 On the Networking tab, click OK.

17 Click Connect in the named dial-up connection window. See Figure 230 
on page 398. No password is required.
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Figure 230
Connect to the DMC8

The screen shown in Figure 231 appears.

Figure 231
Registering on the network

The screen shown in Figure 232 on page 399 appears when a successful 
connection has been made.
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Figure 232
Connection complete screen

18 Disconnect the connection by following the on-screen instructions. Close 
the screen. 

19 Restart the OTM PC.

DECT Access System configuration

It is necessary to configure the DECT Access System (DAS). Perform the 
following steps.

1 In OTM-DECT, add a new DAS.

2 Select the Communications tab.

3 Enter the IP address of the DMC8 card.

4 Select Serial and click Details.

5 Select the COM port that DAS uses to connect to the PC.

6 Enter the IP address of the OTM Server in the OTM Server IP Interface 
field.
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Note: The IP address of both the DMC8 card and the OTM Server must 
have the same subnet mask. See Table 141 for an example.

Error messages

If the error message (Connection event) shown in Figure 233 appears, verify 
the device manager for COM2 in Control Panel > System > Hardware > 
Device Manager > Ports > COM2.

Figure 233
Connection event

Table 141
Sample IP addresses with the same subnet mask

DMC8 IP address 192.168.100.35

OTM Server IP address 192.168.100.179
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Launching OTM-DECT back-end

To launch the OTM-DECT back-end, perform the following steps. 

1 Open the Windows Registry. 
Start > Run> regedit
See Figure 234 on page 401.

Figure 234
Windows Registry 

CAUTION

Always ensure the Windows Registry is backed up before 
opening the Registry and its keys.
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2 Copy the value of the key 
HKEY_LOCAL_MACHINE\SOFTWARE\NorMat\SMP\OTMSer
vices\DECT\Args
See Figure 235 on page 402.

Figure 235
Registry key HKEY-LOCAL_MACHINE 
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3 Open a command prompt window. At the command prompt, type
java paste copied text here

(At the command prompt, type java, press the space bar once, and paste 
the contents of the clipboard.)
See Figure 236 on page 403.

Figure 236
Command prompt with pasted text 

4 Press the Enter key. 
The OTM-DECT back-end is launched. See Figure 237.
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Figure 237
OTM-DECT back-end is launched 

Implementing and operating MSMN

Implementing the MSMN feature

The sequence of actions required to configure this feature are as follows:

1 Configure a phantom superloop using LD 97, if required.

2 Create the new DCS sets in LD 10.

3 Configure the RCFW data in LD 57 and LD 15 for handsets assigned as 
a visitor.

4 Use the DECT manager to configure sets on the DMC8.

5 Pre-subscribe the visiting handset one time at the MCDN node.

Note: Subscription includes both overlay configuration and DECT 
Manager configuration. For DECT Manager configuration, see 
“Configuring DECT on the OTM server” on page 303. 
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LD 10 – Add/Change DCS data block or data blocks. (Part 1 of 2)

Prompt Response Description

REQ: NEW NEW 1-255 
CHG ECHG

NEW = Add a Digital Cordless Set

NEW X = The generation of new DCS units stop when the 
maximum Index of 509 is reached on a single DMC8 or 
VTNs on the system run out or WRLS ISM limits reached. 
All new DCS must be on the same DMC8.

CHG = Allows the DCS configuration to change to another 
DMC8. All new DCS must be on the same DMC8.

ECHG = This command can change either the VSIT 
response or the HMDN response.

TYPE: DCS Digital Cordless Set.
Differentiates between analog sets and non-concentrated 
digital Companion DECT handsets.

If TYPE=DCS, the system allocates the next available VTN, 
and WRLS defaults to YES and WTYP defaults to DECT. If 
package #350 is included, MWUN defaults to 32.

CLS defaults to ERCA, allowing the Enhanced RCFW 
feature.

TN l s c u 
c u

TN on Large System.
TN on Small System and Succession 1000.

The system provides the Virtual TN for the handset.

CDEN (4D) Card Density. Only valid value for IPE is 4D. Normal input is 
<CR>.

WRLS YES WiReLess analog Set – entry defaults to YES with no user 
input; value cannot be CHG’ed.

WTYP DECT Wireless TYPe – entry defaults to DECT with no user input; 
value cannot be CHG’ed.
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MWUN 32 Maximum number of Wireless UNits – entry defaults to 32 
with no user input – value cannot be CHG’ed.

Note: If MWUN = 32, CDEN automatically changes to 8D, 
and prints as an 8D unit.

DMC8 l s c

c

Location of the actual DMC8.
Assigns a TN to a DECT Mobility Card located on an IPE 
shelf or cabinet.

INDX 0. 509 DMC8 index to map the Virtual TN to a DMC8 TN.

Starting index on DMC8, each unit increments to the next 
available unit.

VSIT (NO) YES ViSITing DECT set. Determines the difference between a 
local handset and a visiting handset.
VSIT available if the MSMN Package is unrestricted.
YES = visiting DECT set. NO = local DECT set.

HMDN x...x HoMe Directory Number. Sets the DN as a valid MCDN 
network DN.
NMDN available if VSIT = YES.

LD 10 – Add/Change DCS data block or data blocks. (Part 2 of 2)

Prompt Response Description
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LD 10 – Copy DCS data block or data blocks.

Prompt Response Description

REQ: CPY 1 – 32 CPY n = The generation of new units stop when the 
following occurs:

maximum index of 509 is reached on a single DMC8 or

VTNs on the system run out or 

WRLS ISM limits reached. 

All DCS must be on the same DMC8.

DMC8 l s c
l 

Location of the actual DMC8 to copy on an IPE shelf or 
cabinet.

LD 10 – Remove DCS data block or data blocks.

Prompt Response Description

REQ: OUT 1-255 OUT X = Removing units stops when the maximum index of 
509 is reached on a single DMC8. All new DCS must be on 
the same DMC8.

DMC8 l s c
l

Location of the actual DMC8 to out on an IPE shelf or 
cabinet.
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Note: To convert from concentrated to non-concentrated, OUT all DCS 
units and re-subscribe the handsets.

The CDCS conversion routine prints each TN as it is moved, in the following 
format:

500 TN l s c 00 = DCS TN L S C Index#.
where: L S C = virtual TN 

Index# = default of the unit number of the 500 type set.

LD 10 – Convert handset type 500 to DCS

Prompt Response Description

REQ CDCS Convert Digital Cordless Set – convert from a 
non-concentrated to a concentrated system after software 
upgrade. The conversion routine converts the 500 units to 
DCS units and moves them from the actual TN to a virtual 
TN.

LD 20 – Print actual DMC8 TN and virtual DMC8 TN list.

Prompt Response Description

REQ PRT Request.

TYPE DCS Digital Cordless Set.

TN l s c 

l 

l s c u

c u

Terminal Number for DMC8 card on IPE shelf or Cabinet

Virtual Terminal Number on an IPE shelf or Cabinet

Terminal Number for Large System

Terminal Number for Small System and Succession 1000
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The print routine outputs the following format:

INDX    Index #    VTN lll s cc uu 
where: Index # = Index number of virtual TN.

lll s cc uu = Virtual TN of unit.

The LD 81 output format is as follows:

DCS   Cust#   Local DN   TN lll s cc uu   HMDN   Home 
DN   Last Activity Date.

where: 

• Cust# = Customer Number

• Local DN = Local Directory Number of user

• lll s cc uu = TN of unit

• Home DN = Home directory number of user

• Last Activity Date = Last date of service change activity for user

LD 83 – Prints DCS terminal numbers with a unit type of DCS instead of 500.

LD 81 – Print DCS features. 

Prompt Response Description

REQ LST Request.

FEAT VSIT Feature Request - DECT visitors.

HMDN Xx / <cr> HoMe Directory Number. Specify a single HMDN or print all 
HMDN on system.
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Operating the MSMN feature

To activate the MSMN feature, perform the following steps.

1 Turn the handset on within the coverage range of a visited Companion 
DECT system.

2 Enter the coverage range of a visited Companion DECT system from 
another Companion DECT system with the handset turned on.

To deactivate the MSMN feature, perform the following steps.

1 Turn the handset off within coverage range of the visited Companion 
DECT system. (The handset must have the DECT Detach feature.)

2 Turn the handset on at the home Companion DECT system. (Any CFW 
related to the handset is cancelled.)

3 Enter the coverage range of the home Companion DECT system with the 
handset on. (Any CFW related to the handset is cancelled.)



Page 411 of 612

DECT Description, Planning, Installation, and Operation

536

System administration

Contents
This section contains information on the following topics: 

Windows access to the DECT application  . . . . . . . . . . . . . . . . . . . . . . 412

Web-based browser access to the DECT application . . . . . . . . . . . . . . 415

DECT Systems window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 420

Adding DECT systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 424

Deleting DECT systems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 445

Configuring non-concentrated handsets . . . . . . . . . . . . . . . . . . . . . . . . 447

Configuring concentrated handsets on a PBX. . . . . . . . . . . . . . . . . . . . 456

Retrieving subscription data for handsets . . . . . . . . . . . . . . . . . . . . . . . 467

Enabling subscriptions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 469

Activating the PIN on the handsets . . . . . . . . . . . . . . . . . . . . . . . . . . . . 471

Subscribing the C4010, C4010 Ex, C4020 handsets. . . . . . . . . . . . . . . 472

Subscribing the C4050 handset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 480

Working with handset subscriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . 484

Deleting TNs that are not on the switch . . . . . . . . . . . . . . . . . . . . . . . . 501

Updating data on OTM or updating data on a DECT system . . . . . . . . 502

Provisioning a DECT system remotely. . . . . . . . . . . . . . . . . . . . . . . . . 504

Subscribing a DECT system remotely  . . . . . . . . . . . . . . . . . . . . . . . . . 507

Modifying system properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 510

Keeping or removing non-operational DMC8 cards from OTM  . . . . . 527



Page 412 of 612  System administration

553-3001-370 Standard 1.00 October 2003

Keeping or removing non-operational base stations from OTM . . . . . 528

Resolving a subscription configuration mismatch . . . . . . . . . . . . . . . . 529

User Access security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 531

Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 534

Windows access to the DECT application
For access from a web-based browser, see “Web-based browser access to the 
DECT application” on page 415. 

Logging into the OTM

Figure 238
OTM login dialog box 

Complete the following steps. 

Table 142
Login to the OTM

Step Action

1 Access the OTM Login dialog box.

Click on Start>Programs>OTM.

2 Login.

Enter User ID, Password, and click OK. 

END
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Selecting the PBX that supports DECT

Figure 239
OTM Navigator window

Complete the following step.

Table 143
Selecting the PBX that supports DECT

Step Action

1 Select the system.

Double click on XXX (shown as Sample System in Figure 239). 

END
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Launching the DECT Application

Figure 240
System Window

Complete the following step.

Table 144
Launching the DECT application

Step Action

1 Launch the DECT application.

Double click on DECT, or pull-down File menu and click DECT.

END
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Web-based browser access to the DECT application
For more detailed information on web-based browsers, see Optivity 
Telephony Manager: System Administration (553-3001-330).

MS Internet Explorer and VeriSign Digital Certificates

If using Internet Explorer as a web browser on Windows NT4 Server, 
Windows NT4 Workstation or Windows 9x platforms, it is necessary to 
import the VeriSign Class 3 certification into the client authentication 
repository.

The VeriSign certificates must have the same characteristics, including 
expiration date. The certificates are used to sign the OTM DECT applet. The 
VeriSign certificates must be in the Internet Explorer certificate store so that 
the Java Plug-in 1.2.2 can recognize the OTM DECT certificate.

If the OTM DECT certificate is not recognized, the system generates a Fatal 
navigational error.

Procedure 5
Install VeriSign certificates

1 Using the web browser, follow the steps in Table 145 on page 416 to log 
on to the OTM server.

2 Ensure that the JRE (Java) version is the same (minimum JRE 
1.2.2_006). To do this, at a command prompt on both the client and server 
side, enter 
java -version

3 At the web client PC use the web browser to go to the following URL:
http://server_name/omdect/VeriSignCertificates.
html

4 Click the VeriSign Class 3 certificates link. 
A screen appears, asking if the VeriSignClass3CA.p7b file is to be saved, 
and where to save it.

5 Save that file to the local PC being used. 

6 Right-click on the file. From the pop-up menu that appears, select Install 
Certificate to import the certificate. 

7 An Installation Wizard appears. Click Next until installation is complete.
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8 Connect to the OTM server using the Web Client, and log in. Launch OTM 
DECT for normal access.

Note: This procedure applies only to Internet Explorer web browsers. It 
is not applicable to Netscape.

Opening the Web Administrator Login

Figure 241
Internet Explorer and Netscape Communicator

Complete the following steps.

Table 145
Opening the Administrator Login

Step Action

1 Open a Web browser.

Click on Internet Explorer icon or Netscape Communicator icon.

2 Open the Administrator login screen.

Enter the URL http://<otm_server_name>/admin or use the ip_ address. 

END
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Web Administrator Login

Figure 242
OTM web Administrator Login

Complete the following steps.

Table 146
Opening the OTM web Administrator Login

Step Action

1 Select the Administrator Login.

Click on the applet launch logo.

2 Login.

Enter User Login, Password, and click Submit. 

END
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Opening the Web current Status

Figure 243
OTM web navigator current Status

Complete the following step.

Table 147
Opening the current Status

Step Action

1 Open System Navigator screen.

Click on System Navigator in the Equipment list on the left. 

END
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Opening the web System navigator

The System navigator is selected by clicking on System Navigator in the list 
on the left of the screen shown in Figure 243 on page 418.

Figure 244
OTM web System navigator

Complete the following steps. 

Table 148
Opening the web System navigator

Step Action

1 Select a DECT system.

Highlight a system in the Systems list.

2 Open the DECT systems window.

Click on OTM DECT in the grey box on the left.

END
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DECT Systems window

Figure 245
DECT Systems window
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Opening Subscriptions, Boards, and RFP windows

Connecting to a DECT system

Complete the following steps. 

Table 149
Opening Subscriptions, Boards, and RFP windows

Step Action

1 Select a DECT system.

Highlight a system from the list.

2 Open one of the following from the DECT Systems window:

• Subscriptions window

• Boards (DMC) window

• Radios (base station) window

Click on the appropriate entry in the Applications pull-down menu. 

Table 150
Connecting to a DECT system  (Part 1 of 2)

Step Action

1 Select a DECT system from the DECT Systems window list.

Highlight a DECT system.

END
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Note: While the Connection status is Connecting or Disconnecting, the 
Connect/Disconnect tool is disabled. The status bar shows the 
connection progress.

2 Perform one of the following actions from the DECT Systems window:

1 connect to a DECT system

2 disconnect from a DECT system

3 lock a connection to a DECT system

4 unlock a connection from a DECT system

From the Applications pull-down menu click on the following items, or click on the 
following icon:

1 Connect  or  (green)

2 Disconnect  or  (yellow)

3 Lock  or  (red)

4 Unlock  or  (yellow)

Table 150
Connecting to a DECT system  (Part 2 of 2)

Step Action

END
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Establishing a permanent connection to a DECT system

Figure 246
DECT Systems window and DECT System Properties window
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Complete the following steps. 

Adding DECT systems
Adding a DECT system involves:

1 “Adding new site properties” on page 425

2 “Adding the system on the OTM server” on page 427

3 “Adding properties – General tab” on page 429

4 “Adding a Communications Profile for DECT application” on page 431

5 “Adding the System Data Properties” on page 433

6 “Adding the System Applications Properties” on page 435

7 “Adding the Customer Properties” on page 437

Table 151
Establishing a permanent connection to a DECT system

Step Action

1 Select a DECT system from the DECT Systems window list.

Highlight a DECT system.

2 Connect to a DECT system.

From the Applications pull-down menu, click on Connect or click on the  (green) 
icon.

3 Open the Properties dialog.

From the File pull-down menu, click on Properties.

4 Select Permanent Connection.

Check the Permanent Connection box.

5 Accept the changes.

Click on the OK button.

END
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8 “Adding the Customer0 General Properties” on page 439

9 “Adding the Customer0 Features Properties” on page 441

10 “Adding the Customer0 Numbering Plans Properties” on page 443

Adding new site properties

Figure 247
New Site Properties



Page 426 of 612  System administration

553-3001-370 Standard 1.00 October 2003

Complete the following steps.

Table 152
Adding new site properties

Step Action

1 Open the New Site Properties window.

In the OTM Windows Navigator, choose Add Site from the Configuration menu.

2 The Site Name appears in the Navigator tree. The Short Name is an abbreviated site 
name that displays in the Alarm Banner.

Enter the Site Name and Short Name.

Note:  Bold fields in the dialog sheets indicate required information.

3 In the Site Location box.

Enter the Site Location information.

4 In the Contact Information box.

Enter the contact name and related information, and click Apply.

5 To add a new system to this site.

Click Add System. 

6 When the Site information is entered, click one of the following buttons to add the site 
to the Navigator tree.

OK adds the site and closes the property sheet.

Apply adds the site and leaves the property sheet open allowing another system to be 
added to this site (repeat step 5 to add another system).

Cancel closes the dialog box without adding the site.

END
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Adding the system on the OTM server

As many systems (including non-Nortel Networks systems) as the license 
permits can be added to a site. Administrator privileges are required to add a 
system.

Figure 248
Add System

Complete the following steps.

Table 153
Adding the PBX on the OTM server  (Part 1 of 2)

Step Action

1 In the Navigator window, select the site.

If adding a new system from within the New Site Properties window, go to step 3 in this 
procedure.

2 Open the Add System dialog.

Choose Add System from the Configuration menu or the right mouse button pop-up 
menu.
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3 Program the Add System dialog box.

It might be necessary to install additional software to enable other system types not 
listed here. Follow the installation instructions included with the order.

Select the system type, and then click OK.

Table 153
Adding the PBX on the OTM server  (Part 2 of 2)

Step Action

END
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Adding properties – General tab

Figure 249
New System Properties – General tab
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Complete the following steps.

Table 154
Adding the properties – General

Step Action

1 Select the General tab.

Click the System Properties – General tab.

2 Program the System Name and Short Name (required fields), and other information 
as needed.

Enter the System Name and Short Name.

3 System Location and Contact Information can be the same as site information.

Click the Same as Site checkbox.

4 Accept changes.

Click the OK button.

END
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Adding a Communications Profile for DECT application

Figure 250
Add Communications Profile

Complete the following steps.

Table 155
Adding a new Communications Profile  (Part 1 of 2)

Step Action

1 In the Navigator window, select the Sample Site.

Double click on Sample Site.

2 Choose the Properties dialog.

Click on Properties from the File menu.

3 Open the Add Communications Profile dialog.

Click on the Communications tap and click Add.

4 Select a communications type.
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Highlight Ethernet in the Type box.

Note:  The DECT application does not use the Communications Profile. Unless there is 
another application that requires a specific Communications Profile, choosing Ethernet 
is the least complicated profile to implement.

5 Program the Profile Name.

Enter a Profile Name.

6 Accept the changes.

Click OK.

Table 155
Adding a new Communications Profile  (Part 2 of 2)

Step Action

END
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Adding the System Data Properties

Figure 251
System Properties – System Data tab
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Complete the following steps.

Table 156
Adding the System Data Properties

Step Action

1 Select the System Data tab.

Click the System Properties – System Data tab.

2 Program the Machine Information.

Enter the Machine type and Release version for the system. 

Note:  For example, for a Meridian 1 Option 61C CP PII running Release 25 software, 
enter 61C in the Machine field and use the drop down box to select 25 for Release.

3 Program the System Parameters.

Enter the appropriate values for the system.

4 Program Packages.

Enable or disable M1 packages as appropriate for the system.

5 Note: This data can be copied directly from an installed switch by scheduling an 
upload with the File menu Update System Data command in the System window. 
Update System Data uses the communication profile for Station Administration. 
However, configure the Release number here first to allow available applications to 
appear properly in the Applications Tab.

END
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Adding the System Applications Properties

This tab defines the OTM applications that will appear in the System window 
and the communications profile to be used with each application. An 
application must be enabled for it to be available in the System window.

Figure 252
System Properties – Applications
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Complete the following steps.

Table 157
Adding the System Applications Properties

Step Action

1 Select the system Applications tab.

Click the System Properties – Applications Data tab.

2 To enable an application.

• Select the application in the Applications box.

• Select a Communications Profile from the drop-down list in the Selected 
Application box.

• A checkmark appears next to the application and the Enabled box is also checked.

3 To disable an application.

• Select the application in the Applications box.

• In the Selected Application box, click the Enabled checkbox to remove the 
checkmark.

END
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Adding the Customer Properties

This tab lists the customers currently defined for this system. The following 
action can be performed:

• add new customers

• delete customers

• review the properties of a selected customer

When a new customer is added, configure the features and numbering plans 
that are available to the customer. This information is not automatically 
updated. It must be updated by using LD 15 Customer Data Block.

Note: Customer information is required for System Administration/
CPND and ESN applications.

Figure 253
System Properties – Customers
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Complete the following steps.

Table 158
Adding the customer properties

Step Action

1 Select the system Customers tab.

Click the System Properties – Customers Data tab.

2 Select a customer number.

Click OK.

3 Update the PBX.

Use LD 15 Customer Data Block.

END
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Adding the Customer0 General Properties

Figure 254
Customer0 Properties – General



Page 440 of 612  System administration

553-3001-370 Standard 1.00 October 2003

Complete the following steps.

Table 159
Adding the Customer0 General Properties

Step Action

1 Select the General tab.

Click the General tab.

2 Program the Customer Name and Number.

Enter the Customer Name and Number.

3 Program the Home Location Code.

Enter the HOLC as defined in LD 90.

4 Program the Scheduler System ID, if using applications with scheduled activities, 
such as Station Administration/CPND, ESN, and Traffic.

5 Accept changes.

Click Apply.

END
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Adding the Customer0 Features Properties

Figure 255
Customer 0 Properties – Features
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Complete the following steps.

Table 160
Adding the Customer0 Features Properties

Step Action

1 Select the Features tab.

Click the Features tab.

2 Program Features Group.

3 Accept changes.

Click Apply.

END
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Adding the Customer0 Numbering Plans Properties

Figure 256
Customer Properties – Numbering Plans
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Complete the following steps.

Note: At this point the DECT application is installed in the OTM server.

Table 161
Adding the Customer0 Numbering Plans Properties

Step Action

1 Select the Numbering Plans tab.

Click the Numbering Plans tab.

2 Program the customer information appropriate for the PBX.

3 Accept changes.

Click one of the following buttons to save the information:

• OK adds the customer and returns to the System properties sheet.

• Apply adds the customer and leaves the Customer properties open so that other 
information can be added for this customer.

• Cancel closes the dialog box without adding the customer.

END
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Deleting DECT systems

Figure 257
DECT Systems window

Complete the following steps.

Table 162
Deleting DECT systems  (Part 1 of 2)

Step Action

1 Using Windows, login to OTM. Select the system that supports DECT. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports DECT. Launch the DECT 
application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.
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3 Select a DECT system to delete.

Highlight a DECT system from the list.

4 Delete the DECT system.

From the File pull-down menu, click on Delete.

Table 162
Deleting DECT systems  (Part 2 of 2)

Step Action

END
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Configuring non-concentrated handsets
For information about System Administration, see Option 11C Customer 
Controlled Backup and Restore (CCBR) (553-3011-330).

Configuring non-concentrated handsets involves:

1 “Accessing the Add Station window” on page 449

2 “Adding 500 analog standard” on page 450

3 “Accessing features” on page 451

4 “Accessing wireless type” on page 452

5 “Selecting wireless type” on page 453

6 “Selecting DECT wireless set” on page 454

7 “Accepting changes” on page 455
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Opening Station Administration window

Figure 258
M1 System Window

Complete the following step.

Table 163
Opening the Station Administration window 

Step Action

1 Open the Station Administration window.

Click on Station Administration in the M 1 System Window.

END
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Accessing the Add Station window

Figure 259
Station Administration window

Complete the following steps. 

Table 164
Accessing Add Station window

Step Action

1 Access Add Station window.

From the Edit pull-down menu, click on Add.

END
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Adding 500 analog standard

Figure 260
Add Station window

Complete the following step.

Table 165
Adding 500 analog standard

Step Action

1 Add 500 analog standard.

Highlight 500 Analog Standard, and click on the OK button.

END
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Accessing features

Figure 261
500 dialog

Complete the following step.

Table 166
Accessing features

Step Action

1 Access features.

Click on the Features button.

END
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Accessing wireless type

Figure 262
Features window

Complete the following step.

Table 167
Accessing wireless type

Step Action

1 Access wireless type.

Highlight Wireless Type, and click on the Select button.

END
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Selecting wireless type

Figure 263
Wireless window

Complete the following step.

Table 168
Selecting wireless type

Step Action

1 Select wireless type.

From the Wireless Type (WTYP) pull-down menu, click on YES.

END
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Selecting DECT wireless set

Figure 264
Wireless window

Complete the following step.

Table 169
Selecting DECT wireless set

Step Action

1 Select DECT handset.

From the Wireless Type (WTYP) pull-down menu, click on DECT Wireless Set, and 
click on the OK button.

END
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Accepting changes

Figure 265
Features window

Complete the following step.

Table 170
Accepting changes

Step Action

1 Accept changes.

Click on the Done button.

END
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Configuring concentrated handsets on a PBX
Configuring non-concentrated handsets involves:

1 “Opening the Station Administration window” on page 457

2 “Accessing the Add Station window” on page 458

3 “Selecting Digital Cordless Set” on page 459

4 “Selecting features” on page 460

5 “Selecting wireless type” on page 461

6 “Selecting Visit DECT Set or local calling” on page 462

7 “Selecting an index” on page 463

8 “Provisioning the hardware” on page 464

9 “Accepting changes” on page 465

10 “Single line features” on page 466

11 “Opening the Station Administration window” on page 457

12 “Opening the Station Administration window” on page 457
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Opening the Station Administration window

Figure 266
M1 System Window

Complete the following step.

Table 171
Opening the Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the System Window.

END
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Accessing the Add Station window

Figure 267
Station Administration window

Complete the following step.

Table 172
Accessing Add Station window

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.

END
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Selecting Digital Cordless Set

Figure 268
Add Station dialog

Complete the following step.

Table 173
Selecting Digital Cordless Set

Step Action

1 Select Digital Cordless Set.

Highlight DCS, and click on the OK button.

END
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Selecting features

Figure 269
DCS window

Complete the following step.

Table 174
Selecting features

Step Action

1 Select features.

Click on the Features button.

END
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Selecting wireless type

Figure 270
Features window

Complete the following step.

Table 175
Selecting wireless type

Step Action

1 Select wireless type.

Highlight WTYP, and click the Select button.

END
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Selecting Visit DECT Set or local calling

Figure 271
Wireless Visiting DECT Set

Complete the following steps.

Table 176
Selecting Visit or local 

Step Action

1 Select Visit DECT Set as Yes if this handset is visiting this PBX. Select No if this 
handset is to be configured for local calling only.

If Visiting DECT Set is Yes, go to step 2. If the handset is configured for local calling 
only, go to step 4.

2 Select visiting

From the Visiting DECT Set (VSIT) list, select Yes.

3 Select a Home DN.

Enter a DN in the Home Directory Number (HMDN) box.

4 Configure for local calling only. 

From the Visiting DECT Set (VSIT) list, select No.

5 Accept changes.

Click on the OK button.
END
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Selecting an index

Figure 272
Features window

Complete the following step.

Table 177
Selecting an index

Step Action

1 Select an index.

Highlight INDX, and click on the Select button.

END
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Provisioning the hardware

Figure 273
Hardware Provisioning window

Complete the following steps.

Table 178
Provisioning hardware

Step Action

1 Select a DMC TN.

Enter a TN in the DECT Mobility Controller (DMC) box.

2 Select an index.

Enter an index in the Index on DMC (INDX) box. 
(Index range is 0 to 509.)

Note:  The Terminal Number (TN) is a virtual TN and selected by the PBX system.

Note:  Index 0-509 on PBX is seen as Index 1-510 in OTM.

3 Accept changes.

Click on the OK button.

END
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Accepting changes

Figure 274
Features window

Complete the following step.

Table 179
Accepting changes

Step Action

1 Accept changes.

Click on the Done button.

END
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Single line features

Figure 275
500 window

Complete the following step.

Table 180
Single Line Features

Step Action

1 For information on other Single Line Features.

Refer to the OTM Station Administration in Optivity Telephony Manager: System 
Administration (553-3001-330).

END
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Retrieving subscription data for handsets

Figure 276
DECT Subscriptions window, Synchronize DECT and Administration Config window
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Complete the following steps.

Table 181
Retrieving subscription data for handsets

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the Subscriptions window.

Follow the instructions on page 420.

4 Retrieve the subscription configuration data from the OTM Station Administration 
database.

In the Subscriptions window, click on the Operations pull-down menu, click on 
Retrieve OTM Configuration.

5 Note:  At this point, all handsets configured on OTM Station Administration are shown 
in the Subscriptions window.

Open the Configure DECT Subscription dialog.

Click the File pull-down menu. Click Add or .

END



 System administration  Page 469 of 612

DECT Description, Planning, Installation, and Operation

Enabling subscriptions

Figure 277
Subscriptions window
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Complete the following steps for each handset:

Table 182
Enabling handsets

Step Action

1 Note:  At this point, there are no PINs shown in the Subscriptions window.

Select a handset from the list.

Click on one handset in the list to highlight a row.

2 Enable handsets.

Click on the Operations pull-down menu. Click Enable or click on .

END
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Activating the PIN on the handsets

Figure 278
Subscriptions window

Complete the following step:

Note: When a handset is subscribed, the Subscription window shows the 
Status column as Subscribed and does not show a PIN.

Table 183
Obtaining the PIN

Step Action

1 Note:  At this point, in the Subscriptions window, the PINs are shown and the Status is 
Enabled.

Subscribe the C4010, C4010Ex, C4040, and C4050 handsets.

See “Subscribing the C4010, C4010 Ex, C4020 handsets” on page 472,and 
“Subscribing the C4050 handset” on page 480.

PIN

END
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Subscribing the C4010, C4010 Ex, C4020 handsets
Subscribing the C4010, C4010Ex and C4020 handsets involves:

1 “Distributing handsets and installing battery chargers” on page 473

2 “Subscribing handsets” on page 476

Figure 279
C4010 handset and C4010 Ex handset



 System administration  Page 473 of 612

DECT Description, Planning, Installation, and Operation

Distributing handsets and installing battery chargers

Consult the work order for a list of handset users and their locations.

Figure 280
Battery details, charger details, and connections

DANGER — Serious Injury

Never charge a C4010Ex battery in an explosive 
atmosphere.
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Complete the following steps.

Table 184
Installing battery charger and charge batteries  (Part 1 of 2)

Step Action

1 Take the  handset package to the user location.

2 Unpack the  handset and its accessories, as applicable.

3 Insert the handset battery pack, as applicable.

Note:  Use only the approved battery for the C4010 Ex handset.

4 Unpack the  handset battery charger and its accessories.

5 Mount the battery charger.

Place the charger on the desk, or mount the charger on the wall, as applicable.

Note:  Never mount a battery charger in an explosive atmosphere.

6 Install the mounting screws. Use screws with a maximum diameter of 
4 mm.

Turn the two screws into the wall at a distance of 45 mm from each other. Make sure 
that the screw heads protrude by 2.5 to 3 mm. 

7 Hang the charger on the screws.
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8 Install the power supply.

Plug the power supply cable into the connector located on the side of the charger, then 
plug the ac adapter into the 230 V ac mains socket. 

9 Place the handset into the charger.

Note:  The battery icon appears on the handset display screen indicating the battery is 
charging, whether the battery is installed or not.

CAUTION — Service Interruption

Charge the C4010, C4010 Ex, and C4020 battery at least 
12 hours before using the handset for the first time. This 
will ensure maximum battery life.

Table 184
Installing battery charger and charge batteries  (Part 2 of 2)

Step Action

END
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Subscribing handsets

Consult the work order for a list of subscription names.

Complete the following steps.

Table 185
Subscribing C4010, C4010 Ex, C4020 handsets 

Step Action

1 Select Language.

2 Select Declare base.

Press the Declare base  key.

3 Declare base number? 12345678.

Press the Ok  key.

4 Enter code refers to the PIN code.

Note:  The Subscriptions screen displays the PIN. The PIN is only valid for 16 minutes.

Enter the PIN.

To delete the last digit that was entered, press Erase, or select the digit and enter a 
new digit.

Press the Ok  key.

END
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Table 186
Entering handset name and DN identity 

Step Action

1 Select Menu.

Press the Menu  key.

2 Select Handset name.

Dial 86.

3 Enter the Handset name and/or the handset DN to identify the handset.

To enter a character, press keys 0 to 9 as shown in Table 187 on page 478. For 
example, to enter E press the 3 key twice. To move to the next character, pause three 
seconds. To delete a character, press Erase, or select the digit and enter a new digit.

Note:  Handset DNs are programed in LD 10, not in the DECT database.

4 Confirm the name and DN.

Press Ok.

END
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Use the Southern handset keypad alphabet equivalent listed in Table 187 for 
the following languages:

• English

• French

• German

• Dutch

• Spanish

• Italian 

Table 187
Southern handset key pad alphabet equivalent 

Key 1 2 3 4 5 6 7 8 9

0 0

1 – / space 1 , . : ,

2 A B C 2 Á À Ä ß

3 D E F 3 É È

4 G H I 4 í ì

5 J K L 5

6 M N O 6 Ñ Ö Ó Ô

7 P Q R S 7

8 T U V 8 Ü Ú

9 W X Y Z 9
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Use the Northern handset key pad alphabet equivalent listed in Table 188 for 
the following languages:

• English

• Portuguese

• Swedish

• Norwegian

• Finnish

• Danish

Table 188
Northern handset key pad alphabet equivalent 

Key 1 2 3 4 5 6 7 8 9

0 0

1 – / space 1 , . : ,

2 A B C 2 Å Ä Ã Á Æ

3 D E F 3 Ê

4 G H I 4

5 J K L 5

6 M N O 6 Ö Ó Ô

7 P Q R S 7

8 T U V 8 Ú

9 W X Y Z 9
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Subscribing the C4050 handset
Subscribing the C4010, C4010Ex and C4020 handsets involves:

1 “Distributing handsets and installing battery chargers” on page 481

2 “Subscribing handsets” on page 482

Figure 281
C4050 handset

553-A0079
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Distributing handsets and installing battery chargers

Consult the work order for a list of handset users and their locations.

Figure 282
Battery details, charger details, and connections

Complete the following steps.  

Table 189
Installing battery charger and charge batteries  (Part 1 of 2)

Step Action

1 Take the handset package to the user location.

2 Unpack the handset and its accessories, as applicable.

3 Insert the handset battery pack, as applicable.

Note:  Use only the approved battery for the C4050 handset.

4 Unpack the handset battery charger and its accessories.

5 Mount the battery charger.

553-A0080
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Subscribing handsets 

Consult the work order for a list of subscription names.

Complete the following steps.

Place the charger on the desk.

6 Install the power supply.

Plug the power supply cable into the connector located on the side of the charger, then 
plug the ac adapter into the 230 V ac mains socket. 

7 Place the handset into the charger.

Note:  The LED ring on the handset is green when the batteries are charging.

CAUTION — Service Interruption

Charge the C4050 battery at least eight hours before 
using the handset for the first time. This will ensure 
maximum battery life.

Table 190
Subscribing C4050 handsets (Part 1 of 2)

Step Action

1 Select Menu. 

Table 189
Installing battery charger and charge batteries  (Part 2 of 2)

Step Action

END
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Press Menu. 

2 Select System.

Scroll to System. Press OK. 

3 Select Subscription. 

Press OK. 

4 Select Options. 

Scroll to New. Press OK. 

5 Enter PARK if two DECT systems overlap. 

Press OK. 

6 Enter the PIN code.

Note:  The Subscriptions window displays the PIN. The PIN is only valid for 15 minutes.

Enter the PIN code.

7 Enter the system name.

8 Enter the handset DN.

9 Enter the handset users name.

Table 190
Subscribing C4050 handsets (Part 2 of 2)

Step Action

END
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Note: Complete the “System programming record” on page 238 and the 
“Provisioning information record” on page 235.

Working with handset subscriptions
Procedures are available for:

1 “Disabling a handset subscription” on page 485

2 “Copying a handset subscription” on page 487

3 “Moving a handset subscription” on page 490

4 “Finding a handset subscription” on page 493

5 “Importing a handset subscription” on page 495

Table 191
Handset key pad alphabet equivalent

Key 1 2 3 4 5 6 7 8 9 10 11

0 0 space @ $ &

1 1 ? ! , . : ; “ ‘

2 A B C 2 Ä Å À Á Ã Æ ç

3 D E F 3 È É Ê Ë

4 G H I 4 ì í Î Ï

5 J K L 5

6 M N O 6 Ñ Ö Ò Ó Ô Õ Ø

7 P Q R S 7 ß

8 T U V 8 Ü Ù Ú Û

9 W X Y Z 9

* * - + = ~ < > ^ %

# # ( ) { } [ ] / \ _
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6 “Exporting a handset subscription” on page 497

7 “Force disabling a handset subscription” on page 499

Disabling a handset subscription

Figure 283
DECT Subscriptions window and Disable DECT Subscription window

Note: For further information, refer to “Delete subscriptions, page 92” 
and “Multi-site Mobility Networking, page 116.”
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Complete the following steps.

Table 192
Disabling handset subscription

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the Subscriptions window.

Follow the instructions on page 420.

4 Select a handset subscription(s) for disabling.

Note:  A single handset, a list of handsets, or all handsets on a DMC can be selected.

Highlight a DMC TN and an Index, or several indexs in the list.

5 Disable the handset subscription(s).

From the Operations pull-down menu, click Disable.

6 Disable from this system only.

Click OK.

7 Disable from all systems where the portable set is subscribed.

Click OK.

END
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Copying a handset subscription

Figure 284
DECT Subscriptions window and DECT Copy Subscription window

Note: For further information, refer to “Copy subscriptions, page 89.”
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Complete the following steps.

Table 193
Copying a handset subscription (Part 1 of 2)

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Select the source DECT system to copy the subscription.

Highlight the DECT system in the DECT Systems window.

4 Open the Subscriptions window.

Follow the instructions on page 420.

5 Open the DECT Copy Subscription dialog.

From the Edit pull-down menu, click on Copy.

6 Select a DECT system where the copied subscription will be put.

Pull-down the Destination DECT System list and highlight a system name.

7 Select DMC on the DECT system where the copied subscription will be put.

Pull-down the Destination DMC list and highlight a DMC.

8 Select a handset subscription(s) to copy.

Note:  Select a single handset, a list of handsets, or all handsets on a DMC.

Highlight a DMC TN and an Index (or more than one index) in the list.
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9 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index (or more than one index) in the list.

10 Accept the changes.

Click on the OK button.

Table 193
Copying a handset subscription (Part 2 of 2)

Step Action

END
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Moving a handset subscription

Figure 285
DECT Subscriptions window and DECT Move Subscription window 

Note: For further information, refer to “Move subscriptions, page 91.”

Move

Move
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Complete the following steps. 

Table 194
Moving a handset subscription (Part 1 of 2)

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the Subscriptions window.

Follow the instructions on page 420.

4 Open the DECT Move Subscription dialog.

From the Edit pull-down menu, click on Move.

5 Select a DECT system where the moved subscription is to be put.

Pull-down the Destination DECT System list and highlight a system name.

6 Select DMC on the DECT system where the moved subscription is to be put.

Pull-down the Destination DMC list and highlight a DMC.

7 Select DMC on the DECT system the moved subscription is to be put.

Pull-down the Destination DMC list and highlight a DMC.

8 Select a handset subscription(s) to move.

Note:  Select a single handset, a list of handsets, or all handsets on a DMC.

Highlight a DMC TN and an Index (or more than one index) in the list.
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9 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index (or more than one index) in the list.

10 Accept the changes.

Click OK.

Table 194
Moving a handset subscription (Part 2 of 2)

Step Action

END
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Finding a handset subscription

Figure 286
DECT Subscriptions window and Find DECT Subscription window 

Note: For further information, refer to “Find subscriptions, page 94.”
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Complete the following steps. 

Table 195
Finding a handset subscription

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the Subscriptions window.

Follow the instructions on page 420.

4 Open the Find DECT Subscription dialog.

From the Edit pull-down menu, click on Find.

5 Select find criteria.

Click on Find IPUI or Find Home DN, enter the value, and click on the Find button.

6 View the results.

END
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Importing a handset subscription

Figure 287
DECT Subscriptions window and DECT Import Subscription window

Note: For further information, refer to “Import subscriptions, page 91.” 
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Complete the following steps.

Table 196
Importing a handset subscription

Step Action

1 Access the DECT Application.

Follow the instructions in “Windows access to the DECT application” on page 412.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the Subscriptions window.

Follow the instructions on page 420.

4 Open the DECT Import Subscription dialog.

From the File pull-down menu, click on Import.

5 Select a DECT system where the imported subscription is to be put.

Pull-down the Destination DMC list and highlight a DMC.

6 Select DMC to be imported.

Pull-down the Destination DMC list and highlight a DMC.

7 Select a handset subscription(s) to import.

Note:  Select a single handset, a list of handsets, or all handsets on a DMC.

Highlight a DMC TN and an Index, or several indexs in the list.

8 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index, or several To: indexs in the list.

9 Accept the changes.

Click OK.

END
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Exporting a handset subscription

Figure 288
DECT Subscriptions window and Export Subscription window

Note: For further information, refer to “Export subscriptions, page 93.” 
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Complete the following steps.

Table 197
Exporting a handset subscription

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the Subscriptions window.

Follow the instructions on page 420.

4 Open the Export DECT Subscription dialog.

From the Find pull-down menu, click on Export.

5 Select a handset subscription(s) to export.

Note:  A single handset, a list of handsets, or all handsets on a DMC can be selected.

Highlight a DMC TN and an Index, or several indexs in the list.

6 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index, or several To: indexes in the list.

7 Accept the changes.

Click on the OK button.

8 Paste the subscriptions into a file.

.

END
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Force disabling a handset subscription

Figure 289
DECT Subscriptions window and Force disable DECT Subscription window

Note: For more information, refer to Force disable subscriptions, page 
95. 
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Complete the following steps.

Table 198
Force disabling a handset subscription

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the Subscriptions window.

Follow the instructions on page 420.

4 Open the Force Disable DECT Subscription dialog.

From the Operations pull-down menu, click on Force Disable.

5 Select a handset subscription(s) for Force Disabling.

Note:  Select a single handset, a list of handsets, or all handsets on a DMC.

Highlight a DMC TN and an Index (or more than one index) in the list.

6 Disable the handset subscription(s).

From the Operations pull-down menu, click on Force Disable.

7 Disable from this system only.

Click on OK button.

8 Disable from all systems where the portable set is subscribed.

Click OK.

END
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Deleting TNs that are not on the switch
To remove configured sets (TRN status) that are no longer on the switch, 
perform the following steps

Table 199
Removing configured sets

Note: Perform this procedure after 500 analog TNs have been converted 
to concentrated TNs.

Step Action

1 Using Windows, log in to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Use a web-based navigator to open the Administrator login screen and log in. Select 
the System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the Subscriptions window.

Follow the instructions on page 420.

4 Open the DECT Move Subscription dialog.

From the Edit pull-down menu, click Global update.

5 Select the sync status SSTAT.

Set Old value to the current status. Set New value to NEW.

6 Delete the TN’s from the switch. 

END



Page 502 of 612  System administration

553-3001-370 Standard 1.00 October 2003

Updating data on OTM or updating data on a DECT system

Figure 290
Mismatch dialogs
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When the DECT manager connects to a DECT system, synchronization flags 
any differences between the DECT manager database and the DECT system 
database with mismatch dialogs. These dialogs are useful when provisioning 
DECT systems off-site. 

See “Provisioning a DECT system remotely” on page 504, and “Subscribing 
a DECT system remotely” on page 507.

Complete the following steps.

Table 200
Updating data on OTM

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Select a DECT system.

Highlight a DECT system from the list.

4 Connect to a DECT system.

From the Applications pull-down menu, click on Connect or click on the  (green) 
icon.

5 If any of the dialogs in Figure 291 on page 504 appear, it is necessary to decide to 
update either the DECT manager or the DECT system.

Click on either the Update DECT Manager button, or Update DECT System button.

END
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Provisioning a DECT system remotely
A distributor can use a DECT system in the distributor’s premises lab to 
configure a system and subscribe sets on it. If the DECT Access System and 
board configuration are the same on both the distributor’s and the customer’s 
DECT systems, and if the handsets are properly programmed on the 
customer-PBX-side, then the DMCs can be placed in the customer’s system 
and the handsets will function properly.

Remote DMC8 provisioning where the customer site
has a DECT manager

Figure 291
Remote DMC8 provision where the customer site has a DECT manager
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Complete the following step.

Table 201
Provisioning remotely – the customer site has a DECT manager

Step Action

1 Remotely provision DMC8s for a customer site.

Follow the steps 1 to 6a/6b shown in Figure 291 on page 504.

END
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Remote DMC8 provisioning where the customer site
does not have a DECT manager

Figure 292
Remote DMC8 provision where customer site does not have a DECT manager
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Complete the following step.

Subscribing a DECT system remotely
A handset can subscribe itself to any DECT system, regardless of the DECT 
system Primary Access Rights Identifier (PARI) and Secondary Access 
Rights Identifier (SARI). In other words, from the handset itself, the handset 
can be subscribed to a DECT system where the handset is not necessarily 
intended to be operational. The customer may or may not have a DECT 
manager on site. 

Table 202
Provisioning remotely – the customer site does not have a DECT manager

Step Action

1 Remotely provision a customer site.

Follow steps 1 to 6 shown in Figure 292 on page 506.

END
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Remote handset subscription where the customer site
has a DECT manager

Figure 293
Remote handset subscription where the customer site has a DECT manager 

Complete the following step. 

Table 203
Updating IP address on OTM
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Remote handset subscription where the customer site
does not have a DECT manager

Figure 294
Remote handset subscription where customer site does not have a DECT manager

Complete the following step.

Table 204
Updating IP address on OTM

Step Action
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Modifying system properties
Several system properties can be modified. Procedures are included for:

1 “Changing passwords” on page 511

2 “Changing the DECT system name” on page 513

3 “Changing the IP address on OTM DECT manager” on page 515

4 “Changing the IP address on the DECT system DMC8 Relay card” on 
page 517

5 “Changing a PARI or SARI” on page 519

6 “Changing the Upstream Manager IP address” on page 521

7 “Changing the time and date” on page 523

8 “Changing parameters” on page 525
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Changing passwords

Figure 295
DECT Systems window and Change DECT Password

Note: For lost passwords, see Recovering a password, page 585.
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Complete the following steps.

Table 205
Changing passwords

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the General tab.

4 Select Change Password.

Click on the Change Password button.

5 Change the password.

Enter the Old Password, enter the New Password, confirm the New Password, and 
click OK.

END



 System administration  Page 513 of 612

DECT Description, Planning, Installation, and Operation

Changing the DECT system name

Figure 296
DECT Systems window and DECT System Properties – General tab
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Complete the following steps.

Table 206
Changing the DECT system name

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the General tab.

4 Change the DECT system name.

Enter the new name in the DECT System Name box.

END
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Changing the IP address on OTM DECT manager

Before changing the IP address on the OTM DECT manager, close the 
connection. After the change on the DECT system, open the connection as a 
safety check.

Figure 297
DECT Systems window and DECT System Properties – Communication tab
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Complete the following steps.

Table 207
Changing the IP address on the DECT system

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the Communication 
tab.

4 Select Ethernet.

Click on the Ethernet radio button.

5 Accept the changes.

Click OK.

END
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Changing the IP address on the DECT system DMC8
Relay card

Before changing the DMC8 Relay card’s IP address through Telnet, close the 
connection. After the change on the DECT system, open the connection as a 
safety check.

Figure 298
Telnet 192.168.1.1
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Complete the following steps.

Table 208
Changing the IP address on DECT system DMC8 Relay card

Step Action

1 Open the Telnet dialog.

Click on Start>Accessories>Telnet.

2 Enter user name and password.

Type user name dasuser and password dasuser.

3 When the connection prompt local appears, change the DMC8 Relay card address.

Enter the following command: 

ipconfig xxx.xxx.xxx.xxx yyy.yyy.yyy.yyy zzz.zzz.zzz.zzz

xxx.xxx.xxx.xxx = new IP address of the DMC8 Relay card.

yyy.yyy.yyy.yyy = subnet mask, usually 255.255.255.0

zzz.zzz.zzz.zzz = IP address if this is the gateway for the network.

Note:  Set zzz.zzz.zzz.zzz to the IP address of the OTM server Ethernet interface. If 
there are two Ethernet interfaces on the OTM server, set zzz.zzz.zzz.zzz to the IP 
address of the interface, which is on the same network as the DMC8 Relay card.

END
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Changing a PARI or SARI

Note: When the PARI or SARI changes, the DECT system resets and 
the connection closes. If the connection is permanent, the OTM manager 
attempts to open in the background.

Figure 299
DECT Systems window and DECT System Properties – Access tab
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Complete the following steps.

Table 209
Changing a PARI or SARI

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the Access Right 
Identification tab.

4 Change the PARI or SARI.

Enter the PARI or SARI.

5 Accept the changes.

Click on the OK button. 

END
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Changing the Upstream Manager IP address

Note: An upstream manager IP address can only be programmed on the 
DMC8 Relay card.

Figure 300
DECT Systems window and DECT System Properties – Alarm tab
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Complete the following steps.

Table 210
Changing the Upstream Manager IP address

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties. Click the Alarm tab.

4 Change the Upstream Manager IP address.

Enter the Upstream Manager IP address.

5 Accept the changes.

Click on the OK button. 

END
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Changing the time and date

The time and date is used to time stamp the alarms.

Note: The time and date must be changed when the DECT system 
reboots or a DMC resets. 

Figure 301
DECT Systems window and DECT System Properties – Alarm tab
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Complete the following steps.

Table 211
Changing time and date

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on, page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Connect to a DECT system.

From the Applications pull-down menu click on Connect or  (green).

4 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties. Click the Alarm tab.

5 Change the time and date.

Enter the Date and Time.

6 Accept the changes.

Click the OK button. 

END
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Changing parameters

Figure 302
DECT Systems window and DECT System Properties – Parameters tab
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Complete the following steps.

Table 212
Changing parameters

Step Action

1 Using Windows, log in to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on, page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the DECT System Properties dialog.

From the File pull-down menu, click on Properties. Click the Parameters tab.

4 Change the parameters.

From the appropriate pull-down menus, highlight the parameter time/level.

5 Accept the changes.

Click the OK button. 

END
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Keeping or removing non-operational DMC8 cards 
from OTM

Note: Figure 303 on page 527 only appears when a connection is 
established and there is a mismatch. If there is a permanent connection 
and the DECT system configuration changes, the OTM DECT manager 
is updated automatically. The change is noted in the OTM event log.

Figure 303
Synchronize DECT Board Configuration window

Complete the following steps.

Table 213
Keeping or removing non-operational DMC8 cards from OTM

Step Action

1 To keep DMC8 cards,

Delete the check mark from the appropriate box.

2 To remove DMC8 cards,

Put a check mark in the appropriate box.

3 Accept the changes.

Click the OK button. 

END
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Keeping or removing non-operational base stations
from OTM

Note: Figure 304 only appears when a connection is established and 
there is a mismatch. If there is a permanent connection and the DECT 
system configuration changes, the OTM DECT manager is updated 
automatically and the change is noted in the OTM event log.

Figure 304
Synchronize DECT Radio Fixed Part Configuration window

Complete the following steps.

Table 214
Keeping or removing non-operational base stations from OTM 

Step Action

1 To keep base stations,

Delete the check mark from the appropriate box.

2 To remove base stations,

Put a check mark in the appropriate box.

3 Accept the changes.

Click the OK button. 

END
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Resolving a subscription configuration mismatch
Note: Figure 305 appears when subscriptions are enabled with the 
Subscriptions window Operation pull-down menu and clicking on 
Configure.

Figure 305
DECT Subscriptions Configuration Mismatch window, and DMC window
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Complete the following steps.

Table 215
Selecting login options

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 414.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the system that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419.

3 Open the DMC window.

Follow the instructions on, page 420.

4 Store DMC changes from the DECT system in the OTM server,

In the Synchronization pull-down menu, click on Synchronize From.

5 Make OTM server changes to the DMCs in the DECT system, 

In the Synchronization pull-down menu, click on Synchronize To.

END
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User Access security
Security can be accessed either through a web-based navigator or through 
Windows. 

Web-based navigator Access security

Group access to DECT OA&M features or handset subscriptions can be 
allowed or denied with the Web Access security window.

Figure 306
OTM Web Access security
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Complete the following steps.

Table 216
Accessing security – web-based navigator

Step Action

1 Using Windows, login to OTM. Select the system that supports DECT. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 415 to page 419. 

2 Select Web Navigator Access.

Click on Web Navigator Access. 

3 Follow the on-screen instructions. 

A check in the Allow Access column boxes permits access for the selected users 
group. No check in the boxes denies access to the selected users group.

END
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Windows Access security

Allow or deny Group access to DECT OA&M features with the Windows 
Administration – Template Properties dialog.

Figure 307
OTM Navigator, OTM Users, and Template Properties
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Complete the following steps.

Troubleshooting
This section provides information to help solve common problems.

Disconnecting

The passwords on a DMC8 Relay card and a system on the OTM DECT must 
match.

Table 217
Accessing security – Windows

Step Action

1 Using Windows, login to OTM to open the OTM Navigator window. 

See “Logging into the OTM” on page 412. 

2 Open the OTM Users window. 

From the Security pull-down menu, click on OTM Users. 

3 Open the Template Properties. 

From the Configuration pull-down menu, click on User Templates. 

4 Select the appropriate access level for the user group. 

Click the left mouse button on the icon to change the access, as follows: 

 – Read and write access 

 – Read only access* 

 – No access 

Note:  * Choosing read only access allows read and write access.

END
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The default password for both a DMC8 Relay card and an OTM DECT 
system is Arsenal.

If the password on a DMC8 Relay card is not the same as the OTM DECT 
password, OTM will not be able to connect to the relay card. If the DMC8 
Relay card is rebooted, the mismatched password will be accepted for only 
five minutes. Then the card will disconnect again.

To solve the problem, ensure the password on the system in OTM DECT and 
the password on the DMC8 Relay card are the same. 

It is recommended that the passwords be reset to the default Arsenal.

To change the OTM DECT password, see “Changing passwords” on 
page 511.

Note: Select the option “Do not change password on the DECT system”.

To change the password on the DMC8 relay card, see “Recovering a 
password” on page 585.

Note: Do not select the option “Do not change password on the DECT 
system.”

Unable to connect with Web Client

If unable to connect to OTM DECT with Internet Explorer, see “MS Internet 
Explorer and VeriSign Digital Certificates” on page 415, for more 
information.
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588

System maintenance

Contents
This section contains information on the following topics:

Alarm Code maintenance actions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 537

LED status for DMC8/DMC8-E and base station. . . . . . . . . . . . . . . . . 550

Removing and inserting a DMC8 for maintenance. . . . . . . . . . . . . . . . 553

Adding a DMC8 card to a DECT system . . . . . . . . . . . . . . . . . . . . . . . 561

Removing and re-installing a base station for maintenance . . . . . . . . . 564

Uploading and activating firmware. . . . . . . . . . . . . . . . . . . . . . . . . . . . 569

Recovering from a firmware upload failure . . . . . . . . . . . . . . . . . . . . . 570

Retrieving current RSSI data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 573

Performance Collection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 576

Setting parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 584

Recovering a password . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 585

Alarm Code maintenance actions
Alarm Codes can be viewed with one of the following:

• “Windows Alarm Snapshot” on page 538

• “Web Alarm browser” on page 546 

• “Windows Alarm Notification” on page 548 
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Windows Alarm Snapshot 

Figure 308
Alarm Snapshot window and Alarm Properties window

Note: The Alarm Snapshot window is a static display. The Alarm 
Snapshot window only shows the alarms present at the time the window 
was opened. The window must be refreshed for an up-to-date display. 
The web-based alarm browser displays alarm history and occurring 
alarms.
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Complete the following steps.

Note: The Windows Alarm Notification browser (page 548) only 
displays alarms that have occurred since the window was opened. The 
Web Alarm browser (page 546) has a circular log that provides 
information on a limited history of alarms. The Web Alarm browser 
records alarms at all times. 

 

Table 218
Alarm Code maintenance actions

Step Action

1 Using Windows, and login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window. Open the Current 
Alarms window.

Follow the instructions on page 412 to page 421.

2 Refresh the Alarm Snapshot window.

Click on the  icon.

3 Examine the alarm code, and take the appropriate maintenance action.

See Table 220 on page 547.

END
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Table 219
Alarms  (Part 1 of 6)

Alarm
code

Alarm description Maintenance action

DMC8 operational state Synthesis

DCT001 All DMC8 cards are operational.
(DCT001 only displayed in the 
Alarm browsers. DCT001 does not 
show in the Alarm Snapshot list.)

Information only, no action needed.

DCT002 At least one DMC8 card is not    
operational.
(DCT002 only displayed in the 
Alarm browsers. DCT002 does not 
show in the Alarm Snapshot list.)

Remove the DMC8 and insert the DMC8 
again to reboot. If the reboot fails, replace 
the DMC8.

Note:  When at least one DMC8 card becomes inoperable, DCT002 appears in the alarm browser 
history. When all the DMC8 cards become operational again, DCT001 appears in the browser 
history.

Presence of an alarm 

DCT101 No alarms.
(DCT101 only displayed in the 
Alarm browsers). 

Information only, no action needed.

DCT102 1 DCT102 displayed in the Alarm 
browsers is an alarm on a 
DMC8.

2 DCT102 displayed in the Alarm 
Snapshot is an alarm on a base 
station.

1 Open the Alarm Snapshot window for 
alarm details and perform the 
corresponding maintenance actions.

2 Look for one or more DCT202 to 
DCT215 alarms in the Alarm Snapshot 
window, and perform the corresponding 
maintenance actions.

DCT103 Base station alarm muted when no 
alarms. Look for one or more 
DCT501 alarms for details.(DCT103 
only displayed in the Alarm 
Snapshot window.)

Configure the base station using the OTM, 
or disconnect the base station.
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DCT104 Faceplate cable alarm(s) on DMC8. 
Look for one or more DCT302 to 
DCT307 alarms for details.(DCT104 
only displayed in the Alarm 
Snapshot window.)

Perform the DCT302 to DCT307 
maintenance action.

DCT105 Software alarm(s) on DMC8. Look 
for one or more DCT401 to DCT403 
alarms for details. (DCT105 only 
displayed in the Alarm Snapshot 
window.)

Perform the DCT402 to DCT407 
maintenance action.

Base station alarms

DCT201 No base station alarm.
(DCT201 only displayed in the 
Alarm browsers.)

Information only, no action needed.

DCT202 Local receiver signal missing (base 
station disconnected).

If a re-connection does not solve 
the problem, one of the following 
could be the cause:

1 the base station

2 the base station’s DMC8 card(s)

3 a cable problem between the 
base station and a DMC8 card.

Disconnect the base station for 30 seconds. 

1 Replace the base station.

2 Replace the base station’s DMC8.

3 Check the faceplate cabling.

DCT203 Local loss of receiver slot 
synchronization.

Perform the DCT202 maintenance action.

DCT204 Local loss of receiver frame 
synchronization.

Perform the DCT202 maintenance action.

DCT205 Local bit error rate bad. Perform the DCT202 maintenance action.

DCT206 Remote receiver signal missing. Perform the DCT202 maintenance action.

Table 219
Alarms  (Part 2 of 6)

Alarm
code

Alarm description Maintenance action
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DCT207 Remote loss of receiver slot 
synchronization.

Perform the DCT202 maintenance action.

DCT208 Remote loss of receiver frame 
synchronization.

Perform the DCT202 maintenance action.

DCT209 Remote bit error rate bad. Perform the DCT202 maintenance action.

DCT210 Synthesizer out of synchronization. Perform the DCT202 maintenance action.

DCT211 Power amp out of order. Perform the DCT202 maintenance action.

DCT212 Round-trip delay changed. Perform the DCT202 maintenance action.

DCT213 RFP synthesizer type changed. Perform the DCT202 maintenance action.

DCT214 LFC out of synchronization with 
BMC.

Disconnect and reinsert the DMC8.

DCT215 Error due to synchronization-port 
mutation.

Can affect the interpretation of the alarm 
snapshot or alarm browser applications; 
however, the alarm should clear 
automatically within 200 seconds.

Faceplate cable alarms

DCT301 No faceplate cable alarm.
(DCT301 only displayed in the 
Alarm browsers.)

Information only, no action needed.

Table 219
Alarms  (Part 3 of 6)

Alarm
code

Alarm description Maintenance action
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DCT302 The DMC8card is working; however, 
there is a loss of faceplate cable 
synchronization.

Remove all the DMC8s. Check the strap 
setting on the DMC8s. Check the faceplate 
cabling. Reinsert all the DMC8 cards.

If the above procedure does not solve the 
problem, try to find which DMC8 card gives 
the error condition by inserting the DMC8 
cards one at a time with a minute in 
between insertions.

If needed, replace the defective DMC8 card 
or the defect faceplate cables.

DCT303 No faceplate cable synchronization 
found.

The DMC8 card responsible for this 
alarm cannot pass the alarm on to 
the DMC8 Relay card.

Perform the DCT302 maintenance action.

DCT304 The DMC8 card is working; 
however, someone connected a 
faceplate cable section to the 
DMC8, causing a counter 
di f ference.

Do not connect faceplate cables to a DMC8 
on an active DECT system.

DCT305 The DMC8 card is working; 
however, there is a timing signal 
loss within the DMC8.

Perform the DCT302 maintenance action.

DCT306 The DMC8 card is working; 
however, the input of the faceplate 
cable controller is locked.

Perform the DCT302 maintenance action.

DCT307 The DMC8 card is working; 
however, the processor is 
overloaded with too many faceplate 
cable messages, causing an I/O 
transmit overflow.

Perform the DCT302 maintenance action. If 
the DCT302 action does not solve the 
problem, try provisioning an additional 
DMC8.

Table 219
Alarms  (Part 4 of 6)

Alarm
code

Alarm description Maintenance action
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Software alarms

DCT401 The DMC8 card is working; 
however, there is a subscription 
database corruption.

In the Boards window, Synchronize From 
the DMC8, then Synchronize To the 
DMC8.

DCT402 The DMC8 card is located in a card 
slot position that does not match the 
DMC8 card subscription data card 
slot address. The mismatch is due 
to one of the following:

• the DMC8 card is placed in the 
wrong card slot position

• the DMC8 card will not come 
into service

Perform the DCT401 maintenance action.

DCT403 Duplicate subscription in the 
system.

A subscription is moved from a 
source DMC8 card to a destination 
DMC8 card; however, the original 
subscription is still present on the 
source DMC8 card.

The DCT403 alarm should always 
come from both the source and 
destination DMC8 cards.

Perform the DCT401 maintenance action. If 
the problem does not clear, look for 
duplicated subscription IPUI in the 
Subscription Property dialog. Delete the 
unnecessary subscription from the source 
DMC8.

Table 219
Alarms  (Part 5 of 6)

Alarm
code

Alarm description Maintenance action
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DCT404 (DCT404 only displayed in the 
Alarm browsers.) One of the 
following events occurred:

• the power was turned on

• the DMC8 was inserted into the 
shelf backplane

• a software exception restarted 
the DMC8

If this alarm was caused by a software 
exception, examine the alarm browsers for 
details.

Radio Fixed Part alarm muted

DCT501 Alarms are muted in the RFP 
window, however the base station 
does not have any intrinsic alarms.

Use the RFP window to Cancel Mute 
Alarms.

Backplane controller unit

DCT601 This alarm is used by Nortel 
Networks designers.

Information only, no action needed.

Table 219
Alarms  (Part 6 of 6)

Alarm
code

Alarm description Maintenance action
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Web Alarm browser

The web Alarm browser has a circular log that provides information on a 
limited history of alarms. The Web Alarm browser records alarms at all times.

Figure 309
OTM web System Alarm browser
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Complete the following steps.

Table 220
Alarm Code maintenance actions

Step Action

1 Using a web-based navigator, open the login screen and log in. Select the System 
Navigator. Select the system that supports the DECT system. Select Alarms.

Follow the instructions on page 415 to page 419.

2 Examine the code, and take the appropriate maintenance action.

See Table 219 on page 540.

END
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Windows Alarm Notification

Alarm Notification provides an alert by pagers, E-mail, and forwards SNMP 
traps to an upstream processor. For more information about the Alarm 
Notification, see Optivity Telephony Manager: System Administration 
(553-3001-330).

Figure 310
Alarm Notification

Complete the following steps.

Table 221
Alarm Notification

Step Action

1 Using Windows, open the login screen, login, select the Alarm Notification from the 
Utilities menu of the OTM Windows Navigator.

Follow the instructions on, page 415 to page 419.

2 Examine the Message ID, and take the appropriate maintenance action.

See Table 219 on page 540.
END
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Event Monitor window

The Event Monitor window displays the system's Event Log, allowing all 
recent system events stored in the history file to be viewed. For more 
information about the Alarm management, see Optivity Telephony Manager: 
System Administration (553-3001-330).

Figure 311
Event Log

Complete the following steps.

Table 222
Event Log

Step Action

1 Using Windows, login to OTM. Select the Event Log Viewer from the Maintenance 
menu of OTM Windows Navigator.

Follow the instructions on page 415 to page 419.

2 Examine the Application column.

DECT indicates a DECT event.

3 Examine the Data Group column.

Gives the Site name, PBX name, DECT name.
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LED status for DMC8/DMC8-E and base station
The system LED status indicates the functioning of the DMC8/DMC8-E, 
base station power and card subsystem operation.

4 Examine the Message ID column.

Non-error logs range from 1 to 9999.

Error logs range from 10000 to 19999.

5 Examine the Message column.

Messages are the explanation of Message ID number codes.

Table 223
DMC8/DMC8-E red LED status

Red LED 
State Description Action

On The card is in one of the following states:

1 not programmed

2 disabled

3 has faults

1 Program the card. See 
page 529.

2 Re-enable the card. Use 
LD 32 ENLC l s c.

3 Replace the card. See 
page 553.

Flashes three 
times

Card is doing a self test. Wait.

Off 1 The card is in service if the yellow LED is 
off and the green LED is on.

2 The card has no power if all LEDs are off.

1 No action.

2 Restore power.

Table 222
Event Log

Step Action

END
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Table 224
DMC8/DMC8-E yellow/green LED status  (Part 1 of 2)

Yellow 
LED 
Status

Green 
LED 
Status Description Action

Off Off Power down. Restore power.

On Off Hardware testing by boot 
program.

Wait.

On On Wait for download command by 
the boot program.

Wait.

On Loop‡ No valid main program found by 
the boot program. Card is 
continuously restarting.

Start firmware distribution with the  
DECT Manager.

Slow 
flash†

On Faults caused by one of the 
following:

• software download in progress

• software distribution in 
progress

• subscription or configuration 
data is saving to the flash ROM

Wait.

Do not remove the card, removal 
corrupts the flashROM data.

Off Fast 
flash††

Card is synchronizing to the 
faceplate cable bus.

Wait.

Legend for LED action:
† Slow flash = 2 seconds On and 2 seconds Off
††Fast flash = 1 second On and 1 second Off
‡ Loop for no program = 3 seconds On and 0.25 seconds Off
‡ Loop for corrupted program = 12 seconds On and 0.25 seconds Off
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Off Slow 
flash†

1 Card has no PARI, or has an 
incomplete PARI.

2 Card has detected
an error.

1 Contact the technical support 
group.

2 Replace the card. See 
page 553.

Off On Card is in service. No action required.

Slow 
flash†

Slow 
flash†

Simultaneous occurrence of:

• card has no PARI, or 
incomplete PARI and

• either software distribution is in 
progress or subscription or 
configuration data is saving to 
the flashROM

Contact the technical support 
group.

Table 224
DMC8/DMC8-E yellow/green LED status  (Part 2 of 2)

Yellow 
LED 
Status

Green 
LED 
Status Description Action

Legend for LED action:
† Slow flash = 2 seconds On and 2 seconds Off
††Fast flash = 1 second On and 1 second Off
‡ Loop for no program = 3 seconds On and 0.25 seconds Off
‡ Loop for corrupted program = 12 seconds On and 0.25 seconds Off
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Removing and inserting a DMC8 for maintenance

Table 225
Base station LED status

Green Description Action

Off No power. Check DMC8 to base station 
cables.

Flashes Input power present but no 
output power.

Check DMC8 LED Status and 
Alarm Reports.

Check DMC8 to base station 
cables.

On Power present and communications with DMC8 
established.

No action required.

CAUTION — Service Interruption

Do not bypass the DMC8-E or the DMC8 immediately to 
the left of the DMC8-E. A bypassed DMC8-E can not 
regenerate the faceplate bus signals in the left half of the 
shelf.

Although the separated left half of the shelf remains in 
synchronization, system performance decreases as 
follows:

• Any calls passing through the separated part of the 
faceplate bus are dropped.

• Handsets configured on a DMC in the separated half 
cannot make or receive calls through a base station in 
the other half.
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To remove, re-seat, or insert DMC8 card, perform the following actions:

• Backup the data from the DMC8 card to be removed.

• Remove the faulty DMC8 card.

• Insert a working DMC8 card.

• Restore the data to the DMC8 card that was replaced.

Backing up a DMC8 card’s configuration and subscription 
information

Figure 312
DMC window 
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Complete the following steps.

Table 226
Backing up a DMC8 card’s configuration and subscription information

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window. Open the Boards 
window.

Follow the instructions on page 412 to page 421.

2 Select the DMC8 card.

Highlight the DMC8 card in the list.

3 Save the DMC8 data on the OTM.

From the Synchronization pull-down menu, click on Synchronize From. 

END
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 Removing a faulty DMC8 card

Figure 313
DMC8 card removal
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553-8227.EPS
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Complete the following steps.

Table 227
Removing a faulty DMC8 card

Step Action

1 Connect the maintenance bypass cable.

Plug the maintenance bypass cable into the Maint port of the DMC8 cards on either 
side of the DMC8card to be removed. 

2 Disconnect the faceplate cables.

Detach the faceplate cables from the DMC8 card to be removed and from the cards on 
either side of it. 

3 Remove the DMC8.

Release the card locking devices and lever the card out of the 
shelf backplane.

END
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Inserting a serviceable DMC8 card

Figure 314
DMC8 card insertion
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Complete the following steps.

Table 228
Inserting a serviceable DMC8 card

Step Action

1 Insert the DMC8 card.

Lever the card into the shelf backplane and latch the card 
locking devices.

2 Connect the faceplate cables.

Insert the faceplate cables into the DMC8 card just inserted and into the cards on 
either side of it.

3 Disconnect the maintenance bypass cable.

Remove the maintenance bypass cable from the Maint port of the DMC8 cards on 
either side of the replaced DMC8 card. 

END
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Restoring subscription data to the serviceable DMC8 card

Figure 315
DMC window

Complete the following steps.

Table 229
Restoring subscription data to the serviceable DMC8 card 

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the Boards 
window.

Follow the instructions on page 412 to page 421.

2 Select the DMC8.

Highlight the DMC8 in the list.

Save the DMC8 data on the OTM.

From the Synchronization pull-down menu, click on Synchronize To. 

END
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Note: Restore only one DMC (Board) at a time.

Adding a DMC8 card to a DECT system

Figure 316
Add a DMC8 card to the system
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Complete the following steps.

Table 230
Adding a DMC8 card to a DECT system

Step Action

1 Connect the bypass cable.

Plug the bypass cable into the Maint port of the existing DMC8.

2 Insert the DMC8 card, with a terminating plug installed, into the top  port.

Lever the card into the shelf backplane and latch the card locking devices.

3 Connect the bypass cable to the added DMC8 card.

Plug the bypass cable into the Maint port of the added DMC8 card.

4 Remove the terminating plug from the existing card.

Remove the terminating plug from the bottom  port of the existing DMC8 card.

5 Connect the faceplate cable.

Insert the faceplate cables into the bottom  port of the existing DMC8 card and 
the added DMC8 card.

6 Disconnect the bypass cable.

Remove the maintenance bypass cable from the Maint port of the existing DMC8 card 
and the added DMC8 card.

7 Add the DMC8 card to the database.

Use the procedure on page 560.

END
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Reusing a DMC8 card in another DECT system

Figure 317
DMC window

Complete the following steps.

Table 231
Reusing a DMC8 card in another DECT system 

Step Action

1 Select the DMC8card to be reused.

Highlight the DMC8 in the list.

2 Delete the subscriptions from the DMC8 card memory.

From the File pull-down menu, click on Clear.

END
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Removing and re-installing a base station for maintenance
Removing and re-installing a base station for maintenance involves:

1 “Muting alarms on a base station” on page 564

2 “Canceling mute alarms on a base station” on page 566

3 “Disconnecting and re-installing a base station” on page 567

Muting alarms on a base station

Figure 318
RFP window, and DECT Radio Fixed Parts properties window 
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Complete the following steps.

Table 232
Muting alarms on a base station

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the RFP 
window.

Follow the instructions on page 412 to page 421.

2 Select the DMC8 to mute.

Highlight the DMC8 in the list.

3 Mute the alarms.

From the File pull-down menu, click on Mute Alarms, or click on the  icon.

END
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Canceling mute alarms on a base station

Complete the following steps.

Table 233
Canceling mute alarms on a base station 

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the RFP 
window.

Follow the instructions on page 412 to page 421.

2 Select the DMC8 to cancel mute alarms.

Highlight the DMC8 in the list.

3 Cancel mute alarms.

From the File pull-down menu, click on Cancel Mute Alarms, or click on the  icon.

END
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Disconnecting and re-installing a base station

Figure 319
Disconnect/re-install the base station

Note: After disconnecting the cable to the base station, wait for 60 
seconds before reconnecting another base station.

553-8143a
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Complete the following steps.

Table 234
Disconnecting/reinstalling a base station

Step Action

1 Disconnect the RJ45 cable, MDF side.

Unplug the RJ45 cable from the wall socket of the RJ45 Connection Box.

2 Disconnect the RJ45 cable, base station side.

3 Remove the unserviceable base station from the mounting plate.

4 Re-install a serviceable base station on the mounting plate.

5 Re-connect the RJ45 cable to the base station.

6 Re-connect the RJ45 cable, MDF side.

END
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Uploading and activating firmware

Figure 320
DECT systems, DECT Firmware Upload, DECT Firmware Activation, Upload
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Complete the following steps.

Recovering from a firmware upload failure
It is possible to upload DMC firmware with the V.24 port of a DMC8 card 
using a PC equipped with Z-modem protocol. During the upload, the DMC8 
card deletes the active and standby firmware, and stores the uploaded 
firmware as the active firmware. When the upload completes, the boot 
program starts the uploaded firmware.

Table 235
Uploading and activating firmware

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 412 to page 421.

2 Open the Firmware upload dialog.

Select the Firmware pull-down menu, and click on Upload.

END
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Figure 321
Recovery upload to a DMC8 card

Complete the following steps.

Table 236
Recovering from a firmware upload failure (Part 1 of 2)

Step Action

1 Configure the COM port settings.

baud rate = 19200

data bits = 8

parity = no parity

stop bit = no flow control

2 Connect the NTCW12AA cable to the DMC8 card to be uploaded.

Refer to Table 237 on page 572 for the NTCW12AA cable tip and ring connections.

DMC8 card

  NTCW12AA
MDF to modem
      cable

 

PC with a Z-modem
     application
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Note: The BIX tip and ring connections shown in Table 237 on page 572 
correspond to standard BIX designation. The first pair are labeled T0 and 
R0. See the section in Large System: Installation and Configuration 
(553-3021-210) that deals with planning and designating the MDF.

3 Locate the OTM server COM port.

Connect the NTCW12AA cable connector into the PC COM port.

4 Unseat the DMC8 card.

Disconnect the DMC8 card from the shelf backplane.

5 Access Z-modem application; for example, Windows HyperTerminal.

Start > Programs > Accessories > HyperTerminal.

6 Initiate the file transfer.

Start the Z-modem application on the PC.

7 Activate the boot program.

Insert the DMC8 card into the shelf backplane. 

Table 237
NTCW12AA cable to MDF connections 

DMC8 Relay card 
MDF connection Cable color

DB25 connector pin 
number Signal designator

T1 Grey 8 V.24DCD

R2 Yellow 4 V.24RTS

T3 Blue 2 V.24TXD

R3 Red 3 V.24RXD

T4 Pink 7 V.24GND

Table 236
Recovering from a firmware upload failure (Part 2 of 2)

Step Action

END
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Retrieving current RSSI data
The Radio Signal Strength Indication (RSSI) shows interference and usage by 
a certain base station. A snapshot of the RSSI data is retrieved and stored in 
a file when the user requests it. If the file already existed, the new snapshot 
data is appended to the last snapshot data in the file.

Figure 322
Retrieve Current RSSI window, and Retrieve Current RSSI maps window 
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Complete the following steps.

Table 238
Retrieving current RSSI data

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the Current 
RSSI Data window.

Follow the instructions on page 412 to page 421.

2 Select a DMC8 card or cards for RSSI information retrieval.

Scroll and highlight a TN in the Select DMC(s) for RSSI Retrieval: box.

3 Retrieve the RSSI data.

Click on the Retrieve RSSI now button.

4 Store the RSSI data.

Select a file location.

END
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RSSI file format

The data for each RFP is a nibble for indication of the RSSI value for each 
slot (24) for each carrier (10). This results in 10 (number of carriers) times 24 
(number of slots) nibbles equal to 240 nibbles (120 octets).

Figure 323
RSSI file format

--------------------------------------------------------------------------------------------------------------------------------------------------------
-------------------------------------------------------------------------------------------------- 

Wed Apr 18 16:00:42 CEST 2001  
--------------------------------------------------------------------------------------------------------------------------------------------------------
-------------------------------------------------------------------------------------------------- 

DMC TN :  48 1 07  

RFP 1 : 
0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF5F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0F
FF0F3F5FFF5FFF0F0F0FFF0FFF0F1F0FFF0FFF0F0F0FFF0FFF0F0F0F0F0F1F0F0F0F0F0F0F0F0F0FFF0FFF0F0F0FFF
0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF 

RFP 2 : 
F0FFF0F0F0FFF0FFF4F0F0FFF0FFF0F0F0FFF0FFF8F0F0FFF0FFF0F0F0F0F0FFF3F0F0F0F0FFF0F0F0FFF0FFF0F0F0
FFF0F0F0F0F0FFF0F0F0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF3F5F5FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0
F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FF 
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Performance Collection

Figure 324
Performance Collection window and Select location dialog 
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Complete the following steps.

CAUTION — Service Interruption

Check to ensure the Performance Collection is not using 
all the OTM server storage space. 

Table 239
Collecting performance data: User Performance, Equipment Performance (Part 1 of 2)

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the 
Performance Collection window.

Follow the instructions on page 412 to page 421.

2 Select a collection name.

Enter a name or browse for a collection name.

3 Select the check box User Performance Collection or Equipment Performance 
Collection, or both.

Click on the check box.

4 Select a collection period.

Note:  The User Performance Collection period and the Equipment Performance 
Collection period are independent of each other.

Highlight a time from the Collection Period box.

5 Select a DMC8 card.

Highlight a TN from the DMC TN box.
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Collecting Equipment Performance data

Equipment Performance Collection file format

File name: (for example) epm-brdPP_YYYYMMDDHHMMSS.xml, 
epm-brd24_20010418170920.xml. 

DTD Document Type Definition: <<Epm.zip>> 

Counter description (in the DTD order) 

See “Equipment Performance Collection file sample” on page 609

6 Start the collection.

Click the Start button.

7 Stop the collection.

Click the Stop button.

Table 239
Collecting performance data: User Performance, Equipment Performance (Part 2 of 2)

Step Action

END
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Board (DMC8) statistical performance data    

Table 240
Board statistical performance data 

Counter Description

1 Indicators, not used

2 Number of dropped calls

3 Number of page failures

4 Number of page retries

5 Number of page requests

6 Number of page rejects

7 Number of voice calls

8 Number of message call

9 Number of dropped voice calls

10 Number of dropped message calls

11 Number of dropped voice calls in active phase

12 Number of dropped message calls in active phase

13 Number of dropped voice calls in passive phase

14 Number of dropped message calls in passive phase

15 Number of successful supplementary service calls

16 Number of supplementary service calls with no response

17 Number of supplementary service call rejects

18 Number of slip events on BBC highway A

19 Number of slip events on BBC highway B

20 Number of DECT clock errors
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RFP (base station) statistical performance data 

Table 241
RFP statistical performance data  (Part 1 of 2)

Counter Description

1 Indicators: 1 = 6 Channel RFP, 2 = 12 Channel RFP, 3 = Unknown

2 Number of times BMC overrun occurred

3 Number of times TBC established

4 Number of NT Handshake failures

5 Current radio head error code. See Radio Head Errors section below.

6 Number of units of 100 ms since last radio head error

7 Bit counter pre-set (the measured RFP cable delay in DECT bits)

8 Number of times dummy bearer 0 was set-up

9 Number of times dummy bearer 1 was set-up

10 Number of times dummy bearer 0 was replaced

11 Number of times dummy bearer 1 was replaced

12 Number of frames with corrupted A fields (R-CRC check failed)

13 Number of frames with corrupted B-fields (X-CRC check failed)

14 Number of bad syncs 

15 Number of muted frames

16 Total duration of calls using this RFP in units of 10 ms

Radio Head Errors

17 Number of times Local Receiver Signal Missing

18 Number of times Local Loss Receiver Slot Sync

19 Number of times Local Loss Receiver Frame Sync

20 Number of times Local Bit Error Rate Bad

21 Number of times Remote Receiver Signal Missing

22 Number of times Remote Loss Receiver Slot Sync

23 Number of times Remote Loss Receiver Frame Sync
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RFP (base station) Error Codes 

Error codes are shown in decimal and in (hexadecimal). 

24 Number of times Remote Bit Error Rate Bad

25 Number of times Synthesizer Out Of Sync

26 Number of times Power Amp Out Of Order

27 Number of times Round Trip Delay Changed

28 Number of times RFP Synthesizer Type Changed

29 Number of times LFC Out Of Sync With BMC

30  Number of times Error Due To Sync Port Mutation

Table 242
RFP Error codes  (Part 1 of 2)

Error code Description

1 (0x01) Local Receiver Signal Missing

2 (0x02) Local Loss of Receiver Slot Sync

3 (0x03) Local Loss of Receiver Frame Sync

4 (0x04) Local Bit Error Rate Bad

5 (0x05) Remote Receiver Signal Missing

6 (0x06) Remote Loss of Receiver Slot Sync

7 (0x07) Remote Loss of Receiver Frame Sync

8 (0x08) Remote Bit Error Rate Bad

9 (0x09) Synthesizer Out Of Sync

10 (0x0A) Power Amp Out Of Order

11 (0x0B) Round Trip Delay Changed

12 (0x0C) RFP Synthesizer Type Changed

Table 241
RFP statistical performance data  (Part 2 of 2)

Counter Description
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RFP-Channel occupation performance data 

The 13 RFP-channel occupation counters give the number of seconds that n 
RFP channels were free (n = 0 – 12). 

Backbone-Channel occupation statistical performance data 

The 33 Backbone-channel occupation counters give the number of seconds 
that n backbone channels were free (n = 0 – 32). 

Speech-Channel occupation statistical performance data 

The 33 Speech-channel occupation counters give the number of seconds that 
n speech channels were free (n = 0 – 32). 

Collecting User Performance data

User Performance Collection file format

File name: upm-brdPP_YYYYMMDDHHMMSS.xml
Example: upm-brd24_20010418170924.xml 

DTD Document Type Definition: <<Upm.zip>> 

See “User Performance Collection file sample” on page 611.

13 (0x0D) LFC Out Of Sync With BMC

14 (0x0E) Error Due To Sync Port Mutation

255 (0x0FF) No Error

Table 242
RFP Error codes  (Part 2 of 2)

Error code Description
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Statistical Performance Data 

Table 243
Statistical Performance Data

Counter Description

1 Indicators, not used

2 Number of page failures

3 Number of page retries

4 Number of page requests

5 Number of page rejects

6 Number of voice calls

7 Number of message calls

8 Number of voice calls, dropped in passive state

9 Number of voice calls, dropped in active state

10 Number of message calls, dropped in passive state

11 Number of message calls, dropped in active state

12 Number of hand overs

13 Number of failed hand overs

14 Number of aborted hand overs

15 Number of delayed hand overs

16 Current Circuit Number (0xFF, if none)



Page 584 of 612  System maintenance

553-3001-370 Standard 1.00 October 2003

Setting parameters

Figure 325
DECT System Properties – Parameters tab
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Complete the following steps.

Recovering a password
The DECT system password can be changed by a customer and the distributor 
managing the system would not know the changed password. The password 
could be damaged in the OTM database by a disk crash and not backed up, or 
the password can be forgotten. Passwords cannot be accessed from the OTM.

The OTM provides a mechanism allowing the password to be reset to the 
factory password. The password can be changed in the DECT system and the 
OTM DECT database, or in the OTM DECT database only.

Table 244
Setting parameters

Step Action

1 Using Windows, login to OTM. Select the system that supports the DECT system, 
Launch the DECT application. Open the DECT Systems window. Open the Properties 
dialog, and click on the Parameters tab.

Follow the instructions on page 412 to page 421.

2 Select the parameter.

Select a pull-down menu item, and click Apply.

END
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Figure 326 
DECT Systems window, DECT Systems Properties, Change DECT Password
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Complete the following steps.

Table 245
Recovering a password

Step Action

1 Using Windows, login to OTM. Select the system that supports DECT. Launch the 
DECT application. Open the DECT Systems window. Open the Properties dialog, and 
click on the General tab.

Follow the instructions on page 412 to page 414.

2 Select password change.

Click on Change Password.

3 Change to the factory default password.

Note:  The default is case sensitive.

Type Arsenal in the New password box.

4 Confirm the password.

Type Arsenal in the Confirm new password box.

5 Set up for a password change the on the DECT system.

Remove the DMC8 Relay card, and reinsert the DMC8 Relay card.

6 Connect to the DECT system within five minutes.

From the Applications pull-down menu click on Connect or the  (green) icon.

 
END
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Appendix A: Upgrade a DECT system to 
a SNMP managed system

Overview
There are two types of managers for DECT systems:

• Windows Manager

• OTM with DECT application

The Windows Manager, a non-SNMP device, is used to manage the first 
generation of DECT systems. An OTM with a DECT application manages the 
present generation of DECT systems.

Note: The following terms are used in this appendix:

• The DMC (NTCW00AA) and DMC-E (NTCW01AA) are 
referred to as DMC4 and DMC4-E.

• A DECT system equipped with both DMC4/DMC4-E and 
DMC8/DMC8-E is referred to as a Mixed DECT system.

An OTM can manage a DMC4/DMC4-E DECT system or a Mixed DECT 
system.

In a DMC4/DMC4-E DECT system, or a Mixed DECT system managed by 
an OTM, the DMCs must run SNMP software.

A Mixed DECT system must be managed by an OTM. In a Mixed DECT 
system, a DMC8/DMC8-E must be the relay card.
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In a DMC4/DMC4-E DECT system or a Mixed DECT system managed by 
an OTM, the DMCs must run 451001xx.dwl software, and the DMC8s/
DMC8-Es must run 470001xx.dwl software. If DECT Messaging is used, the 
DMCs must run 451002xx.dwl software, and the DMC8s/DMC8-Es must run 
470002xx.dwl software

Connecting an OTM to a DMC4 Relay card using an Ethernet connection is 
not supported. Only a V.24 connection can be used.

Backing up the DMC4 data with Windows Manager

Figure 327
DECT Manager window

553-AAA0273
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Complete the following steps.

Table 246
Backup the DMC data with Windows Manager 

Step Action

1 Launch the Windows Manager program.

Double click on the DECT-Manager icon.

2 Select the Companion system.

Highlight the system and click on the OK button.

3 Select the Boards tab.

Place the cursor on the tab and click.

4 Select all DMC4s.

Highlight all addresses.

5 Backup the DMC4 data.

Click on the Backup button.

6 Close the connection to the relay card.

From the toolbar, click on the Connect icon.

END
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Uploading OTM supporting firmware to the DMC4 Relay 
card

Figure 328
DECT Manager window

553-AAA0273
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Complete the following steps.

Table 247
Upload OTM supporting firmware to the DMC4 Relay card 

Step Action

1 Load the OTM supporting 451001xx.dwl firmware file on the Windows Manager PC.

2 Select the Companion system.

Highlight the system and click on the OK button.

3 Select the Boards tab.

Place the cursor on the tab and click.

4 Select the Relay DMC4.

Highlight the address.

5 Upload the 451001xx.dwl firmware file to the Relay DMC.

From the Boards pull-down menu, click on Upload firmware.

END
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Closing the Windows Manager

Figure 329
Close Program dialog

Complete the following steps.

Table 248
Close the Windows Manager

Step Action

1 Open the Close Program dialog.

Press the Ctrl + Alt + Delete keys.

2 Disable the Windows Manager.

Select DECT Manager and press the End Task button.

553-AAA0274

END
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Changing the DMC4 Relay card default IP address 

Connect the DMC4 Relay card to a configuring PC

Figure 330
NTCW12AA cable to configuring PC connections 

CAUTION — Service Interruption

The DMC4 address must be changed to conform to the 
network IP address plan.

DECT System 

DMC4 Relay card

NTCW12AA
MDF to modem 

adaptor
A0773252

Null modem 
adaptor

Configuring PC

553-AAA0276
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Note: The configuring PC can be the OTM server or another PC.
If the configuring PC is the OTM server, the Configuring PC shown in 
Figure 330 will be the OTM Server shown in Figure 332 on page 598. 

Resetting the DMC4 Relay card to the server IP address

Change the Relay DMC4 IP address to conform to the server network IP 
address plan.

Figure 331
Telnet 192.168.1.

Table 249
Connect the DMC4 relay card to a configuring PC

Step Action

1 Connect the NTCW12AA cable to the Configuring PC.

Insert the NTCW12AA cable into the A0773252 Null Modem Adaptor and connect to 
the Configuring PC. 

END
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Complete the following steps.

Connecting the DMC4 Relay to the OTM server
Connect the OTM server to a DMC4 Relay card using a V.24 connection. 
Connecting an OTM to a DMC4 Relay card using an Ethernet connection is 
not supported.

Table 250
Reset the Relay DMC4 IP address to the LAN IP address

Step Action

1 Open the Telnet dialog. 

Click on Start>Accessories>Telnet. 

2 Enter user name and password. 

Type user name dasuser and password dasuser. 

3 When the connection prompt local appears, change the Relay DMC4 card address. 

Enter the following command: 
ipconfig xxx.xxx.xxx.xxx yyy.yyy.yyy.yyy zzz.zzz.zzz.zzz 

xxx.xxx.xxx.xxx = new IP address of the Relay DMC4 card. 

yyy.yyy.yyy.yyy = subnet mask, usually 255.255.255.0 

zzz.zzz.zzz.zzz = IP address if this is the gateway for the network. 

Note:  zzz.zzz.zzz.zzz should be set to the IP address of the OTM server Ethernet 
interface. If there are two Ethernet interfaces on the OT server, zzz.zzz.zzz.zzz should 
be set to the IP address of the interface, which is on the same network as the DMC4 
Relay card.

END



Page 598 of 612 Appendix A: Upgrade a DECT system to a SNMP managed system

553-3001-370 Standard 1.00 October 2003

Figure 332
OTM Server to DMC4 relay connections (local and remote)

DECT System 

DMC4 Relay card

NTCW12AA
MDF to modem 

cable A0773252
Null modem 

adaptor

OTM Server

553-AAA0279

Standard
DB-25 to DB-9

cable

Local

DECT System 

DMC4 Relay card

NTCW12AA
MDF to modem 

cable

OTM Server

553-AAA0280

Standard
DB-25 to DB-9

cable

Remote

 

PSTN

Modem
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Complete the following step.

Table 251
Connect the DMC4 Relay to the OTM server

Step Action

1 Connect the OTM server to the DMC4 Relay card.

Refer to “Adding a V.24 serial connection” on page 348.

END
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Adding the DECT system

Adding General System Properties

Figure 333
DECT systems and DECT System Properties

553-AAA0282

553-AAA0281
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Complete the following steps.

Table 252
Add the DECT system

Step Action

1 Open the DECT System Properties dialog.

Pull down File>Add. 

2 Enter the DECT system name.

Type the system name in the DECT System Name box.

3 Accept the changes.

Click on the Apply button.

END
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Setting the DECT system IP address to match
the DMC4 Relay card

Figure 334
System Properties – Communication
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Complete the following steps.

Table 253
Set the IP address of the DMC4 Relay card in the manager

Step Action

1 Open the Communications dialog.

Click on the Communications tab.

2 Enter the IP address.

Type the IP address that was entered in Table 250 on page 597.

3 Select Serial.

Click on Serial radio button, and go to “Adding a V.24 serial connection” on page 348.

4 Accept the changes.

Click on the OK button.

Note:  When the OK button or Apply button is clicked at this point, the manager attempts 
to connect to the DECT system to write the MIB2 system name. 

END
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Synchronizing data with the DECT system
When the DECT manager connects to the DECT system, synchronization 
occurs. The OTM database can be updated with the DECT system data.

Figure 335
DECT systems, and a synchronize dialog

553-AAA0284

553-AAA0283
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Complete the following steps.

Table 254
Synchronize data with the DECT system

Step Action

1 If the toolbar icon is red, indicating the DECT system connection is enabled, disconnect 
from the DECT system.

Double click on the icon, or use File>Disonnect. Go to step 3.

2 If the toolbar icon is green. 

Go to step 3.

3 Re-connect to the DECT system.

Double click on the red icon, or use File>Connect.

4 Store the DECT system data in the OTM Manager database.

Click on the Update DECT Manager button on all synchronization dialogs.

END
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Confirming the active software package on the
DMC4 Relay card

Figure 336
DMC window and DECT Board properties dialog

Complete the following steps.

Table 255
Confirm the active software package on the DMC4 Relay card 

Step Action

1 Examine the Active Software Package on the DMC4 relay in the DMC window list.

Active Software Package must be 451001xx.dwl firmware, the same one that was 
loaded on page 592.

2 Close the DMC window.

Click on the close box.

553-AAA0285

END
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Activating the firmware on all DMC4s

Figure 337
DECT Systems window

Complete the following step.

Table 256
Activate the firmware on all DMC4s

Step Action

1 Activate the 451001xx.dwl firmware the same as was loaded on page 592 to all 
DMC4s.

From the Firmware pull-down menu, click on Activate.

553-AAA0281

END
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Monitoring the firmware activation

Figure 338
DMC window

Complete the following step.

Table 257
Monitor the firmware activation 

Step Action

1 Examine the Active Software Package on the DMC4 relay card in the DMC window list.

Active Software Package must be 451001xx.dwl firmware on all DMCs. See page 592.

END
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Appendix B: Performance Collection file 
samples

Equipment Performance Collection file sample
<?xml version="1.0"?> 
<file> 
<header> 
<systeminfo PARI="44446666"/> 
<boardinfo boardnumber="24"/> 
<package package_id="45100105"/> 
</header> 
<data> 
<boardstat> 
<dateandtime>2001,1,12,18,17,37,0</dateandtime> 
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0</counters> 
</boardstat> 
<rfpinfo> 
<rfpstat rfp="1"> 
<dateandtime>2001,1,24,19,50,9,0</dateandtime> 
<counters>1,0,0,0,8,420,0,1,1,0,0,0,0,0,0,0,0,0,0,0,0,0,0,1,0,0,0,0,0,0</
counters> 
</rfpstat> 
<rfpstat rfp="2"> 
<dateandtime>2001,1,24,19,50,13,0</dateandtime> 
<counters>1,0,0,0,8,420,0,1,1,0,0,0,0,0,0,0,0,0,0,0,0,0,0,1,0,0,0,0,0,0</
counters> 
</rfpstat> 
<rfpstat rfp="3"> 
<dateandtime>2001,1,24,19,50,13,0</dateandtime> 
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<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0</
counters> 
</rfpstat> 
<rfpstat rfp="4"> 
<dateandtime>2001,1,24,19,50,19,0</dateandtime> 
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0</
counters> 
</rfpstat> 
</rfpinfo> 
<rfpchanocc> 
<rfpchocc rfp="1"> 
<dateandtime>2001,1,12,18,17,37,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc> 
</rfpchocc> 
<rfpchocc rfp="2"> 
<dateandtime>2001,1,12,18,17,37,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc> 
</rfpchocc> 
<rfpchocc rfp="3"> 
<dateandtime>2001,1,24,19,50,6,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc> 
</rfpchocc> 
<rfpchocc rfp="4"> 
<dateandtime>2001,1,24,19,50,6,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc> 
</rfpchocc> 
</rfpchanocc> 
<bschanocc> 
<bchanocc> 
<dateandtime>2001,1,24,19,50,6,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,434</
choc> 
</bchanocc> 
<schanocc> 
<dateandtime>2001,1,24,19,50,6,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,434</
choc> 
</schanocc> 
</bschanocc> 
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</data> 
</file> 

User Performance Collection file sample
<?xml version="1.0"?> 
<file> 
<header> 
<systeminfo PARI="44446666"/> 
<boardinfo boardnumber="24"/> 
<package package_id="45100105"/> 
</header> 
<data> 
<ppstat RecNum="2"> 
<dateandtime>2001,1,12,18,17,37,0</dateandtime> 
<ipui>40110000E5A97B7F84</ipui> 
<dnr>20801</dnr> 
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,255</counters> 
</ppstat> 
</data> 
</file> 
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